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Outline
1  The OpenScape UC Application Clients

This document compiles and describes all client applications available for 
operating the communication functions provided by the OpenScape 
UC Application server. The client applications that have no manual of their own 
are explained in detail. For all other clients you find a short feature overview and 
a reference to the corresponding manual.

1.1  Outline

Structure of this manual.

The instructions on hand are divided into the following chapters:

Chapter 1, "The OpenScape UC Application Clients"

In this chapter you find general information on the OpenScape UC Application 
communication solution as well as information on the structure and the use of this 
manual.

Chapter 2, "The Communications solution OpenScape UC Application"

In this chapter you find an overview of the OpenScape UC Application communi-
cations solution. 

Chapter 3, "The Clients for OpenScape UC Application"

In this chapter you find a short feature overview of the clients available for 
OpenScape UC Application as well as information about where to find the 
respective manual.

Chapter 4, "The OpenScape Voice Portal"

Operating instructions for the OpenScape Voice Portal.

Chapter 5, "The OpenScape UC Speech Portal"

Operating instructions for the OpenScape UC Speech Portal.

Chapter 6, "Conferences in OpenScape UC Application"

Operating instructions for the conference function offered via the OpenScape 
UC Application clients (OpenScape Web Client and OpenScape Desktop Client 
Enterprise Web Embedded Edition).

Chapter 7, "OpenScape Extensions for Microsoft Outlook"

Operating instructions for the Microsoft Outlook conference extension of the 
OpenScape UC Application.
A31003-S5070-U101-3-7619, 06/2012
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Chapter 8, OpenScape Extensions for Lotus Notes"

Operating instructions for the IBM Lotus Notes conference extension of the 
OpenScape UC Application.

Chapter 9, "OpenScape Desktop Integration"

Description of how to set up and operate the application program DesktopInte-
gration. 

Chapter 10, "OpenScape Click-to-Dial-Browser-Plug-in"

Operating instructions for the OpenScape Click-to-Dial-Browser-Plug-in.

Chapter 11, "OpenStage Client"

Operating instructions for the OpenStage Client.

Chapter 12, "The OpenScape Client Integrations"

Feature overview and installation manual for the OpenScape Client Integrations.

Chapter 13 "OpenScape icons"

In this chapter we provide information about the icons used in the OpenScape 
UC Application clients.

1.2  Working with this Manual

Basic information about how to use this manual.
 A31003-S5070-U101-3-7619, 06/2012
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1.2.1  Formats and Display Forms

In the manual on hand the following conventions apply: 

NOTICE:  Indicates useful notes.

IMPORTANT:  Indicates situations that may result in damage to 

Purpose Representation Example

Product and company 
names

Italic ...OpenScape UC Application...

Special emphasis Bold Name must not be deleted.

User interface elements Bold Click on OK.

Menu sequence > File > Close 

Textual cross reference Italic You find further information in the 
Configuration and Administration 
manual.

Path and file names Font with fix 
character spacing, 
e. g. Courier

c:\Programs\...

or

Example.txt

Variables Italic in angle 
brackets

Enter your <user name> and the 
<password> to log on to the system.

Output Font with fix 
character spacing, 
e. g. Courier

Command not found.

Entry Font with fix 
character spacing, 
e. g. Courier

Enter LOCAL as file name

Key combination Bold [Ctrl]+[Alt]+[Esc]

Steps and subordinate 
steps in instructional text

Numeric and alpha-
betic lists

1. Configure the RADSL telephony 
subscribers with the respective 
extensions.

 a) Click on Add.

 b) Enter the name of the RADSL 
telephony subscriber under RADSL 
telephony subscriber.

Listings of functions etc. Bulleted list • If you would like to issue amounts, 
activate the checkbox Issue 
amounts instead of units.

• If you would like to issue units, 
deactivate the checkbox Issue 
amounts instead of units.
A31003-S5070-U101-3-7619, 06/2012
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property and/or loss of data.

1.2.1.1  Figures

This manual displays all entry dialogs important for operation and configuration. 
Depending on the operating system, the browser used, the screen resolution, the 
configurations on your PC and your selection of the user interface style these 
dialogs may appear slightly different.

1.2.2  Reference Manuals

This section informs you about additionally available user documentation on 
OpenScape UC Application.

The general rule is that a printed version of the manuals can only be obtained 
upon special request. All other documents are available on the enclosed DVD as 
full text search-compatible PDF version. Additionally, an online help is available 
for most of the components, which can be started directly from the respective 
programs.

The following OpenScape UC Application operating instructions are available in 
addition:

Manual Topic

OpenScape Desktop Client Enterprise 
Web Embedded Edition

Setup and operation guide for the OpenScape 
Desktop Client Enterprise Web Embedded 
Edition.

Quick Guide

OpenScape Desktop Client Enterprise 
Web Embedded Edition

Quick guide through the OpenScape Desktop 
Client Enterprise Web Embedded Edition.

OpenScape Web Client Operating instructions for the OpenScape Web 
Client. 

Quick Guide

OpenScape Web Client

Quick guide through the OpenScape Web 
Client.

OpenScape Mobile Client Installation and operating guide for the 
OpenScape Mobile Client.

Quick Guide

OpenScape Mobile Client

Quick guide through the OpenScape Mobile 
Client. 

OpenScape Web Collaboration V1 Operating instructions for the web conferencing 
application OpenScape Web Collaboration. 
These instructions describe basically the 
functional range of the OpenScape Web 
Collaboration Embedded shipped with the 
OpenScape UC Application.
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Quick Guide

OpenScape Web Collaboration

Quick guide through the web conferencing 
application OpenScape Web Collaboration 
Embedded.

Quick Guide

OpenScape Voice Portal

Graphic overview of the OpenScape Voice 
Portal main features.

Quick Guide

OpenScape Voice Portal mit PhoneMail

Graphic overview of the OpenScape Voice 
Portalfeatures that can be reached via the 
voicemail script OpenScape Xpressions 
PhoneMail.

HiPath 4000 OpenStage 60/60 G, 
OpenStage 80/80 G OpenStage Key 
Module

Operating instructions for the telephone 
OpenStage 60/80.

Manual Topic
A31003-S5070-U101-3-7619, 06/2012
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2  The OpenScape UC Application

Overview of the OpenScape UC Application clients.

2.1  Introduction

The OpenScape UC Application communications solution – “UC” means Unified 
Communications here – enables you to reach people fast and smoothly, or to 
access important information. When using the OpenScape UC Application in the 
Enterprise Edition it does not matter from where you set up the connection or 
retrieve information: in the office, at home or on the road. This software solution 
is provided on a server and can be used by multiple users at the same time. The 
Personal Edition provides mostly the functionality of a softphone without using the 
server of the Enterprise Edition.

2.1.1  Main Features

Overview of the main features.

The OpenScape UC Application simplifies your business communication by 
summarizing all access and operating elements in one application. The following 
table lists the main features of the OpenScape UC Application with the respective 
clients that enable using these features: 

For reasons of clarity, the clients in the table are assigned to the following letters: 

• A:OpenScape Desktop Client Enterprise Web Embedded Edition

• B: OpenScape Web Client

• C: OpenScape Mobile Client

• D: OpenStage Client for telephones of type OpenStage 60/80

• E: OpenScape Voice Portal

• F: OpenScape Extensions for Microsoft Outlook

• G: OpenScape Extensions for Lotus Notes

• H: OpenScape Fusion for Google Apps
A31003-S5070-U101-3-7619, 06/2012
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Feature Description Clients

A B C D E1 F G

Presence-based contact 
management

Enables you to view information on 
presence and availability in real time and 
provide it for your colleagues. Additionally, 
calls via the contact list are possible. 

X X X X X X

One-number service (ONS) You can issue a single telephone number 
via which you can be reached. You can 
make and take calls at a device different 
from your office phone (i. e. your preferred 
device). For outgoing calls, your office 
phone number is always transferred as 
caller number.

X X X X X X

Using routing rules You can define several private routing 
rules for your incoming calls and select 
one of them if required.

X X X 2 X3 X

Softphone Integrated SIP softphone with the feature 
of making local calls. Note: The feature 
SIP-Softphone is not available for terminal 
server clients. Integrated softphone with 
the feature of making local calls with HFA 
connection to the HiPath 4000.

X

Information feature

(Tell-me-when)

Sends a notification when a contact is 
available. X X

Audio conferencing service Supports you in performing meet-me 
conferences (dial-in conferences) or ad-
hoc conferences without previous dial-in or 
registration procedures.

X X X X X X

Video conferencing Allows performing video conferences if 
video-compatible devices/clients are used.

X X X X

Text-to-speech Text messages are converted to speech 
that can then be played via a voice device. 

X

Directory search Server-based directory access (LDAP) X X X X

Journal with number resolution Logs all incoming and outgoing calls. 
Allows sorting and grouping calls as well 
as initiating outgoing calls by clicking on a 
name or number. 

X X X X X

Instant messages Native client support for instant messages 
based on extensible messaging and 
presence protocol (XMPP) allows using 
existing Enterprise instant-messaging 
platforms such as Openfire or Jabber 
XCPTM. 

X X X

Managing preferred devices 
(One-Number Service, ONS)

Enables using several devices and device 
lists for incoming and outgoing calls via the 
one-number service. 

X X X X X X
 A31003-S5070-U101-3-7619, 06/2012
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Named device list Enables naming a selected device list. The 
device list can be assigned to a status to 
attribute calls in a certain order or to 
certain devices. 

X X X

Call screening With the help of this control feature the 
name and phone number of a caller can 
be displayed. The name and number must 
be in your contact list.

X X X

Micosoft Office Communica-
tions Server (OCS) integration

The server-based integration of Micosoft 
Office Communications Server enables 
access to your OCS contact list. You can 
search for OCS-based contacts and import 
them in the OpenScape contact list, and 
communicate with your contacts/
colleagues via instant messaging. Your 
OpenScape presence status is synchro-
nized with the OCS presence status.

X X

Groupware integration The server-based integration of IBM Lotus 
Domino and Microsoft Exchange Server 
allows access to global and private 
contacts and address books as well as the 
inbox and the calendar (may vary 
depending on the client).

X X X

Calendar integration Accessing groupware-based calendars. X X

Messaging integration Integration with Microsoft and IBM 
messaging features. 

X X

Video telephony Video telephony via SIP. X

Desktop integration Easy-to-start application that provides the 
following features:

• Calling subscribers from any application 
via copying the phone number to the 
clipboard.

• Signaling of incoming calls and instant 
messages, even if the windows of the 
OpenScape Web Client or of the 
OpenScape Desktop Client are closed.

X X

Browser integration The OpenScape Click-to-Dial-Browser-
Plug-in for the Microsoft Internet Explorer 
enables dialing a phone number from your 
web browser.

X X X

Single Sign-On (SSO) Logging on to the clients installed on your 
workstation via your local Windows 
account.

X X X

Client logon via your Windows 
user account.

Logging on to clients via Windows user 
account 

X X X

Feature Description Clients

A B C D E1 F G
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2.1.2  Main Concepts

The main concepts of the OpenScape UC Application.

Working with OpenScape UC Application is based on the following concepts.

• Your status information - the basis for ideal communication
OpenScape UC Application uses your status to determine how the communi-
cation is to take place. Your colleagues can always immediately see whether 
you are available, in a meeting or busy. 

NOTICE:  Of course, you can specifically prohibit displaying your 
status information for individual subscribers.

Always remember to define your status and to update it regularly. 
In a deployment with Micosoft Office Communications Server integration the 
presence status is exchanged between the systems and always corresponds 
to the status you have set last, no matter whether you have specified it in the 
OpenScape UC Application or in the Micosoft Office Communications Server.

• Your contacts - a list of colleagues, customers, family participants and friends. 
You can configure your contacts to gain a quick overview of your status and 
to facilitate selecting the most appropriate communications medium. This is 
particularly useful if your contacts are other OpenScape UC Application 

Microsoft Outlook Integration - 
address data export and import

You can export and import your contact 
data as Microsoft Outlook-based contacts.

X X

Microsoft Outlook Integration - 
Telephone Service Provider 
support (TSP)

TSP support enables direct calling from 
selected e-mails or address book entries 
in Microsoft Outlook. The associated 
contacts need to have been assigned a 
phone number for this purpose.

X X

Microsoft Outlook/IBM Lotus 
Notes integration - planning 
conferences via the calendar 
of Microsoft Outlook or of IBM 
Lotus Notes.

Installing the OpenScape Extensions for 
Microsoft Outlook/OpenScape Extensions 
for Lotus Notes provides functions in 
Microsoft Outlook/IBM Lotus Notes for 
scheduling conferences via a meeting 
request in the calendar of 
Microsoft Outlook/IBM Lotus Notes. 

X X

MeetNow! conferences via 
telephone

Access to MeetNow! conferences by using 
a special service telephone number. The 
conference room is defined by entering the 
same PIN. This PIN is arbitrary.

1 When using the voice portal in Direct Access; in Guest Access you can only leave a voicemail (answering machine 
function).

2 Activating only one of the already defined rules from the rule list.

3 Activating only one of the already defined rules from the rule list.

Feature Description Clients

A B C D E1 F G
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users, since you have then the best possible overview of your communica-
tions options. You can also configure contact persons as groupware contacts 
without OpenScape UC Application. Integrating people you contact 
frequently in your contact list simplifies your work significantly.

• Your devices - You determine them, theOpenScape UC Application keeps 
track.
You choose the devices via which you take calls and that you would like to 
use to make calls. The status of all your devices is tracked for every commu-
nication starting from your OpenScape UC Application clients and is used for 
the corresponding routing of incoming calls. Your office telephone status or 
your softphone status can also be tracked if you make calls directly from the 
telephone.

• Access to the effective features of the OpenScape UC Application 
The OpenScape Desktop Client (Personal Edition as well as OpenScape 
Desktop Client Enterprise Web Embedded Edition is your desktop appli-
cation. It provides trouble-free communication and cooperation with others 
from your desk with each of your telephones, your integrated softphone 
included.
You can use the OpenScape Desktop Client for easy access to the 
OpenScape UC Application via an internet browser.
The OpenScape Mobile Clientenables access to the OpenScape 
UC Application via mobile phone.
You can use the OpenScape Voice Portal to access the OpenScape 
UC Application via keypad (Dual Tone Multi Frequency - DTMF). 

2.1.3  Microsoft Groupware and Office Integration

Collaboration with Microsoft Groupware and Microsoft Office.

The OpenScape UC Application supports copying Outlook contacts so that you 
can use your contacts from the OpenScape UC Application clients. This must be 
configured by your system administrator.

If your system administrator does not configure copying your Outlook contacts as 
OpenScape UC Application contacts, the Outlook and OpenScape 
UC Application contacts are managed on the respective servers separately. 
However, you may copy Outlook contacts to your OpenScape UC Application 
contact list.

The Microsoft Office integration with the OpenScape UC Application enables you 
to:

• Integrate any of your Outlook contacts in your OpenScape UC Application 
contact list.

• Add contacts from the global Microsoft Exchange address book (global 
address list, GAL).

• Call a contact directly from Outlook.

• Send an e-mail to a person of your OpenScape UC Application contact list by 
clicking on the e-mail icon next to the desired entry.

• Receive your voicemail directly in your e-mail inbox.
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• Administer your inbox, your calendar and your voicemails by telephone.

2.1.4  IBM Lotus Groupware Integration

Collaboration with IBM Lotus Groupware.

Your Lotus Notes contacts are separated from your OpenScape UC Application 
contacts, since they can only be maintained in the third-party system. However, 
you may copy Outlook contacts to your OpenScape UC Application contact list.

The IBM Lotus Notes integration with the OpenScape UC Application enables 
you to:

• Integrate any contacts from your Lotus Notes address book in your 
OpenScape UC Application contact list.

• Call a contact directly from Lotus Notes.

• Receive your voicemail directly in your e-mail inbox.

• Administer your inbox, your calendar and your voicemails by telephone.

2.1.5  Microsoft Office Communications Server (OCS) Integration

Collaboration with Microsoft Office Communications Server.

Your OCS contacts are separated from your OpenScape UC Application contacts 
and are only maintained in the third-party system. However, you may copy OCS 
contacts to your OpenScape UC Application contact list. You cannot save 
OpenScape UC Application contacts from the Microsoft Office Communications 
server.

The Micosoft Office Communications Server integration with the OpenScape 
UC Application enables you to:

• Integrate any contacts from your OCS address book in your OpenScape 
UC Application contact list.

• Use your OpenScape UC Application or OCS presence status for ideal 
communication with your contacts/colleagues.

• Communicate in an easy and safe way with your contacts/colleagues via 
instant messaging.
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3  Overview of the OpenScape UC Application Clients

The clients for operating the OpenScape UC Application features.

The following clients are available for the OpenScape UC Application communi-
cations system:

• OpenScape Desktop Client Enterprise Web Embedded Edition

• OpenScape Web Client

• OpenScape Mobile Client

• OpenScape Voice Portal

• OpenScape UC Speech Portal

• OpenScape Extensions for Microsoft Outlook

• OpenScape Extensions for Lotus Notes

• OpenScape Desktop Integration

• OpenScape Click-to-Dial-Browser-Plug-in

• OpenStage Client

• OpenScape Client Integrations

• OpenScape Fusion for Google Apps

3.1  OpenScape Desktop Client Enterprise Web Embedded Edition

OpenScape Desktop Client Enterprise Web Embedded Edition Features

NOTICE:  Operating the OpenScape Desktop Client Enterprise 
Web Embedded Edition is described in the OpenScape 
UC ApplicationOpenScape Desktop Client Enterprise Web 
Embedded Editionmanual.

The OpenScape Desktop Client Enterprise Web Embedded Edition enables you 
to reach people fast and smoothly, or to access important information - regardless 
of whether you are in the office, at home, or on the road. This software solution is 
provided on a server and can be used by a lot of people at the same time. The 
client uses the Intranet connection to this server and provides a wide range of 
features.

The OpenScape Desktop Client Enterprise Web Embedded Edition offers the 
following features among other things:

3.1.1  Own Calls

Feature: Own Calls.

With the help of several icons you can make calls, configure conferences and 
track your current device status.
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3.1.2  Conferencing

Feature: Conferencing.

You can quickly and easily initiate ad-hoc conferences, start and administer pre-
configured meet-me conferences and schedule and configure future confer-
ences. The OpenScape Desktop Client Enterprise Web Embedded Edition allows 
connecting up to 300 users in a voice conference.

3.1.3  Contact List

Feature: Contact List.

You administer your contacts here and can check whether a contact can be 
reached via telephone, e-mail or instant message.

3.1.4  Own Status

Feature: Own Status.

Here you can enter your status, so that the OpenScape UC Application can 
determine the most suitable way of communication based on your presence infor-
mation. In a Micosoft Office Communications Server integration the OpenScape 
UC Application automatically copies the presence status defined there.

3.1.5  Preferred Device

Feature: Preferred Device.

Here you can specify which of your voice devices (landline telephone, cell phone, 
private phone etc.) OpenScape UC Application is to use for incoming and 
outgoing calls.

3.1.6  Instant Messaging (IM)

Feature: Instant Messaging.

Using instant messaging you can send text messages to OpenScape users who 
are currently online. Delivery takes place directly when sending the message so 
that your colleague may react and answer immediately.

3.1.7  Journal

Feature: Journal.
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Here you can log all incoming and outgoing calls, even if you are offline.

3.1.8  Video Conferencing

Feature: Video Conferencing.

Setting up video conferences to other OpenScape users.

3.2  OpenScape Web Client

OpenScape Web Client Features

NOTICE:  Operating the OpenScape Web Client is described in 
the OpenScape UC ApplicationOpenScape Web Clientmanual.

The OpenScape Web Clientis a server-based CTI solution for the intranet. The 
software installation and configuration takes places centrally on the server. User-
related journal data and settings are stored on the server, too. Even if the user PC 
is switched off, all journal information relevant to the user is maintained on the 
server and immediately available at the new login since the user data is centrally 
saved on the server.

The OpenScape Web Clientis a CTI client with a connection to the PBX HiPath 
4000. It uses the internet connection to the OpenScape UC Application.

A web browser is sufficient for invoking the OpenScape Web Client. Thus, the 
installation on your workstation that is usually necessary for clients does not 
apply. The quick and simple distribution in the intranet is thus ensured and the 
OpenScape Web Client can be immediately used at each computer in the 
intranet.

The OpenScape Web Client offers the following features among other things:

3.2.1  Own Calls

Feature: Own Calls.

With the help of several icons you can make calls, configure conferences and 
track your current device status.

3.2.2  Conferencing

Feature: Conferencing.
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You can quickly and easily initiate ad-hoc conferences, start and administer pre-
configured meet-me conferences and schedule and configure future confer-
ences. The OpenScape Desktop Client Enterprise Web Embedded Edition allows 
connecting up to 300 users in a voice conference.

3.2.3  Contact List

Feature: Contact List.

You administer your contacts here and can check whether a contact can be 
reached via telephone, e-mail or instant message.

3.2.4  Own Status

Feature: Own Status.

Here you can enter your status, so that the OpenScape UC Application can 
determine the most suitable way of communication based on your presence infor-
mation. In a Micosoft Office Communications Server integration the OpenScape 
UC Application automatically copies the presence status defined there.

3.2.5  Preferred Device

Feature: Preferred Device.

Here you can specify which of your voice devices (landline telephone, cell phone, 
private phone etc.) OpenScape UC Application is to use for incoming and 
outgoing calls.

3.2.6  Instant Messaging (IM)

Feature: Instant Messaging.

Using instant messaging you can send text messages to OpenScape users who 
are currently online. Delivery takes place directly when sending the message so 
that your colleague may react and answer immediately.

3.2.7  Journal

Feature: Journal.

Here you can log all incoming and outgoing calls, even if you are offline.
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3.3  OpenScape Mobile Client

OpenScape Mobile Client Features

NOTICE:  Operating the OpenScape Mobile Client is described in 
the OpenScape UC ApplicationOpenScape Mobile Clientmanual.

The OpenScape Mobile Client allows cell phone users to deploy presence-based 
contact lists and conference teamwork features via remote access. 

The following mobile devices are supported:

• Blackberrys

• Nokia mobile phones of the E series

• Mobile devices with Windows operating systems 

NOTICE:  You find current and detailed information about the 
supported mobile devices and their operating systems in the 
OpenScape UC Application Planning Guide manual.

After the installation of the required applet on the mobile devices the available 
features are offered via a main menu. 

The status bar at the lower margin of the monitor displays the current user, the 
selected device and the network status.

You can access the following features via the OpenScape Mobile Client:

3.3.1  Calling

Feature: Calling.

This feature allows dialing a phone number not entered in your contact list.

3.3.2  Handover to

Feature: Handover to.

Using this feature you can transfer an existing connection to another device 
assigned to you or to another extension. This extension can be yours or that of 
another person.

3.3.3  Contacts

Feature: Contacts.
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You can open your contact list and create, edit or delete contacts.

3.3.4  Journal

Feature: Journal.

The last 20 incoming, outgoing and missed calls can be displayed.

3.3.5  Devices

Feature: Devices.

You can open your device list and add, modify or delete devices. Additionally, you 
can select a device as preferred device.

3.3.6  Updating

Feature: Updating.

You can use this feature to update the display.

3.3.7  Setting a Status

Feature: Setting a Status.

You can call your status options list for your presence display and change your 
presence status.

3.3.8  Setting a Rule

Feature: Setting a Rule.

You can activate or deactivate call handling rules.

3.3.9  Settings

Feature: Settings.

You can define call handling rules, have user information displayed and view an 
error log.
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3.4  OpenScape Fusion for Google Apps

Features of the OpenScape Fusion for Google Apps

OpenScape Fusion for Google Apps enables Google domain users to deploy 
OpenScape UC Application features such as the One-Number Service, device or 
presence management.

OpenScape Fusion for Google Apps on a separate computer in a DMZ to access 
the OpenScape UC Application in the corporate network (intranet) from the 
Google domain in the internet.

Google Apps is a Google service that offers independently adjustable versions of 
different Google products under a customized domain name. Amongst other 
things, the service provides different web applications with similar functions as 
you know them from traditional Office Suites. Examples are Gmail, Google 
Groups, Google Calendar and Google Docs.

The functions of OpenScape Fusion for Google Apps are provided via Google 
Gadgets. Such gadgets are web-based applications implemented in the user 
interfaces of the applications Google Mail and Google Calendar.

OpenScape Fusion for Google Apps offers the following features:

3.4.1  Initiating Calls

Feature: Initiating Calls

The user enters a phone number, a name or part of a name (auto-completion) and 
initiates a call. To complete the name automatically, the system searches the 
private Google contacts and the OpenScape UC Application contacts. Which 
device is used for outbound calls depends on the preferred devices or device lists 
specified. The call is always finished on the device used.

3.4.2  Contact Synchronization

Feature: Contact Synchronization

Google Apps users can synchronize their contacts manually. Private OpenScape 
UC Application contacts can be integrated in private Google contacts. Private 
Google contacts can be integrated in private OpenScape UC Application 
contacts. 

Private contacts are available in the Google domain and/or in the database of the 
OpenScape UC Application. If required, the user synchronizes manually.

• As soon as a Google domain user has been created, he/she can manually 
integrate his/her entire private contacts from the OpenScape UC Application 
in his/her Google contacts.

• In Google, you can add, edit, delete, and copy contacts. The data of a new 
contact is stored in the Google contacts. After manual synchronization, the 
new contact is also available in the OpenScape UC Application. If the Google 
contacts are modified, such changed contact data is also available in the 
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database of the OpenScape UC Application after manual synchronization. 
Contacts removed from the Google contact list must be manually deleted from 
the OpenScape UC Application contact list.

• In the OpenScape UC Application, you can add, edit, and delete contacts. 
The data of a new contact is stored in the contact list of the OpenScape UC 
Application user. After manual synchronization, the new contact is also 
available in the Google contact list. If the OpenScape UC Application contacts 
are modified, such changed contact data is also available in the Google 
domain after manual synchronization. Contacts removed from the 
OpenScape UC Application contact list must be manually deleted from the 
Google contact list. The data of a new contact is stored in the Google 
contacts. After manual synchronization, the new contact is also available in 
the OpenScape UC Application. If the Google contacts are modified, such 
changed contact data is also available in the database of the OpenScape UC 
Application after manual synchronization. Contacts removed from the Google 
contact list must be manually deleted from the OpenScape UC Application 
contact list.

3.4.3  Preferred Devices

Feature: Preferred Devices.

The user can add, edit and delete devices and device lists. A device list consists 
of a group of several devices. To specify the preferred device or preferred device 
list the user selects an entry in the list of configured devices or device lists.

After a device has been selected as preferred device, it will be used for in- and 
outbound calls by default.

After a device list has been selected as preferred device list, the first device in this 
list will be used for outbound calls by default. Incoming calls will be signalled on 
the first device as long as the Ring-No-Answer (RNA) timeout of the device is not 
exceeded. If you do not accept the call within the RNA period of the device, the 
call will be signalled on the next device in the list.

3.4.4  Conferencing

Feature: Conferencing.

The user can add an OpenScape dial-in phone conference to an appointment 
entered in the calendar. He/she does this via the OpenScape Calendar Sidebar 
Gadget.

The OpenScape Calendar Sidebar Gadget enables the user to:

• Create phone conferences

• Start phone conferences and take part in them

• Add participants to a phone conference

• Terminate phone conferences

• Delete phone conferences

• Delete calendar entries
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3.4.5  Click-to-Dial

Feature: Click-to-Dial

If a user opens an e-mail in Gmail, he/she can initiate a phone call to the mail's 
originator and to a maximum of four further recipients or to recipients specified 
under Cc.

Appropriately configured, the number of recipients displayed with phone number 
can be increased. This is a general configuration, i. e., it is valid for all Google 
users.

The originator or the recipients are only displayed if contact data, e-mail address 
(search criterion) and phone number are available in the private contacts of the 
Google user or in the private and global contacts of the OpenScape UC Appli-
cation user. You can select one of the available phone numbers and initiate the 
call using Click-to-Dial.

When the user opens an e-mail for the first time, he/she is prompted to specify 
the URL of the Google Apps server. If the Google Apps server cannot be reached 
or the cookies have been deleted, the user is prompted to enter the URL once 
more.

To save resources, the Google Apps server ends the session after half an hour. 
In this case the user needs to reopen the mail to have the Click-to-Dial feature 
available again.

3.4.6  Presence Status

Feature: Presence Status

The user can change his/her presence status via the presence status self-
management function. The following statuses are available:

• Available

• Unavailable

• Do not disturb

• Be right back

• Busy

• In meeting

NOTICE:  The OpenScape presence status and the Google 
Instant Messaging status are two mutually independent status 
displays. There is no functional correlation between the two.

3.4.7  Single Sign-On

Feature: Single Sign-On
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When the user logs on to Google Apps after having installed the Gmail Sidebar 
Gadget, he/she will be automatically logged on to the OpenScape UC Application 
also. When the user logs on for the first time, a pop-up opens in which the user 
needs to confirm the transmission of the e-mail address. If pop-ups are disabled, 
the user needs to click on the Sign-in link.

3.5  OpenScape Voice Portal

OpenScape Voice Portal Features

NOTICE:  You find a detailed description of how to operate the 
OpenScape Voice Portal in another passage of this manual.

The OpenScape Voice Portal can be used from any phone. It uses the connection 
of cable connected telephones to OpenScape UC Application. To this, the 
OpenScape VoiceHiPath 4000 PBX must have been installed in your OpenScape 
UC Application environment. You can access the OpenScape Voice Portal via 
telephone keypad and deploy its features.

The OpenScape Voice Portal supports the following categories of features:

• Logging on to the system and accessing the main menu

• Via the Mailbox menu:

– Sending voicemails

– Playing messages

– Selecting message types

– Switching message directories

• Via the Calendar menu:

– Accessing the Microsoft Outlook and Lotus Notes calendar feature

• Via the Conferences menu:

– Joining a conference

– Starting a conference

• Via the Settings menu:

– Configuring the answering options. These include recording welcome 
greetings and the individual name.

– Setting voicemail options. Via this you can change your password and 
administrate your trusted numbers that enable simplified system access.

– Setting the Unified Communications options. In this menu you can change 
your presence status, set your preferred device and select a routing rule 
for incoming calls.

– Editing your contacts. Via this you can name dial a contact or retrieve the 
presence status of a selected contact.

• Via the Call subscriber menu:

– Calling a subscriber directly (entering the phone number) or via name 
dialing (entering the contact name).
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• Via the Help menu detailed help greetings for the main menu are played.

NOTICE:  A help feature is available for all menus via which you 
can play detailed help greetings to every menu you are currently 
in.

3.5.1  OpenScape Voice Portal mit PhoneMail

OpenScape Voice Portal mit PhoneMail Features

NOTICE:  You find a detailed description of how to operate the 
OpenScape Voice Portal mit PhoneMail in another passage of this 
manual.

You can reach various OpenScape Voice Portal functions also via the OpenScape 
Xpressions PhoneMail telephone interface, if an OpenScape XpressionsOpen-
Scape UC Application

The following OpenScape Voice Portal features are then additionally available to 
PhoneMail users:

• Access to the OpenScape UC Application function Conferencing with the 
features:

– Joining a conference

– Starting a conference

• Providing the OpenScape UC Application function Unified Communications 
Options with the features:

– Accessing the Calendar menu. The Calendar menu offers access to the 
calendar features of Microsoft Outlook and Lotus Notes.

– Accessing your presence status settings for changing your presence 
status.

– Accessing the settings of your preferred device

– Accessing the routing rules for activating one of the routing rules you have 
defined.

3.6  OpenScape UC Speech Portal

General description of the OpenScape UC Speech Portals.

The OpenScape UC Speech Portal is the telephone user interface (TUI) for the 
OpenScape UC Application which is operated via voice commands. Thus, you 
can access the OpenScape UC Application features by spoken commands. 
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Your spoken commands are converted to control commands via a speech recog-
nition software installed on the server.

NOTICE:  The speech recognition software is currently only 
available for English and German.

The feature range is to a large extent identical to the OpenScape Voice Portal 
feature range. In addition to the features available in OpenScape Voice Portal, the 
following actions can also be performed:

• Creating calendar entries

• Performing ad-hoc conferences

You can use the following OpenScape UC Application features by spoken 
commands:

• In the Control Mode (Direct Access), you have the following options after 
having logged on to the system:

– Editing your messages

– Accessing your calendar and creating calendar entries

– Joining a conference, starting a conference and performing an ad-hoc 
conference

– Changing your system settings

– Calling any subscriber

• In the Answering Machine Mode (Guest Access), you may: 

– Create you personal answering machine by configuring a call diversion to 
the Answering Machine Mode. Furthermore, you can call the Answering 
Machine Mode directly from any phone and record voicemails for the 
OpenScape subscribers and store the messages in their mailbox.

NOTICE:  The Control Mode and the Answering Machine Mode 
can be reached by dialing different access numbers.

The OpenScape UC Speech Portal can be reached and used from any phone.

Your system administrator provides the code numbers for logging on to the 
OpenScape UC Speech Portal: 

• Your access number for the OpenScape UC Speech Portal Control Mode.

• Your account number for the Control Mode.

• Your password (PIN) for the Control Mode.

• Your access number for the OpenScape UC Speech Portal Answering 
Machine Mode.

NOTICE:  If voice commands are not recognized by the system, 
it will allow you after a number of failed attempts to trigger 
selected actions by using the telephone keypad. The available 
options will be announced for the corresponding menu.
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3.7  OpenScape Extensions for Microsoft Outlook

OpenScape Extensions for Microsoft Outlook Features

NOTICE:  Please refer to other passages in this manual for the 
setup, configuration and operation of OpenScape Extensions for 
Microsoft Outlook.

The OpenScape Extensions for Microsoft Outlook for the OpenScape 
UC Application server facilitates scheduling and monitoring conferences.

This function provides the following features via the calendar function of 
Microsoft Outlook:

• Scheduling an audio conference (telephone conference).

• Automatic start of the audio conference at the defaulted time (scheduled 
conferencing).

• Scheduling and initiating a web conference.

• Scheduling a video conference

You can additionally configure the following feature via the OpenScape Exten-
sions for Microsoft Outlook configuration settings:

• Synchronizing your OpenScape presence status based on the 
Microsoft Outlook calendar data.

3.8  OpenScape Extensions for Lotus Notes

OpenScape Extensions for Lotus Notes Features

NOTICE:  Please refer to other passages in this manual for the 
setup, configuration and operation of OpenScape Extensions for 
Lotus Notes.

The OpenScape Extensions for Lotus Notes for the OpenScape UC Application 
server facilitates scheduling and monitoring conferences.

This function provides the following features via the calendar function of IBM 
Lotus Notes:

• Scheduling an audio conference (telephone conference).

• Automatic start of the audio conference at the defaulted time (scheduled 
conferencing).

• Scheduling and initiating a web conference.

• Scheduling a video conference

You can additionally configure the following feature via the OpenScape Exten-
sions for Lotus Notes configuration settings:

• Synchronizing your OpenScape presence status based on the IBM Lotus 
Notes calendar data.
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3.9  OpenScape Desktop Integration

OpenScape Desktop Integration Features

NOTICE:  Please refer to other passages in this manual for the 
setup, configuration and operation of OpenScape Desktop 
Integration.

Using the information on the DesktopIntegration tab of the OpenScape Web 
Client you can install a small program on your workstation that allows calling a 
subscriber from any application.

Example:

A Word document you have opened contains a phone number. Select this phone 
number in the text and enable the hotkey you have defined for this purpose. A call 
to this number is immediately initiated.

Furthermore, incoming calls and instant messages are signalled via the 
OpenScape Desktop Integrationapplication even if the OpenScape Web Client 
screen is closed.

In the OpenScape Desktop Integration application you can set further options for 
the startup behavior, the OpenScape Web Client display and the notification 
options.

3.10  OpenScape Click-to-Dial-Browser-Plug-in

OpenScape Click-to-Dial-Browser-Plug-in Features

NOTICE:  Please refer to other passages in this manual for the 
setup, configuration and operation of OpenScape Click-to-Dial-
Browser-Plug-in.

The OpenScape Click-to-Dial-Browser-Plug-in enables making calls by mouse-
click from a web browser. 

You can integrate this function in theInternet Explorer and optionally in the Mozilla 
Firefox.

The plug-in provides a call entry in the web browser's search engine list in 
addition. This enables you to enter any phone number, which is dialed via the 
OpenScape Web Client, in the search field of your preferred web browser via PC 
keyboard.

3.11  OpenStage Client

OpenStage Client Features
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If the OpenStage Client application is installed on the OpenScape UC Application, 
you can operate important OpenScape UC Application functions that are normally 
used via the OpenScape Web Client, the OpenScape Desktop Client Enterprise 
Web Embedded Edition or the OpenScape Mobile Client via the application 
OpenStage Client with telephones of type OpenStage 60 or OpenStage 80.

The following OpenScape UC Application functions are supported for operation 
on the telephone OpenStage:

• Displaying and changing your own presence status.

• Displaying and changing the preferred device.

• Looking for contacts in available address books.

• Displaying your own contact list and calling a selected contact from there.

• Displaying your own telephone journal with the following operating options:

– Callback to a selected entry in the caller list.

– Filtering call entries by call event time (today, yesterday, last week, by 
date).

• Displaying your conferences, starting them and controlling existing confer-
ences.

3.12  OpenScape Client Integrations

OpenScape Client Integrations Features

After installing OpenScape Client Integrations you can use the click-to-dial 
function independently of setting up another CTI client such as the OpenScape 
Desktop Client Enterprise Web Embedded Edition or the OpenScape Web Client. 
You can thus implement this function in many clients and use it there.
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4  OpenScape Voice Portal

General description of the OpenScape Voice Portal.

The OpenScape Voice Portal is a telephone user interface (TUI) for the 
OpenScape UC Application. This interface lets you access the OpenScape 
UC Application functions via telephone keypad. In the corresponding menus, the 
options available are announced by the system which allows an intuitive 
operation.

You can use the following OpenScape UC Application features via telephone:

• In the Control Mode (Direct Access), you have the following options after 
having logged on to the system:

– Editing your messages

– Accessing your calendar

– Joining or starting a conference

– Changing your system settings

– Calling any subscriber

• In the Answering Machine Mode (Guest Access), you may: 

– Create you personal answering machine by configuring a call diversion to 
the Answering Machine Mode. Furthermore, you can call the Answering 
Machine Mode directly from any phone and record voicemails for the 
OpenScape subscribers and store the messages in their mailbox.

NOTICE:  The Control Mode and the Answering Machine Mode 
can be reached by dialing different access numbers.

The OpenScape Voice Portal can be reached and used from any phone.

Your system administrator provides the code numbers for logging on to the 
OpenScape Voice Portal: 

• Your access number for the Control Mode in the OpenScape Voice Portal.

•  Your phone number for the Control Mode.

• Your password (PIN) for the Control Mode.

• Your access number for the Answering Machine Mode in the OpenScape 
Voice Portal.

NOTICE:  If you use name dialing, special characters (ä, ö and ü) 
in person's names must be marked by a following “e” (numerical 
key 3). The name “Äuld” would be written as “aeuld” and corre-
spond to the numbers "23853". The German special character “ß” 
must be replaced by “ss” (77).

This chapter shows the operation of the Control Mode in OpenScape Voice Portal 
via your telephone keypad in graphic overviews.
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4.1  OpenScape Voice Portal Operating Modes

Operating modes for the OpenScape Voice Portal.

Each OpenScape UC Application user is assigned one of three messages/
OpenScape Voice Portal operating modes:

• OpenScape UC Application Voice Portal basic Unified Messaging

• Other Voicemail/Unified Messaging

• OpenScape Xpressions Unified Messaging (PhoneMail)

In these three operating modes different features are available.

The setup version of your system environment determines which of these 
operating modes are available. In case of doubt please contact your system 
administrator.
 A31003-S5070-U101-3-7619, 06/2012
40 OpenScape UC Application V7 Client Applications, User Guide



OpenScape Voice Portal
Access to the OpenScape Voice Portal
You will find an overview of these differences in the following table:

NOTICE:  A finer control of the feature access is possible via the 
OpenScape UC Application licence administration.

NOTICE:  In mulitlingual environments several access codes can 
be provided for a certain usage mode.

NOTICE:  Please ask your system administrator for information 
on your assigned user type and the access number to be used.

4.2  Access to the OpenScape Voice Portal

Logon options to the OpenScape Voice Portal Control Mode (Direct Access).

You can use the OpenScape Voice Portal functions via two types of access: The 
following access types to the Control Mode (Direct Access) are possible:

• A direct logon to the OpenScape Voice Portal.

Function of the 
OpenScape Voice 

Portal

OpenScape 
UC Application 

Voice Portal basic 
Unified Messaging

Other Voicemail/
Unified Messaging

OpenScape Xpres-
sions PhoneMail

Access number of 
the Control Mode 
(Direct Access)

OpenScape Voice 
Portal number for the 
Control Mode

OpenScape Voice 
Portal number for the 
Control Mode

OpenScape Xpres-
sions PhoneMail 
number for the 
Control Mode

Login and main 
menu

Yes Yes AboutOpenScape 
Xpressions 
PhoneMail

Messages Yes Transfer to another 
UM/VM system

AboutOpenScape 
Xpressions 
PhoneMail

Calendar Yes Yes Yes

Conferences Yes Yes Yes

Settings Yes Yes Yes

Calling subscribers Yes Yes AboutOpenScape 
Xpressions 
PhoneMail

Access number for 
the Answering 
Machine Mode 
(Guest Access)

OpenScape Voice 
Portal number for the 
Answering Machine 
Mode

OpenScape Voice 
Portal number for the 
Answering Machine 
Mode

OpenScape Xpres-
sions PhoneMail 
number for the 
Answering Machine 
Mode
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• A logon to the OpenScape Xpressions PhoneMail. This means that the 
OpenScape Xpressions PhoneMail functions are extended by further 
OpenScape Voice Portal functions.

NOTICE:  The Answering Machine Mode is used in the 
OpenScape Voice Portal and the OpenScape Xpressions 
PhoneMail via a separate access number which does not require 
a logon to the system.

4.2.1  Access via direct Logon to the OpenScape Voice Portal

Direct logon to the OpenScape Voice Portal.

In case of use via direct logon to the OpenScape Voice Portal the following modes 
are possible:

• OpenScape UC Application Voice Portal basic Unified Messaging

• Other Voicemail/Unified Messaging

The OpenScape Voice Portal supports the following categories of features:

• Login. After you have logged in successfully, you have access to the main 
menu.

• Messages

• Calendar

• Conferences

• Settings

• Calling subscribers

4.2.2  OpenScape Voice Portal Access via OpenScape Xpressions 
PhoneMail

OpenScape Voice Portal Access via OpenScape Xpressions PhoneMail.

You can reach various OpenScape Voice Portal functions also via the OpenScape 
Xpressions PhoneMail telephone interface, if an OpenScape Xpressions server 
is integrated in the OpenScape UC Application environment. 

The following OpenScape Voice Portalfeatures are then additionally available to 
OpenScape Xpressions PhoneMail users:

• Accessing the Conferences menu of OpenScape UC Application with the 
functions:

– Joining a conference

– Starting a conference

• Providing the OpenScape UC Application function Unified Communications 
Options with the features:
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– Accessing the Calendar menu. The Calendar menu offers access to the 
calendar features of Microsoft Outlook and Lotus Notes.

– Accessing your presence status settings for changing your presence 
status.

– Accessing the settings of your preferred device

– Accessing the routing rules for activating one of the routing rules you have 
defined.

4.3  The OpenScape Voice Portal Features

OpenScape Voice Portal features.

The OpenScape Voice Portal supports the following categories of features:

In the Control Mode (Direct Access)

• Logging on to the system and accessing the main menu

• Via the Mailbox menu:

– Sending voicemails

– Playing messages

– Selecting message types

– Switching message directories

• Via the Calendar menu:

– Accessing the Microsoft Outlook and Lotus Notes calendar feature

• Via the Conferences menu:

– Joining a conference

– Starting a conference

• Via the Settings menu:

– Configure the reply options. These include recording welcome greetings 
and the individual name.

– Setting voicemail options. Via this you can change your password and 
administrate your trusted numbers that enable simplified system access.

– Setting the Unified Communications options. In this menu you can change 
your presence status, set your preferred device and select a routing rule 
for incoming calls.

– Editing your contacts. Via this you can name dial a contact or retrieve the 
presence status of a selected contact.

• Via the Call subscriber Menu 

– Calling a subscriber directly (entering the phone number) or via name 
dialing (entering the contact name).

• Via the Help menu detailed help greetings for the main menu are played.

NOTICE:  A help feature is available for all submenus via which 
you can play detailed help greetings to every menu you are 
currently in.
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In the Answering Machine Mode (Guest Access)

• Configuring a personal answering machine by creating a call diversion to the 
Answering Machine Mode. Furthermore, you can call the Answering Machine 
Mode directly from any phone and record voicemails for the OpenScape 
subscribers and store the messages in their mailbox.

4.4  Logging on to the Main Menu

Logging on to the OpenScape Voice Portal and to the main menu.

If you wish to edit messages or your mailbox settings, you need to log on to the 
OpenScape Voice Portal Control Mode via telephone to reach the main menu. For 
this purpose you can use any telephone.

NOTICE:  The system can be configured by the administrator so 
that you need to record your name first with the first logon to 
OpenScape Voice Portal. In this case, you cannot access the 
system without recording your name.

To log on to the system you need to pass through a default logon procedure.

The following diagram shows the steps necessary for gaining access to the 
OpenScape Voice Portal:

NOTICE:  The system can be configured by the administrator so 
that after the logon procedure, you are offered the option to 
access directly the Join conference menu if at least one active 
conference exists for you, or to continue with the main menu.

Enter Control 
Mode access 

number

Mailbox settings1
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Settings4

Call subscriber7

Help0

Invalid account 
number or PIN

User identification via ANI
 (ANI = Automatic Number Identification)
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login attempts
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Close connection

1 2 3
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7 8 9

0 #*

Enter account 
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1 2 3

4 5 6

7 8 9

0 #*

Enter PIN
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0 #*
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4.4.1  How to Log on to the OpenScape Voice Portal

Logging on to the OpenScape Voice Portal follows a given procedure.

Prerequisites • The OpenScape Voice Portal can exclusively be used at an installed 
OpenScape UC Application system.

• You have an account on the OpenScape UC Application system.

• You know the access number of the Control Mode (Direct Access). If you do 
not know your PIN, please ask your system administrator.

• You know your account number. If you do not know your PIN, please ask your 
system administrator.

• You know your password (PIN). If you do not know your PIN, please ask your 
system administrator.

NOTICE:  Your administrator will give you a password (PIN) for 
your first login that you can use for your first login at the system. 
The system can be configured so that you need to change your 
password (PIN) during this first login.

Step by Step 1. Enter the Control Mode access number via telephone.

If you call from a corporate phone, this will in most cases be an extension. If 
you make an external call or use your cellphone, you need to enter the 
complete company number, followed by the Control Mode access number.

The system then prompts you to enter your account number.

2. Enter the account number.

The system then prompts you to enter your PIN.

3. Enter your PIN for authentication.

During or after dialing in, the following operating states may occur:

• After having entered your logon data correctly, you will be connected to the 
OpenScape Voice Portal Control Mode. Depending on the server configu-
ration, you will be: 

– directly in the main menu to access the functions to edit your mailbox.

– directly in the conference menu if at least one active conference exists for 
you. In this case, you will be offered first the active conferences to join 
them. Only if you refuse to do so, you will access the main menu.

• If you make a mistake while entering the data, the system prompts you to 
repeat your entries from step 2.

• If the number of your login attempts exceeds the pre-set number of attempts, 
the connection is closed. Then dial in again, starting with step 1.
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4.5  The Mailbox Menu

Overview of the Mailbox menu functions.

You can use the OpenScape Voice Portal to access your mailbox by telephone 
keypad.

The Mailbox menu offers the following features:

• Sending messages (voicemails)

• Playing new Voicemails

• Selecting message types

• Switching message directories

4.5.1  Sending Messages

Overview diagram with the full functional range for sending messages.

The Send message menu lets you create and address new messages.

Creating and sending a message takes place according to the following pattern:

Invoke the Send message menu > Address the message > Record the message 
> Select the delivery option.
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Please refer to the following figure for detailed operating options of the Send 
message menu:

4.5.1.1  How to Send Messages

Sending a message (voicemail).

Step by Step 1. Select the Send message menu.

After you have selected this function the system prompts you to enter the 
recipient's address.

2. Address the voicemail. 

You can address the recipient of the voicemail either by entering the account 
number or via name dialing.

After you have entered the recipient, the system prompts you to record the 
message.

3. Record the message.

Follow the system prompts to record the message.

After you have completed your recording, the system prompts you to select a 
delivery option.
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4. Define the delivery option.

After you have recorded the voicemail you can set one or several of the 
following delivery options:

• Requesting a delivery report.

• Sending the message as confidential.

• Sending the message as urgent.

• Selecting standard delivery (without one of the aforementioned options)

5. Send the message.

After you have finished setting the delivery options or selected the standard 
delivery, the voicemail is sent automatically.

4.5.2  Playing new Voicemails

Overview diagram with the full functional range for playing messages.

You can access newly received messages via the Select new voicemail menu.

Playing a new message takes place according to the following pattern:

Invoke the Select new voicemail menu > Play message > Select the Editing 
function.
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Please refer to the following figure for detailed operating options of the Play new 
voicemail mailbox menu:

4.5.2.1  Playing new Voicemails

Playing a new voicemail message.

Step by Step 1. Select the New voicemail message menu.

After you have selected this function, a system greeting informs you by default 
how many new unread voicemails are in your mailbox. 

NOTICE:  You can have the system play messages according to 
the message type you select.
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2. Play message.

The messages are then played in the order latest message first.

3. Select modification feature.

After the playback or after you have cancelled the playback, the following 
modification options are - according to the message type - available for the 
latest played message:

• Sending, to send a message from the Drafts directory.

• Replying, with the options: Replying to sender or replying to all recipients 
of this message.

• Accepting or declining if the message is an invitation to a meeting.

• Going to the previous message.

• Undoing the deletion (only for messages from the Deleted objects 
directory) or setting a message status from read to unread.

• Going to the previous message.

• Playing the message again with further options.

• Deleting the message.

• Calling the originator.

NOTICE:  Then you go to the device selection menu for this user.

• Emptying the Deleted objects directory.

• Forwarding the message with or without a comment.

• Going to the next message.

• Changing the output language for messages that are played by Text-to-
speech (TTS).

NOTICE:  E-mails and appointment notifications are played. The 
system might inform you that the e-mail has an attachment. If the 
attachment is a text file, it is not played. Only WAV files are played 
automatically.

4.5.3  Selecting a Message Type

Overview diagram with the full functional range for selecting the message type.

Select this menu to define which type of messages you wish to listen to.

The selection takes place according to the following pattern:

Invoke the Select message type menu > Select the message type > Select the 
message options.
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Please refer to the following figure for detailed operating options of the Select 
message type mailbox menu:

4.5.3.1  How to Select a Message Type

Selecting the message type.

Step by Step 1. Invoke the Select message type menu.

The system announces the message types you can select.

2. Select the message type

You can select the following message types:

• Meetings or appointment invitations.

• Voicemails.

• E-mails.

• Meetings.
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• All messages.

NOTICE:  You can select meetings after choosing the inbox 
directory. If you have selected another directory, the menu item 
Appointment notices is displayed in this menu instead of the menu 
item Meetings.

3. Select the message options.

For voicemails and e-mails, you can start the message playback for all 
messages or limit the playback to certain messages. To limit the message 
selection to certain messages, you can choose between the following criteria:

• Playback of new messages.

• Playback of read messages.

• Playback of messages marked as urgent.

• Playback of regular messages.

• Playback of new messages marked as urgent.

• Playback of read messages marked as urgent.

• Playback of new regular messages.

• Playback of read regular messages.

You have the following options for meeting requests:

• Selecting appointment invitations.

• Selecting meeting replies.

• Selecting all appointment invitations and meeting replies.

After you have selected the desired message option, the system starts to play 
the messages with the selected options from the set message directory.

4.5.4  Switching message directories

Overview diagram with the full functional range for selecting the message 
directory.

Select this menu to define from which directory the messages you wish to listen 
to shall originate.

The selection takes place according to the following pattern:

Invoke the Change message directory menu > Select the message directory.
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Please refer to the following figure for detailed operating options of the Change 
message directory mailbox menu:

4.5.4.1  How to Switch the Message Directory

Switching to another message directory for message playback.

Step by Step 1. Invoke the Change message directory menu.

The system announces the message directories you can select.

2. Select the message directory.

You can select the following message directories:

• The inbox directory for received messages.

• The deleted-objects directory.

• The drafts directory.

After having selected the desired message directory, you will be offered by the 
system the selection of the desired message type. After this, the messages of 
the selected message type in this directory will be played.

4.6  The Calendar Menu

Overview of the Calendar menu functions.

You can use the OpenScape Voice Portal to access your Microsoft Outlook or 
Lotus Notes calendar via telephone keypad.

The Mailbox menu provides the following features:

• Retrieving the next upcoming appointment. The next appointment from the 
current time on within the next seven days is played.
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• Playing all appointments of a specific date range

4.6.1   Playing and Editing Appointments

Overview diagram with the full functional range for retrieving upcoming appoint-
ments.

This menu lets you play and edit the next appointment within the next seven days 
as well as look for appointments due on specific days.

The feature selection takes place according to the following pattern:

Select the Calendar menu function > have the next appointment played or look 
for an appointment > edit an appointment.

Please refer to the following illustration for detailed operating options of the 
Calendar menu:
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4.6.1.1  How to Retrieve the Next Upcoming Appointment

Playing the next upcoming appointment.

Step by Step 1. Select Calendar menu

The next appointment from the current time on within the next seven days is 
played.

2. Select the Play next appointment function.

Select this menu to play the next appointment.

3. Edit appointment.

After the appointment playback the following editing options are available:

• Recording a reply

• Playing a message

• Accepting/declining the appointment, with message recording

• Listing meeting participants

• Deleting/canceling the appointment

• Calling the meeting organizer

4.6.1.2  How to Play Appointments from a specific Date Range

Looking for appointments within a specific date range.

Step by Step 1. Select Calendar menu

The next appointment from the current time on within the next seven days is 
played.

2. Select the Look for appointments function.

The following options are available for this purpose:

• Play today's appointments

• Play tomorrow's appointments

• Enter time range (year, month and day) for the appointment search

3. Edit appointment.

After the appointment playback the following editing options are available:

• Recording a reply

• Playing the previous appointment

• Playing a message

• Accepting/declining the appointment, with message recording

• Listing meeting participants
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• Deleting/canceling the appointment

• Calling the meeting organizer

• Playing the next appointment

• Returning to the calendar menu

4.7  The Conferences Menu

Overview of the Conferences menu functions.

You can use the OpenScape Voice Portal to manage your conferences by 
keypad.

The Conferences menu provides the following features:

• Joining a conference

• Starting a conference

4.7.1   Starting or Joining Conferences

Overview diagram with full functional range for starting or joining conferences.

This menu lets you first play your upcoming conferences and, after you have 
selected a conference, you are automatically connected to this conference or can 
start it.

NOTICE:  Scheduled conferences, thus conferences with a 
defined start time configured via the OpenScape Desktop Client 
Enterprise Web Embedded Edition or the OpenScape Web Client, 
are not announced by the system.

The following conferences are announced by the system:

• Conferences that are in the lead time prior to the actual start or that have 
already been started so that you can join in.

• Conferences configured without a start time so that you can start or join them.

• Conferences created via OpenScape Extensions for Microsoft Outlook or 
OpenScape Extensions for Lotus Notes.

The feature selection takes place according to the following pattern:

Select the Conferences menu function > Join or start a conference.
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Please refer to the following figure for detailed operating options of the Confer-
ences menu:

4.7.1.1  How to Join a Conference

Joining a selected conference

Step by Step 1. Select the Conferences menu.

2. Select the Join conference function.

Select this menu to join a conference you have been invited to.

Via this feature the upcoming conferences are first played in groups of six.

3. Select conference.

After you have selected the Join conference function, the following editing 
options are available:

• Selecting a conference from the first group of six

• Going to the previous group of six

• Going to the next group of six

After you have selected the desired conference you are automatically 
connected to this conference.
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4.7.1.2  How to Start a Conference

Starting a (self-created) conference.

Step by Step 1. Select the Conferences menu.

2. Select the Start conference function.

Select this menu for starting a conference you have configured yourself. Then 
you can start the conference either by selecting the conference type or by 
having listed all conference that can be started.

The conferences you have configured yourself are played first.

3. Select conference type

Select this function if you wish to start a self-created conference via the 
conference type. The following selection options are available:

• Selecting the moderator conference that can be started if you have 
defined the conference so that only you as moderator are allowed to start 
the conference.

• Selecting the recurrent conference that can be started if you have defined 
the conference so that it is a recurrent conference.

• Selecting the one time conference that can be started if you have defined 
the conference so that it is a one time conference.

After you have selected this function, the available conferences are offered in 
groups of six so that you can pick the desired one.

4. Select all conferences that can be started.

Select this function if you wish to start one of your self-created conferences 
without considering the conference type.

After you have selected this function, the available conferences are offered in 
groups of six so that you can pick the desired one.

4.8  The Settings Menu

Overview of the functions of the Settings menu.

You can use the OpenScape Voice Portal to change your system settings by 
keypad.

The Settings menu provides the following features:

• Reply options
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– You can configure a special welcome greeting for each presence status 
(Available, In a meeting, Do not disturb, Be right back, Not available and 
Busy). The welcome greeting changes automatically when you change 
your status.

NOTICE:  The Unified Communications options menu lets you 
change your presence status also using the OpenScape Voice 
Portal.

– You can record your name. This name greeting is played e.g. if you send 
a voicemail to another OpenScape user.

INFO:  If you do not record a name, the name recording is 
generated and played via Text-to-Speech (TTS).

• Voicemail options

– You can change your password (PIN).

– You can administer your three trusted numbers

NOTICE:  Via the definition of trusted numbers a user can define 
the telephone extensions via which he/she can access his/her 
mailbox without identification, i.e. having to enter the account and 
PIN number. You can define a maximum of three devices as trust-
worthy. Please note that the device that is to be trustworthy allows 
to transmit the caller ID and that this feature is enabled. You 
should know that trusted numbers might become a security 
problem. Everyone who knows which telephone is trustworthy 
and has access to this device can have complete control over this 
foreign mailbox. You should never define the telephone at your 
work station as trustworthy, if other persons have access to your 
workstation.

• Unified Communications options

– Change your presence status.

– Set your preferred device.

– Activate a routing rule you have defined for incoming calls.

• Edit contact

– This menu lets you enter a contact's name by numerical keys to select 
him/her from your contact list for retrieving his/her presence status or 
calling him/her.

4.8.1  Reply Options

Overview diagram with the full functional range for setting your reply options.

Select this menu to perform the following actions:
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• Recording greetings for each of your presence statuses.

• Recording your name.

The selection takes place according to the following pattern:

Invoke the Settings menu > select Reply options > record/delete/edit a greeting 
or name.

Please refer to the below figure for detailed operating options of the Reply 
options menu from the Settings menu:

4.8.1.1  How to Record a Welcome Greeting

Recording a welcome greeting.

Step by Step 1. Select the Settings menu.

2. Select the Reply options function.

Select this menu to record your greetings.
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3. Select the Record greeting function.

Select this feature to record greetings for the presence statuses.

4. Assign greeting to a presence status or record alternate greeting.

Select the presence status for which you would like to record the welcome 
greeting. The following presence statuses are available:

• Available

• In a meeting

• Do not disturb

• Be right back

• Unavailable

• Busy

NOTICE:  You can also record an alternate greeting that is played 
if the configured presence status has no greeting.

5. Record/delete greeting.

Choose whether you would like to record a new greeting or delete an existing 
one. 

Record your greeting.

NOTICE:  After having deleted a greeting you will automatically go 
to the menu branch via which you can record a new greeting.

6. Edit greeting.

After the recording you can continue editing the recording. The following 
editing options are available for the recording:

• Discard greeting recording and rerecord.

• Continue recording.

• Play the recording (for checking purposes).

• Finish recording.

• Cancel recording and return to the menu branch Rerecord greeting.

4.8.1.2  How to Record your own Name

Recording your own name

Step by Step 1. Select the Settings menu.

2. Select the Reply options function.

Select this menu to record your greetings.
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3. Select the Record name function.

Select this feature to record your name.

If you have not recorded a name yet, you will automatically be asked to record 
your name.

NOTICE:  If you have already recorded your name you can use 
the editing functions to change the existing name recording.

4. Edit new name recording.

After you have recorded your name you can edit this recording. For editing the 
name recording the following options are available:

• Discard name recording and rerecord.

• Continue stopped recording.

• Play the recording (for checking purposes).

• Finish the recording.

• Cancel the recording and back to menu branch Rerecord name.

5. Change existing name recording.

If you have recorded your name already you are automatically taken to the 
menu branch for editing your current name recording. For editing the name 
recording the following options are available:

• Delete the existing name recording and rerecording the name

• Play the current name recording (for control purposes).

• Delete a name recording.

4.8.2  Voicemail Options

Overview diagram with the full functional range for setting your voicemail options.

Select this menu to perform the following actions:

• Changing your password (PIN)

• Managing your trusted numbers

NOTICE:  Please note that your new password (PIN) must corre-
spond to the guidelines for passwords (PINs) that are valid in your 
system.

The selection takes place according to the following pattern:

Invoke the Settings menu > Select Voicemail options > Select Change password 
or Manage trusted numbers.
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Please refer to the below figure for detailed operating options of the Voicemail 
options menu from the Settings menu:

4.8.2.1  How to Change the Password (PIN)

Changing the password (PIN)

Step by Step 1. Select the Settings menu.

2. Select the Voicemail options function.

Select this menu to edit your voicemail options.

3. Select the Change password function.

Select this menu to change your password (PIN).

You are prompted to enter a new password.

NOTICE:  Please note that your new password (PIN) must corre-
spond to the guidelines for passwords (PINs) that are valid in your 
system.

4. Enter password (PIN).

Enter your new password (PIN).
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5. Confirm/discard password (PIN).

After you have entered your new password (PIN) you have the following 
operating options:

• Confirm new password (PIN).

NOTICE:  If you have entered a password that does not corre-
spond to the system guidelines, you will go back to the menu 
branch to enter the password (PIN) to repeat entering the 
password.

• Discard entered password (PIN).

NOTICE:  You will then come back to the menu branch to enter 
your password (PIN).

4.8.2.2  How to Manage Trusted Numbers

Managing trusted numbers.

Step by Step 1. Select the Settings menu.

2. Select the Voicemail options function.

Select this menu to edit your voicemail options.

3. Select the Manage trusted numbers function.

Select this menu to manage your trusted numbers. The following operating 
options are available:

• Play current trusted numbers.

• Add trusted number.

NOTICE:  Following this action you reach the menu branch where 
you can define a device as trustworthy.

• Edit trusted number.

NOTICE:  Following this action you reach the menu branch where 
you can define another device as trustworthy.

• Delete trusted number.

NOTICE:  After you have deleted a trusted number you reach the 
menu branch in which you can define another device as trust-
worthy.
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4. Add trusted number.

Select this option to define another device as trustworthy. After you have 
invoked this function the following options are available:

• Select available device.

NOTICE:  Afterwards you arrive at the menu branch for selecting 
a device.

• Apply ANI.

NOTICE:  When you select this option, the phone number of the 
device called at the OpenScape Voice Portal is copied as trusted 
number.

• Copy dialable number.

NOTICE:  You will arrive at a menu branch where you can enter 
any phone number that will be defined as trustworthy.

5. Edit/delete trusted numbers

After you have selected the Edit/Delete trusted numbers feature the following 
options are available for selecting a new trustworthy device:

• Select the device you would like to edit/delete from the maximum of three 
existing trustworthy devices.

NOTICE:  After you have selected the device you reach the menu 
branch in which you can define another device as trustworthy.

4.8.3  Unified Communications Options

Overview diagram with the full functional range for setting your Unified 
Communications options.

Select this menu to perform the following actions:

• Changing your presence state

NOTICE:  This setting allows you to inform the other OpenScape 
UC Application users as to whether they can reach you.
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• Setting your preferred device

NOTICE:  Via this feature you can select the device from your 
device list that is to accept your incoming calls.

• Activating one of the routing rules you have defined

NOTICE:  Via this feature you can enable one of the routing rules 
for incoming calls that you have predefined.

The selection takes place according to the following pattern:

Invoke the Settings menu > Select Unified Communications options > Select 
Change presence status, Set preferred device or Activate rule.

Please refer to the below figure for detailed operating options of the Unified 
Communications options menu from the Settings menu:
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4.8.3.1  How to Set your Presence Status

Setting your own presence status.

Step by Step 1. Select the Settings menu.

2. Select the Unified Communications options function.

Select this menu to change your Unified Communications options.

3. Select the Change presence status function.

Select this menu to change your presence status.

Your current presence status is played.

In this menu branch the following operating options are available:

• Change status

• Keep current presence status. 

NOTICE:  After you have selected this option you return to the 
Unified Communications options menu.

4. Enter presence status

The following setting options are available for your presence status:

• Available

• In a meeting

• Do not disturb

• Be right back

• Unavailable

• Busy

4.8.3.2  How to Manage Preferred Devices

Setting the preferred device.

Step by Step 1. Select the Settings menu.

2. Select the Unified Communications options function.

Select this menu to change your Unified Communications options.

3. Select the Set preferred device function.

Select this feature to configure your preferred device. In this menu branch the 
following operating options are available:

• Change preferred device.
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• Keep currently preferred device.

NOTICE:  After you have selected this option you return to the 
Unified Communications options menu.

4. Select the preferred device.

If you have selected the option Change preferred device, the following setting 
options are available for your presence status:

• Select available device.

NOTICE:  Subsequently, you are taken back to the menu branch 
to select the preferred device.

• Apply ANI as preferred device.

NOTICE:  When you select this option, the phone number of the 
device called at the OpenScape Voice Portal is copied as 
preferred device.

• Copy dialable number.

NOTICE:  You will arrive at a menu branch where you can enter 
any phone number that will be defined as preferred device.

4.8.3.3  How to Activate a Routing Rule

Activating a routing rule.

Step by Step 1. Select the Settings menu.

2. Select the Unified Communications options function.

Select this menu to change your Unified Communications options.

3. Select the Enable routing rule function.

Select this function to activate one of your routing rules. In this menu branch 
the following operating options are available:

• Activate rule set.

NOTICE:  Your routing rules are combined to rule sets in groups 
of six.
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• Deactivate rule set. 

NOTICE:  After you have selected the Deactivate rule set option 
you are taken back to the menu branch where you can select 
another rule set or leave the Enable routing rule menu.

• Leave the Enable routing rule menu

NOTICE:  Leaving this menu and going back to the Unified 
Communications options menu..

4. Select routing rule

After you have activated a rule set, the following setting options are available 
for selecting the routing rule:

• Select rule.

NOTICE:  Select the rule you wish to use from a rule set of six 
rules. After you have selected the routing rule you return to the 
Settings menu.

• Go to the previous group of six

NOTICE:  This option lets you move to the previous rule set for 
selecting a rule.

• Go to the next group of six

NOTICE:  This option lets you move to the next rule set for 
selecting a rule.

4.8.4  Editing a Contact

Overview diagram with the full functional range for setting your Unified 
Communications options.

Select this menu to trigger the following functions:

• Playing back the presence status of a specific contact.

• Setting up a connection to this contact.

The selection takes place according to the following pattern:

Invoke the Settings menu > select Unified Communications Options > have 
presence status of a specific contact played back or have a connection set up to 
this contact.
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Please refer to the below figure for detailed operating options of the Edit contact 
menu from the Settings menu:

4.8.4.1  How to Edit a Contact

Requesting the presence status of a contact and subsequently setting up a 
connection to him/her.

Step by Step 1. Select the Settings menu.

2. Select the Edit contact function.

Select this feature to play back the presence status of the selected contact or 
to directly establish a connection to this contact.
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3. Enter contact names for addressing.

Enter the contact's name via telephone keypad. After having entered the 
contact name the system checks whether this name is valid.

The contact has been found in the system:

Your address entry is repeated by a system announcement. After you have 
confirmed the address announcement you will arrive at the menu branch 
where you can either play back the presence status of the contact or establish 
a connection to the contact.

If the system announces a contact that you would not like to call, you can 
correct the addressing by entering another name.

The contact has not been found in the system:

If the system announces that a contact with that name does not exist, you can 
correct the addressing by entering another name.

Alternatively, you can leave the Edit contact feature and return to the Settings 
menu.

If the system has found the desired contact and you have confirmed the 
announcement of the contact, you will arrive at the menu to select the desired 
feature:

4. Play presence status of selected contact. 

The presence status of the selected contact is played back. Thereafter you 
automatically return to the menu branch for selecting functions Play 
presence status of selected contact or Connect contact.

5. Connect with contact.

By calling this operating option you will arrive at the menu to select the device 
the call is addressed to. The following operating options are available:

• Selecting a device.

NOTICE:  Select a device from the contact's device group as call 
target.

• Going to the previous device group.

NOTICE:  Select a device from the contact's device group now 
offered as call target.

• Going to the next device group.

NOTICE:  Select a device from the contact's device group now 
offered as call target. 

After you have selected the desired device the connection is immediately 
established.
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4.9  The Call Subscriber Menu

Overview diagram with the full functional range for the OpenScape Voice Portal 
menu Call subscriber.

The Call subscriber menu lets you directly set up a telephone connection to any 
subscriber.

To address the desired conversational partner you can use name dialing or dial 
by entering the numbers.

NOTICE:  For name dialing the conversational partner must exist 
as entry in an address book or your contact list.

The selection takes place according to the following pattern:

Select the Call subscriber menu > Enter the phone number or contact name for 
addressing (if name dialing, select device).

Please refer to the following figure for detailed operating options of the Call 
subscriber  menu:
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4.9.1  How to Call a Subscriber via Digit Dialing

Calling a subscriber via digit dialing.

Step by Step 1. Select the Call subscriber menu.

Select this function to directly set up a connection to a contact. The following 
dialing options are then available:

2. Enter a phone number

After you have entered the phone number it is repeated by a system 
announcement. The following operating options are then available:

• You can confirm the entry.

• You can dismiss the entry. This takes you back to the menu branch for 
entering the phone number.

After you have confirmed the phone number the connection is immediately set 
up.

4.9.2  How to Call a Subscriber via Name Dialing

Calling a subscriber via name dialing.

Step by Step 1. Select the Call subscriber menu.

Select this function to directly set up a connection to a contact. The following 
dialing options are then available:

2. Invoke the Name dialing function.

This action switches from digit to name dialing.

3. Enter contact names for addressing.

Enter the contact's name via telephone keypad. After having entered the 
contact name the system checks whether this name is valid.

The contact has been found in the system:

Your address entry is repeated by a system announcement. By confirming the 
address announcement you will arrive at the menu to select the device the call 
is addressed to.

If the system announces a contact that you would not like to call, you can 
correct the addressing by entering another name.

The contact has not been found in the system:

If the system announces that a contact with that name does not exist, you can 
correct the addressing by entering another name.

Alternatively, you can leave the Edit contact feature and return to the Settings 
menu.
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4. Select a device.

By confirming the address announcement you will arrive at the menu to select 
the device the call is addressed to. The following operating options are 
available:

• Selecting a device.

NOTICE:  Select a device from the contact's device group as call 
target.

• Going to the previous device group.

NOTICE:  Select a device from the contact's device group now 
offered as call target.

• Going to the next device group.

NOTICE:  Select a device from the contact's device group now 
offered as call target. 

After you have selected the desired device the connection is immediately 
established.

4.10  The Help Menu

Notes for using the help functions.

You can call help in the main menu and in the sub menus by clicking on the phone 
key . 

If help is called, detailed announcements are played concerning the operating 
options of the menu you are currently in.

After you have invoked the help function and click on the phone key  you are 
directly connected to the operator.

4.11  The OpenScape Voice Portal Answering Machine Mode (Guest Access)

General information about the OpenScape Voice Portal Answering Machine 
Mode.

The OpenScape Voice Portal Answering Machine Mode provides two useful 
functions to the OpenScape users:

• Every OpenScape user can configure his/her mailbox as an answering 
machine by redirecting his/her own extension to the Answering Machine 
Mode phone number.
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• Every OpenScape user can leave a message for other OpenScape users by 
calling directly the Answering Machine Mode and entering the corresponding 
mailbox.

Both functions can be used independently. This means that, although you are 
using e. g. the Answering Machine Mode, other OpenScape users can still call 
your mailbox directly.

4.11.1  Using the Answering Machine Mode as Answering Machine

Using the Answering Machine Mode as answering machine.

Every OpenScape user can configure his/her mailbox as an answering machine 
by redirecting his/her own extension to the Answering Machine Mode phone 
number.

To this, just enter the phone number of the Answering Machine Mode as desti-
nation in the call diversion configuration in OpenScape Desktop Client Enterprise 
Web Embedded Edition or OpenScape Web Client. 

The server detects automatically that you have redirected your telephone to the 
mailbox. All incoming calls are redirected to the recipient's mailbox.

The caller can leave a message for the callee on the mailbox as a voicemail.

The recipient of the message can listen to this message later via his/her mailbox 
access.

4.11.2  How to use the Answering Machine Mode to Send Voice Messages 
directly

Sending a voicemail via the Answering Machine Mode.

Prerequisites • You need to know the access number to the Answering Machine Mode. In 
case of doubt please contact your system administrator.

• To address the voicemail, you need to know the account number or the name 
of the OpenScape user for whom you would like to leave a message.

Step by Step 1. Dial the access number to the Answering Machine Mode.

If you call from a corporate phone, this will in most cases be an extension. If 
you make an external call or use your cellphone, you need to enter the 
complete company number, followed by the Control Mode access number.

Your are prompted by an announcement to enter the account number of the 
OpenScape user for whom you would like to leave a message or to change 
to the name dialing mode by pushing the star key .

2. Use the telephone keypad to enter the account number of the OpenScape 
user. If you have activated the name dialing, enter the name of the corre-
sponding OpenScape user
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You will be asked to record your message.

3. To finish the recording of your voicemail, push the pound key . After this, 
you can choose one of the following commands for further actions:

a) Push  to discard the message recording and record a new message.

b) Push  to continue recording the message.

c) Push  to listen to the recorded message.

d) Push  to cancel the message recording and exit the Answering 
Machine Mode.

4. Send the recorded message by pushing again the pound key . 

The voicemail is sent to the recipient's mailbox.
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5  OpenScape UC Speech Portal

General description of the OpenScape UC Speech Portals.

The OpenScape UC Speech Portal is the telephone user interface (TUI) for the 
OpenScape UC Application which is operated via voice commands. Thus, you 
can access the OpenScape UC Application features by spoken commands. 

Your spoken commands are converted to control commands via a speech recog-
nition software installed on the server.

NOTICE:  The speech recognition software is currently only 
available for English and German.

The feature range is to a large extent identical to the OpenScape Voice Portal 
feature range. In addition to the features available in OpenScape Voice Portal, the 
following actions can also be performed:

• Creating calendar entries

• Performing ad-hoc conferences

You can use the following OpenScape UC Application features by spoken 
commands:

• In the Control Mode (Direct Access), you have the following options after 
having logged on to the system:

– Editing your messages

– Accessing your calendar and creating calendar entries

– Joining a conference, starting a conference and performing an ad-hoc 
conference

– Changing your system settings

– Calling any subscriber

• In the Answering Machine Mode (Guest Access), you may: 

– Create you personal answering machine by configuring a call diversion to 
the Answering Machine Mode. Furthermore, you can call the Answering 
Machine Mode directly from any phone and record voicemails for the 
OpenScape subscribers and store the messages in their mailbox.

NOTICE:  The Control Mode and the Answering Machine Mode 
can be reached by dialing different access numbers.

The OpenScape UC Speech Portal can be reached and used from any phone.

Your system administrator provides the code numbers for logging on to the 
OpenScape UC Speech Portal: 

• Your access number for the OpenScape UC Speech Portal Control Mode.

• Your account number for the Control Mode.

• Your password (PIN) for the Control Mode.
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• Your access number for the OpenScape UC Speech Portal Answering 
Machine Mode.

NOTICE:  If voice commands are not recognized by the system, 
it will allow you after a number of failed attempts to trigger 
selected actions by using the telephone keypad. The available 
options will be announced for the corresponding menu.

5.1  The OpenScape UC Speech Portal Features

OpenScape UC Speech Portal features.

The OpenScape UC Speech Portal supports the following categories of features:

In the Control Mode (Direct Access)

• Logging on to the system and accessing the main menu

• Via the Mailbox menu:

– Sending voicemails

– Playing messages

– Selecting a Message Type

– Switching message directories

• Via the Calendar menu:

– Accessing the Microsoft Outlook and Lotus Notes calendar feature with 
the option of creating calendar entries.

• Via the Conferences menu:

– Joining an active conference

– Starting a conference

– Performing an ad-hoc conference

• Via the Settings menu:

– Configure the reply options.
These include recording welcome greetings for different presence 
statuses and recording the individual name.

– Setting voicemail options. 
Via this you can change your password and administrate your trusted 
numbers that enable simplified system access.

– Setting the Unified Communications options. 
In this menu you can change your presence status, set your preferred 
device and select a routing rule for incoming calls.

– Editing your contacts. 
This menu allows you to delete private contacts or to change the phone 
number of a private contact.

• Via the Call subscriber Menu 

– Calling a subscriber directly (entering the phone number) or via name 
dialing (entering the contact name).
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• Via the Help menu detailed help greetings for the main menu are played.

NOTICE:  A help feature is available for all submenus via which 
you can play detailed help greetings to every menu you are 
currently in.

In the Answering Machine Mode (Guest Access)

• Configuring a personal answering machine by creating a call diversion to the 
Answering Machine Mode. Furthermore, you can call the Answering Machine 
Mode directly from any phone and record voicemails for the OpenScape 
subscribers and store the messages in their mailbox.

5.2  Operating the OpenScape UC Speech Portal

Instructions for operating the OpenScape UC Speech Portal.

The operation of OpenScape UC Speech Portal is accomplished by voice 
commands that you communicate to the system via your telephone.

The operation is intended to invoke by short commands quickly the desired 
function without passing from one voice command to another to reach the desired 
menu and finally the desired function. 

NOTICE:  Additionally, you have the option to follow the menu 
structure. You may, for example, say "Mailbox" first to switch to the 
Mailbox menu and then "Send a message" to invoke the function 
Send a new message in this menu.

The principle of this system is to search the voice commands for certain keywords 
by using a speech recognition software. This means that there are no unique 
commands assigned to each of the functions which must mandatorily be spoken 
to trigger a determined function. The system is adapted to the natural use of 
language, so that it also accepts utterances as commands which express the 
command in a similar way.

The commands do not only allow you to change from one menu to another and 
to the submenus contained. You may also say directly the function you would like 
to access.
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System prompts will support you by guiding you through the system. The 
announcements inform you about your position in the menu and which functions 
can be triggered there. This allows a completely intuitive operation: You can easily 
orientate yourself in the system and use your communication tool in as efficiently 
as possible. 

NOTICE:  If voice commands are not recognized by the system, 
it will allow you after a number of failed attempts to trigger 
selected actions by using the telephone keypad. The available 
options will be announced for the corresponding menu.

Control Mode

After having dialed in to the Control Mode (Direct Access), the system will 
welcome you with the following announcement:

" Looking in your mailbox and calendar and checking your status."

"You have <xx> new messages, your current status is: <yy>". 

"Main menu - what would you like to do?"

After this announcement, just say the desired command. For example, "Send a 
message" to record, address and send a message.

Examples of voice commands

Sending a message in the Mailbox menu

You can use, for example, the following voice commands:

• "I would like to record a message"

• "Record a message"

• "I want to record a message"

• "Send a message"

• "Send message"

• "I would like to send a message"

• "I want to send a message"

• "Send a message to <John Doe>"

NOTICE:  You can only use the command "Send a message to 
<John Doe>" to address a message to a contact from your private 
contact list. If you would like to send a message to a global 
contact, use a voice command without the contact name. 

Listening to a message in the Mailbox menu

You can use, for example, the following voice commands:

• "Listen to all messages"

• "I would like to listen to all messages"

• "I would like to listen to all my messages"

• "I want to listen to all messages"
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• "I want to listen to all my messages"

Listening to voicemails in the Mailbox menu

You can use, for example, the following voice commands:

• "Listen to voicemails"

• "I would like to listen to my voicemails"

Listening to e-mails in the Mailbox menu

You can use, for example, the following voice commands:

• "Listen to e-mails"

• "Listen to urgent e-mails"

• "Listen to all urgent e-mails"

• "I would like to listen to all urgent e-mails"

• "I would like to listen to all my urgent e-mails"

• "I want to listen to urgent e-mails"

Listening to meeting requests in the Mailbox menu

You can use, for example, the following voice commands:

• "Listen to meeting requests"

• "I would like to listen to my meeting requests"

Listening to meeting responses in the Mailbox menu

You can use, for example, the following voice commands:

• "Listen to meeting responses"

• "I would like to listen to my meeting responses"

Listening to appointments in the Calendar menu

You can use, for example, the following voice commands:

• "Listen to appointments"

• "I would like to listen to my appointments"

• "I want to listen to my appointments"

• "Listen to my next appointment"

• "I would like to listen to my next appointment"

• "I want to listen to my next appointment"

• "I would like to listen to my appointments between 1st January 2010 and 1st 
December 2011"

• "I want to listen to my appointments between 1st January 2010 and 1st 
December 2011"

Creating an appointment in the Calendar menu

You can use, for example, the following voice commands:

• "Create an appointment"

• "I would like to create an appointment"

• "I want to create an appointment"

• "I would like to create an appointment for tomorrow"
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• "I would like to create an appointment for tomorrow at 10 o'clock"

Starting a conference in the Conference menu

You can use, for example, the following voice commands:

• "Start a conference"

• "I would like to start a conference"

• "I would like to start a conference with <xyz>"

• "I want to start a conference"

• "I want to start a conference with <xyz>"

Recording a greeting in the Settings menu > Answering options > Greetings

You can use, for example, the following voice commands:

• "Record a greeting"

• "I would like to record a greeting"

• "I want to record a greeting"

• "Record a greeting for status "Available""

• "I would like to record a greeting for status "Available""

• "Record a greeting for status "In meeting""

• "I would like to record a greeting for status "In meeting""

• "Record a greeting for status "No interruptions""

• "I want to record a greeting for status "No interruptions""

• "Record a greeting for status "Be right back""

• "I would like to record a greeting for status "Be right back""

• "Record a greeting for status "Unavailable""

• "I want to record a greeting for status "Unavailable""

• "Record a greeting for status "Busy""

• "I would like to record a greeting for status "Busy""

• "Record a default greeting"

• "I would like to record a default greeting"

Recording a name in the Settings menu > Answering options > Record a 
name

You can use, for example, the following voice commands:

• "Record a name"

• "I would like to record my name"

• "Delete a name"

• "I would like to delete my name"

Changing the password in the Settings menu > Voicemail options > Change 
password

You can use, for example, the following voice commands:

• "Change password"

• "I would like to change my password"

• "want to change my password"
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Changing the trusted number in the Settings menu > Voicemail options > 
Change trusted number

You can use, for example, the following voice commands:

• "Change trusted number"

• "I would like to change my trusted number"

• "Add a trusted number"

• "I would like to add a trusted number"

Changing the status in the Settings menu > Unified Communications Options 
> Change Status

You can use, for example, the following voice commands:

• "Change status"

• "I would like to change my status"

• "I would like to change my status to "Available""

• "I would like to change my status to "Busy""

• "I would like to change my status to "No interruptions""

• "I would like to change my status to "Be right back""

• "I would like to change my status to "Busy""

Changing the preferred device in the Settings menu > Unified 
Communications Options > Change preferred device

You can use, for example, the following voice commands:

• "Change preferred voice target"

• "I would like to change my preferred voice target"

• "Change preferred voice target to current number"

• "I would like to change my preferred voice target to the current number"

• "Change preferred voice target to predefined voice target"

• "I would like to change my preferred voice target to a predefined voice target"

Activating a rule in the Settings menu > Unified Communications Options > 
Activate rule

You can use, for example, the following voice commands:

• "Manage rules"

• "I would like to manage my rules"

• "I would like to activate my rules"

• "I would like to deactivate my rules"

Managing contacts in the Settings menu > Manage contacts

You can use, for example, the following voice commands:

• "Manage contacts"

• "I would like to manage my contacts"

• "I want to manage my contacts"

Calling subscribers in the Call subscribers menu

You can use, for example, the following voice commands:
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• "Call <John Doe>"

• "I would like to call <John Doe>"

These example commands allow you to access all available features of the 
OpenScape UC Speech Portal and to use them for your communication.

Using the Answering Machine Mode as Answering Machine 

After having created a call diversion from your phone to the Answering Machine 
Mode phone number, all calls will be redirected automatically to your mailbox. The 
caller has the option to record a voice message and leave it as a voicemail in your 
mailbox.

Answering Machine Mode in Guest Access

After having dialed in to the Answering Machine Mode (Guest Access), the 
system will welcome you with the following announcement:

"For whom would you like to leave a message?"

After this announcement, just say the name of the desired subscriber. You can 
say the last name, the first name or both in any order. You can also enter the 
account number of the subscriber for whom you would like to leave a message 
via the telephone keypad. To check whether the system has identified the right 
subscriber, the name recognized or the name assigned to the account number is 
repeated. After this, you will be asked to record the message. After having 
finished the name recording, just end the connection. The message will be sent 
to the mailbox of the desired subscriber.
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6  Conferences in the OpenScape UC Application

Overview of the conference types available via the OpenScape UC Application 
and the clients used for scheduling and controlling conferences.

The OpenScape UC Application conferencing features enable you to efficiently 
and reliably cooperate with your contacts and colleagues.

Depending on the installed and configured features you can use the following 
conferencing options in the OpenScape UC Application: 

• Merge Calls
You can initiate conferences via call control also. This lets you expand an 
active consultation call in normal telephone conversation to a conference. 
The Merge Calls   functionality is used. A conference set up this way 
comprises all conference options.

• MeetNow! Conferences
MeetNow! conferences are video or voice conferences that you can quickly 
configure via a special service access number with all privileged subscribers. 
The conference room is exclusively defined by entering an arbitrary PIN. That 
means, all conference participants who dial the service access number and 
enter the same PIN are in the same conference room and can directly talk to 
each other. A MeetNow! conference is always video-compatible. However, 
the video feature does not become active until the first conference participant 
dials into the conference with a video-compatible device.

NOTICE:  If not enough server resources are available to realize 
a video conference, automatically a voice conference is initiated.

• Ad-hoc Conferences
Ad-hoc conferences are initiated spontaneously, thus without any scheduling. 
You initiate such conferences via your client application by selecting conver-
sation partners in your address list and calling them via the conference 
function. 
Ad-hoc conferences to a video or web conference.

– Web Conferences
You can use a web conference to show elements and actions represented 
on your monitor to other users in real time during an online session. By 
means of this “desktop sharing” you can thus demonstrate operating 
steps or present an application and work on documents in cooperation 
with other users. 

– Video Conferences
You can expand every voice conference to a video conference under the 
appropriate conditions: server licenses, video-compatible devices respec-
tively video-compatible clients, enough free server resources. The video 
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dialog opens automatically with starting the conference and the user only 
needs to release sending his/her own video image for starting the video 
streaming.

NOTICE:  If not enough server resources are available to realize 
a video conference, automatically a voice conference is initiated.

• Meet Me conferences (scheduled conferences)
Meet Me conferences are all scheduled conferences. You can pre-configure 
them via the clients of the OpenScape UC Application (OpenScape Desktop 
Client Enterprise Web Embedded Edition or OpenScape Extensions for 
Microsoft Outlook).
For Meet Me conferences you can configure: 

– Whether they are to start at a scheduled time or, if this option is not used, 
are to be started manually by the moderator (moderated conference) or a 
conference participant (open conference).

NOTICE:  If participants need to dial into an open conference by 
themselves, it starts with the first participant dialing in.

– Who to invite for the conference.

– Which conference type to prepare in addition (web or video conference).

– Whether to create an open or moderated conference.

– Whether the conference participants are called to join the conference 
(dial-out) or need to dial in by themselves (dial-in).

NOTICE:  Scheduled conferences with video preparation are 
currently only possible via the OpenScape Extensions for 
Microsoft Outlook.

Meet Me are first initiated as voice conferences, but can then be extended to 
a video or web conference.

– Web Conferences
You can use a web conference to show elements and actions represented 
on your monitor to other users in real time during an online session. By 
means of this “desktop sharing” you can thus demonstrate operating 
steps or present an application and work on documents in cooperation 
with other users. 

– Video Conferences
You can expand every voice conference to a video conference under the 
appropriate conditions: server licenses, video-compatible devices respec-
tively video-compatible clients, enough free server resources. The video 
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dialog opens automatically with starting the conference and the user only 
needs to release sending his/her own video image for starting the video 
streaming.

NOTICE:  If not enough server resources are available to realize 
a video conference, automatically a voice conference is initiated.

The conference creator can set a start time for a Meet Me conference. When 
this point in time is reached, the conference starts automatically. 
If no start time is set, the following start-up procedures apply:

– In case of a moderated conference: The moderator must start the 
conference manually or dial into the conference.

– In case of an open conference: Any conference participant can start the 
conference or it starts when the first conference participant dials in.

You can use the following OpenScape clients for configuring and starting a 
conference:

• The OpenScape Extensions for Microsoft Outlook
This extension provides Microsoft Outlook features for scheduling confer-
ences via a meeting request in the Microsoft Outlook calendar. You can use 
the conference configuration options to create a voice conference that can be 
optionally extended to a video and/or web conference.

• The OpenScape Web Client
Via this browser-based OpenScape UC Application client you can create Ad-
hoc and Meet Me conferences.

– Ad-hoc conferences via the Call Control or as extension of an active call. 
Another option is the Contacts function window, in which you select and 
call the desired conference participants. 

– Meet Me conferences via the Conferences dialog.
You find the detailed description of this client in the OpenScape 
UC Application OpenScape Web Client

• The OpenScape Desktop Client Enterprise Web Embedded Edition
Via this OpenScape UC Application desktop client you can create Ad-hoc and 
Meet Me conferences.

– Ad-hoc conferences via the Call Control or as extension of an active call. 
Another option is the Contacts function window, in which you select and 
call the desired conference participants. 

– Meet Me conferences via the Conferences dialog.
You find the detailed description of this client in the OpenScape 
UC Application OpenScape Desktop Client Enterprise Web Embedded 
Edition manual.

6.1  Ad-hoc Conferences

Definition of ad-hoc conferences.
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An ad-hoc conference is a dynamically and spontaneously configured and directly 
executed voice conference. If you wish to hold a meeting with several persons 
and you see in the contact list that all of them are available, you can select them 
and subsequently start a one-off voice conference in one step. You initiate ad-hoc 
conferences via the Contacts (compact) or Contacts (extended) window.

You can extend Ad-hoc conferences to video and/or web conferences.

6.2  Meet Me Conferences

The definition of meet-me conferences.

Meet Me conferences are voice conferences planned and configured in advance.

Meet-me conferences can be scheduled conferences that start automatically at a 
specific time. They can also be conferences started any time either manually by 
the moderator or automatically with the first participant who dials in. 

A conference does not begin at the actual start time but somewhat earlier. This 
advance period is defaulted by a system configuration. It serves for balancing out 
minor differences between the system times of the conference participants, thus 
avoiding failed dial-ins.

If the defaulted conference duration was too short, it is automatically prolonged 
following the defaults in the system configuration. Such prolongations are defined 
in accordance with the overall duration of conferences configured in the system. 
The default-set value for a prolongation is 30 minutes.

In addition, a Meet Me conference can be designed as moderator-controlled or 
open conference. Several conference participants can be defined as moderators. 
This determines the conference proceedings.

The following actions end a Meet Me conference: 

• The last moderator (moderated conference) leaves the conference by termi-
nating the conference call. This triggers a grace period that allows other 
conference participants to end the conference also. When the grace period 
has expired, the conference ends.

• The last conference participant (open conference) logs out of the conference 
by terminating the conference call.

Scheduled conference

In case of a scheduled conference, the conference creator sets the start time and 
duration of the conference in accordance with the overall duration of conferences 
configured in the system. 

Please note the following for a moderated and scheduled conference:

• If the moderator leaves the conference during the initially scheduled period, 
the conference persists until the initially scheduled end time. So, the other 
conference participants can resume the conference.
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• If the moderator leaves the conference during a conference prolongation, the 
grace period starts when the moderator terminates the conference call. The 
grace period enables the other conference participants to end the conference 
also. When the grace period has expired, the conference ends.

Unscheduled conference

In case of an unscheduled conference you (as conference creator) need to start 
the conference manually. After the conference start the conference remains 
active within the scope of the overall duration of conferences configured in the 
system until the last conference participant has logged out by terminating the 
conference call.

Please note the following for a moderated and unscheduled conference:

• If the moderator leaves the conference during the initially scheduled period, 
the grace period starts when the moderator terminates the conference call. 
The grace period enables the other conference participants to end the 
conference also. When the grace period has expired, the conference ends.

• If the moderator leaves the conference during a conference prolongation, the 
grace period starts when the moderator terminates the conference call. The 
grace period enables the other conference participants to end the conference 
also. When the grace period has expired, the conference ends.

Open conference

An open conference is a meet-me conference in which all participants have equal 
control privileges. The conference starts automatically either at a scheduled time 
or with the first participant who dials in or manually with the first conference partic-
ipant who dials in. The conference configuration allows two ways of joining in: 
Participants are either called automatically by the system after the conference 
start (dial-out) , or they need to dial in by themselves (dial-in) . You create an 
open conference by activating the Open Conference checkbox in the Create 
conference dialog.

Moderated conference

A moderated conference is a meet-me conference in which only the conference 
creator has the control privilege as moderator. The conference starts automati-
cally at the scheduled time if such a point in time has been configured. If no start 
time has been defined, the moderator can start the conference manually or by 
dialing into the conference. Depending on the configuration, the conference 
participants can dial into the conference (dial-in)  or are called by the system 
(dial-out) . When the moderator leaves the conference, it comes automatically 
to an end for the other participants, too. A moderated conference is created by 
the conference creator deactivating the Open Conference check box in the Add 
Conference dialog.

6.2.1  How to Configure a Meet Me Conference via the Conferences Dialog

Configuring a Meet Me Conference via the Conferences dialog.
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How to configure a new Meet Me conference via the Conferences dialog:

Step by Step 1. Open the Conferences function window via menu > Conference.

The settings dialog Create conference for configuring a new conference 
opens.

2. Enter under Start time the time for the automatic conference start.

3. If desired, add further participants via the  or  icon.

4. Perform the desired conference settings.

5. Click on the Apply button to save your settings without closing the setting 
dialog.

The Bridge number field is filled in automatically and the conference PIN is 
generated. Subsequently, you can perform further configuration changes. 
The conference name appears as entry in the Conferences window.

6. Click on OK to save modifications.

The settings dialog closes. Every participant can see the new conference as item 
of the conference list in the Conferences window. The conference starts 
automatically at the scheduled time.

NOTICE:  You find further conference setting details in the 
manuals OpenScape Desktop Client Enterprise Web Embedded 
Edition and/or OpenScape Web Client.

6.2.2  How to Configure a Meet Me Conference via the Contacts Dialog

Configuring a Meet Me Conference via the Contacts dialog.

How to configure a new Meet Me conference via the Contacts dialog:

Step by Step 1. Open the Contacts function window.

2. Select the conference participants from your contact list. You can select 
several contacts at a time by clicking on the desired contact list entries with 
the [Ctrl] key kept pressed.

3. Then click on .

The settings dialog Create conferences in which you can configure the new 
conference with the selected participants opens.

4. Enter under Start time the time for the automatic conference start.

5. If desired, add further participants via the  or  icon.

6. Perform the desired conference settings.

7. Click on the Apply button to save your settings without closing the setting 
dialog.
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The Bridge number field is filled in automatically and the conference PIN is 
generated. Subsequently, you can perform further configuration changes. 
The conference name appears as entry in the Conferences window.

8. Click on OK to save modifications.

The settings dialog closes. Every participant can see the new conference as item 
of the conference list in the Conferences window. The conference starts 
automatically at the scheduled time.

NOTICE:  You find further conference setting details in the 
manuals OpenScape Desktop Client Enterprise Web Embedded 
Edition and/or OpenScape Web Client.

6.2.3  Joining an Active Meet-me Conference

Joining an active meet-me conference.

The way conference participants join a conference, thus, whether they are called 
by the system at the conference start or need to dial in by themselves, is first 
determined by the conference creator when configuring a conference. The invited 
conference participants, however, can change this setting using the clients 
OpenScape Desktop Client Enterprise Web Embedded Edition or OpenScape 
Web Client via the conference entry in the Conferences window.

NOTICE:  You must be a conference participant before you can 
join a conference already in progress.

The conference creator can choose the following options:

• Dial-In : The conference participants need to dial in by themselves. They 
can do this from any phone, from an OpenScape client or via voice portal.

• Dial-Out : The system calls the conference participants on their preferred 
device or under the phone number specified during the conference configu-
ration.

These defaults require different steps for joining a conference.

6.2.3.1  Options for joining a Meet Me Conference

Joining a conference by dialing in or system call.

You can join a conference in two ways:

•  The conference participants need to dial into the conference by themselves.

• The conference participants are automatically called by the system when the 
conference starts.
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Dial-in:

NOTICE:  The dial-in  option is possible for scheduled as well 
as unscheduled conferences. 

If the configuration of your taking part in a conference wants you to dial in by 
yourself, the join-in procedure depends on the defaulted start-up behavior of the 
conference: 

• In case of a scheduled conference the conference starts automatically when 
the defined start time is reached. You can then dial into the conference any 
time.

• In case of an unscheduled conference, the dial-in time depends on the config-
uration setting "open conference/moderated conference":

– In case of an open conference (conference configuration default) you can 
dial into the conference at will. The conference starts when a conference 
participant has started the conference manually or the first participant 
dials into the conference..

– In case of a moderated conference (resetting the open conference 
option), the moderator starts the conference manually or by dialing in. The 
other conference participants can dial in beforehand but are informed via 
announcement that the conference has not started yet.

NOTICE:  In case of an unscheduled conference, the conference 
participant who started the conference need not log on to the 
conference by pushing the  key.

There are the following options for dialing in:

• You can directly dial into the conference from any phone using the dial-in data 
(bridge number and PIN) given in the dialog for this conference.

• You can dial in via the conference dialog in the OpenScape Web Client or in 
the OpenScape Desktop Client Enterprise Web Embedded Edition. In doing 
so, use the icon available for this conference. Enable the Join conference 
function from the context menu to dial into the conference.

• You can join the conference via the OpenScape Voice Portal. Select the 
Conferences menu in there and then the Join conference function.

Call-out:

NOTICE:  The "call-out " setting is possible for scheduled as 
well as unscheduled conferences. 

If the configuration of your taking part in a conference determines that the system 
calls you when the conference starts, the join-in procedure depends on the 
defaulted start-up behavior of the conference:
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• In case of a scheduled conference the conference starts automatically when 
the defined start time is reached. Simultaneously with the conference start, 
the system calls all conference participants for whom the system call has 
been configured.

• In case of an unscheduled conference, the system call depends on the config-
uration setting "open conference/moderated conference":

– In case of an open conference (conference configuration default) the 
system calls the conference participants for whom the system call has 
been configured when a conference participant has started the 
conference manually or the first conference participant dials into the 
conference.

– In case of a moderated conference (resetting the open conference 
option) the system calls the conference participants for whom the system 
call has been configured after the moderator has started the conference 
manually.

6.2.3.2  How to Dial into a Conference by yourself via Telephone

Joining an active meet-me conference by dialing in yourself via telephone.

The conference participation requires you to dial in by yourself.

How to join the conference via any phone:

NOTICE:  The conference must have been started either by the 
system at the scheduled time or by the moderator (in case of a 
moderated conference) for you to dial in. The conference icon 
next to the relevant conference in the Conferences window 
switches from  to  . If the conference is an open one, it starts 
when the first participant dials in.

Step by Step 1. Dial the bridge number. You find this phone number in the conference dialog 
of the conference you wish to join.

An announcement informs you that you are in the conference bridge. 
Subsequently, you are prompted to enter the conference PIN.

2. Enter the conference PIN via the telephone keypad.

3. Confirm the PIN entry with  .

Now you hear an announcement that explains how to use the phone keypad 
for controlling the conference.

4. You are prompted to push  for joining the conference or  for rejecting 
to take part in the conference.

After you have pushed  for joining the conference you hear an 
announcement that explains how to use the telephone keypad for controlling 
the conference.

A signal tone indicates that you are connected to the conference.
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6.2.3.3  How to Dial into a Conference by yourself via the "Conferences" Dialog

Joining an active meet-me conference by dialing in by yourself via the 
OpenScape Web Client or the OpenScape Desktop Client Enterprise Web 
Embedded Edition.

The conference participation requires you to dial in by yourself. How to join the 
conference via the Conferences dialog:

NOTICE:  The conference must have been started either by the 
system at the scheduled time or by the moderator (in case of a 
moderated conference) for you to dial in. The conference icon 
next to the relevant conference in the Conferences window 
switches from  to  . If the conference is an open one, it starts 
when the first participant dials in.

Step by Step 1. Start the OpenScape Web Client or the OpenScape Desktop Client Enter-
prise Web Embedded Edition.

2. Open the Conferences dialog.

3. In the Conferences window click on  to the left of the name of the active 
conference you wish to join.

A selection list appears.

4. Select the Join Conference option in the open selection list.

A call is made to your preferred device.

5. After you have accepted the call, you are prompted to push  for joining 
the conference or  for rejecting to take part in the conference.

After you have pushed  for joining the conference you hear an 
announcement that explains how to use the telephone keypad for controlling 
the conference.

A signal tone then indicates that you are connected to the conference.

6.2.3.4  How to Participate in a Moderated Conference by the System Calling you

Taking part in a moderated conference by the system calling you.

If the configuration of your joining the conference requires the system to call your 
preferred device, proceed as follows to join a moderated conference:

Step by Step 1. As moderator:

a) In case of a scheduled conference, the moderator (and the other 
conference participants) is automatically called by the system when the 
conference start time is reached. He/she opens the conference by 
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accepting the system call. If other conference participants have already 
accepted the conference call, they are in a waiting room and hear music-
on-hold until the moderator joins the conference.

b) In case of an unscheduled conference the moderator needs to start the 
conference manually. Subsequently, he/she (and the other conference 
participants) is called by the system. He/she opens the conference by 
accepting the system call. If other conference participants have already 
accepted the conference call, they are in a waiting room and hear music-
on-hold until the moderator joins the conference.

Note: Another way for the moderator to start a conference is to dial in 
directly.

2. For the other conference participants:

a) In case of a scheduled conference the other conference participants are 
also called by the system when the conference start time is reached. After 
they have accepted the conference call they remain in the waiting room 
until the moderator joins the conference to start it. Only then the voice 
connection is set up. For the other conference participants called by the 
system applies: After they have accepted the call, they are prompted to 
push for joining the conference or for rejecting to take part in the 
conference.

After you have pushed for joining the conference you hear an 
announcement that explains how to use the telephone keypad for 
controlling the conference.

A signal tone then indicates that you are connected to the conference.

b) In case of an unscheduled conference, the system calls the other 
conference participants after the moderator has started the conference 
manually. If other conference participants have already accepted the 
conference call, they are in a waiting room and hear music-on-hold until 
the moderator joins the conference. For the other conference participants 
called by the system applies: After they have accepted the call, they are 
prompted to push for joining the conference or for rejecting to 
take part in the conference.

After you have pushed for joining the conference you hear an 
announcement that explains how to use the telephone keypad for 
controlling the conference.

A signal tone then indicates that you are connected to the conference.

6.2.3.5  How to Participate in an Open Conference by the System Calling you

Taking part in an open conference by the system calling you.
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If the configuration of your joining the conference requires the system to call your 
preferred device, proceed as follows to join an open conference:

Step by Step 1. For a scheduled conference:

a) When the conference start time is reached, the system calls all 
conference participants.

b) After you have accepted the call, you are prompted to push  for 
joining the conference or  for rejecting to take part in the conference.

c) When you push  to accept joining the conference you hear an 
announcement that explains how to invoke the telephone control menu for 
the conference.

A signal tone then indicates that you are connected to the conference.

2. For an unscheduled conference:

a) After any conference participant has started the conference manually, the 
system calls this participant first and then all the others.

b) After you have accepted the call, you are prompted to push  for 
joining the conference or  for rejecting to take part in the conference.

c) When you push  to accept joining the conference you hear an 
announcement that explains how to invoke the telephone control menu for 
the conference.

A signal tone then indicates that you are connected to the conference.

6.3  Web Conferences

Definition of web conferences.

You can use a web conference to show elements and actions represented on your 
monitor to other users in real time during an online session. By means of this 
“desktop sharing” you can thus demonstrate operating steps or present an appli-
cation and work on documents in cooperation with other users. This is particularly 
useful in training projects, demonstrations and conferences joined by participants 
who are far away from each other.

In an OpenScape system you can integrate different web conferencing providers.

The web conferencing application OpenScape Web Collaboration Embedded is 
shipped with OpenScape UC Application by default. A moderator decides which 
participant may present his/her screen and who is in control of the presented 
screen. Likewise, the moderator can present his/her own screen and have it 
controlled.

NOTICE:  The web conferencing application OpenScape Web 
Collaboration of the OpenScape UC Application is not supported 
for Mac OS.
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Other web conferencing providers can be configured for use in a project-specific 
installation.

Check the combo box for selecting the web conferencing provider to see which 
web conferencing providers are available to you.

NOTICE:  Please obtain the operating instructions for the single 
web conferencing applications from the manuals of the respective 
web conferencing provider.

If you can choose from several web conferencing providers, it is 
useful to deploy one specific web conferencing provider only. 
Since the features of all web conferencing providers vary only 
slightly, you need to familiarize yourself with only one web confer-
encing application.

NOTICE:  You find a guide to using and operating the OpenScape 
Web Collaboration web conferencing application as well as 
feature descriptions in the OpenScape Web Collaboration V1 
user manual.

Clients you can use for Web Conference

You can use the web conferencing feature on Windows-based systems only. 

NOTICE:  You find information about Windows operating systems 
that can be used for staging web conferences in the OpenScape 
UC Application V6 Planning Guide manual. 

You can stage a web conference alternatively via the following clients:

• A separate stand-alone client, which is downloaded and started for a web 
conferencing session.

• A web-based client that can be reached via a specific URL.

What is a Web Conferencing Application?

In OpenScape UC Application you can realize the web conferencing feature by 
different web conferencing applications. The web conferencing application is 
installed on an individual server. Neither the moderator nor the participants need 
to install or configure any additional application before using the web confer-
encing application. After the start of a web conference, the participants can 
download a program via a user-specific Internet address. The online session is 
opened after the conference participants have started this program.

Web conferencing applications support two user roles:

• Presenter
His/her desktop is presented to the other participants. He/she can allow/forbid 
controlling his/her desktop.

• Viewer
He/she watches the presenter's desktop.
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The following user modes are possible during a web conference:

• Moderator: he/she organizes, opens and controls a web conference

• Participants (active/passive):
these are the conference participants who have been invited for a web 
conference and join a web conference session.

All in all the web conferencing function is similar to the one of a video/audio 
conference with the difference that the desktop of a user is transmitted instead of 
a video stream. This transmission can be controlled by the moderator or a partic-
ipant if he/she has been granted the corresponding privilege.

When the moderator starts a web conferencing session, he/she is in display 
mode. The participants are in viewer mode and see the moderator's desktop. The 
moderator can change this mode by assigning a participant the privilege to 
display his/her desktop. In addition, the moderator can delegate the operation of 
the desktop elements to a participant. This enables the member to remotely 
control the mouse and keyboard of the computer the desktop of which is currently 
displayed. He/she can thus operate the computer.

Further features of a web conferencing application are:

• Application selection
You use this feature to specify the applications and screen elements to be 
visible to the session partners.

• Monitor control
Via this feature you control how your screen is represented to the session 
partners.

• Uploading, downloading and deleting files.

• Using a whiteboard feature in screenshot or live mode
This enables the session participants to insert drawings and markings in the 
transmitted screen, which all other participants can see then. In case of the 
screenshot mode the displayed screen freezes to a fixed-image; in live mode 
the transmission continues without restriction.

• Using a chat feature
The chat feature enables the transmission of text messages either to single 
participants or to all of them during the session.

With the conference configuration, all required conference data (participants, dial-
in data, link for the web conferencing client and conference time) is sent by e-mail 
to the conference participants. 

NOTICE:  Depending on the system environment, an additional 
link is embedded in the e-mail for invited internal conference 
participants (UC Application users). They can use this link to open 
a cluster-spanning call control window. This call control shows the 
status of the started conference and enables controlling the 
conference depending on the participant privileges.
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At the same time, the conference is entered for OpenScape UC Application 
participants in the conference list of the Conferences function window and, in 
case of Microsoft Outlook and IBM Lotus Notes, automatically entered in the 
calendar.

NOTICE:  External conference participants are informed about 
the dial-in data (PIN, Tollfree Bridge Number, and URL for the 
web conferencing application as well as the conference start time) 
by e-mail only if their e-mail address is available in the system. If 
the external conference participants do not have an e-mail 
address, they must be informed separately, e.g. via an external e-
mail address or by telephone.

6.3.1  How to Start an Ad-hoc Web Conference

Starting an ad-hoc web conference.

If you would like to start spontaneously a web conference with other contacts, 
proceed as follows:

Step by Step 1. Select the contacts you wish to talk to in a conference in the Contacts 
window.

2. Then click on  .

A settings dialog opens.

3. Assign a Name to the conference and change the defined participant entries 
if desired (  ).

This setting dialog lets you add further participants to the ad-hoc conference. 
Enter a participant name or a phone number in the Add participant combo 
box for this purpose. Then click on  to search the configured directories for 
the contact or on  to complete the required contact information via the Add 
participant dialog.

4. Click on the Start button to initiate the ad-hoc conference.

The Call Control window opens. All participants are connected to each other 
after they have picked up the receiver. The spontaneously started voice 
conference is also listed in the Conferences window and indicated 
by  or  .

5. Click on  in the Call Control function window.

A file-download dialog opens via which you need to download the program 
required for the web conference.

6. Click on the Apply button in this dialog.

After the successful download a security prompt is displayed.

7. Confirm this security prompt with a click on the Apply button.

The connection to the web conference server is set up.
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6.3.2  How to Start a Meet-me Web Conference

Starting a meet-me web conference

How to start a web conference selected in the Conferences window:

Step by Step 1. Click on  in the row of the selected conference in the Conferences window 
and select Join Conference from the opening list.

The voice conference connection is being established. The corresponding 
entry in the conference list is indicated by  and the Call Control dialog 
opens.

2. Click on  in the Call Control function window.

A file-download dialog opens via which you need to download the program 
required for the web conference.

3. Click on the Apply button in this dialog.

After the successful download a security prompt is displayed.

4. Confirm this security prompt with a click on the Apply button.

The connection to the web conference server is set up.

6.4  Configuring Conferences

Configuring conferences in the OpenScape UC Application.

The following functions are available in the toolbar of the windows for scheduling 
and controlling conferences:

6.4.1  Controls in the "Conferences" Dialog

Controls in the "Conferences" dialog

Controls in the toolbar

The following features are available in the toolbar of the Conferences window for 
scheduling conferences:

•  Create new conference
Click on  to create a new conference. The Conferences dialog opens. You 
can use the entry mask on the Create conference tab to prepare the 
conference.

•  Edit selected conference
Select the conference you want to edit from the list. Then click on   . The 
Conferences entry mask with the data for the selected conference opens for 
editing.

•  Delete selected conference
To remove a configured conference from the list, select it and click on   .
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• Combo box for selecting the conference view
The combo box in the toolbar allows filtering the conference list by the confer-
ences you have created. Only these conferences are then displayed. Select 
the I'm Creator option in the combo box to display these conferences. Via All 
Conferences the complete list of conferences is displayed.

Controls of a Conference List Entry

The following information and features are available for each conference entry:

•  Extended representation
With a click on  the conference entry in the list shows more details. These 
details consist of the following information and features (from left to right):

– Presence status of the participants

– Name of the conference participants

– Type of connection setup:  (participant dials in himself/herself) or 
   (participant is called)

–  Sends an e-mail with the conference information (name, PIN, etc.) to 
the respective conference participant.

–  Opens the Directory Search dialog in a separate window and displays 
the contact information of the respective participant available in all defined 
directories.

• Name
Conference name

• Creator
Name of the inviting person

•  Start conference
Click on  to start a conference. A list with the options View Conference 
and Join to Conference opens. Select Join to Conference here.
You can use the View Conference feature to see the connection data and 
control elements of the conference in the Call Control window during the 
conference.

•  Active conference
Click on  and select View Conference to display the connection data and 
control elements of an active conference in the Call Control window.

6.5  MeetNow! Conferences

General information about MeetNow! conferences.

MeetNow! conferences are video or voice conferences that you can quickly 
configure via a special service access number with all privileged subscribers. The 
conference room is exclusively defined by entering an arbitrary PIN. That means, 
all conference participants who dial the service access number and enter the 
same PIN are in the same conference room and can directly talk to each other. A 
MeetNow! conference is always video-compatible. However, the video feature 
does not become active until the first conference participant dials into the 
conference with a video-compatible device.
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This conference type with its simple concept, however, makes it easy for 
unwanted conference participants to dial in. If, for example, conference partici-
pants agree upon a too simple PIN like 123, unauthorized persons may find 
themselves in the conference inadvertently. To avoid this, use a more complex 
digit string as PIN. Such a PIN could be e. g. a participant's extension.

When a video conference is staged, the participants who dial in are merely 
expected to have video-compatible devices. Even if the MeetNow! conference is 
started via a pure audio device, video-compatible participants can directly switch 
to the video mode, thus stage a video conference by activating the video function.

To use this feature you need to be recognized as system user and have a special 
user profile (Professional or Team). In other words, when calling the service 
number for the MeetNow! conference a check is performed to find out whether 
you are entitled to create a MeetNow! conference. In addition, when an external 
call is made to the service number it is checked as to whether it comes from a 
device assigned to a user in the system and whether this device is exclusively 
assigned to this user. If one of the two criteria is not met, no MeetNow! conference 
can be created via this device. 

6.5.1  How to Perform MeetNow! Conferences

Staging a MeetNow! conference.

How to perform a MeetNow! conference:

Step by Step 1. Inform the desired conference participants about the conference start time, 
your intended conference PIN, and, if required, the service access number. 
You can do this by phone or e-mail.

2. When the conference start time is reached, dial in with the service access 
number.

NOTICE:  If at least two participants with video-compatible 
devices have dialed into the conference, they can stage a video 
conference by activating the video function.

3. Enter the conference PIN.

4. Complete the entry with the pound key  .

You are now in the conference room that was created by your defaulting a 
PIN.

5. Wait until the other conference participants have dialed in.

The other conference participants need to dial in as described from step 2.

6.6  Operating Options during a Conference

Operating options during active conferences.
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You can interfere in the conference proceedings. You make the corresponding 
control entries via telephone keypad or via the keyboard you display in the video 
screen of the OpenScape Desktop Client Enterprise Web Embedded Edition. 
Whether you are allowed to interfere in the conference proceedings and the 
options available for this purpose depend(s) on various factors: 

• The conference type moderated or open conference:

– In case of a moderated conference only the moderator can use the control 
commands that affect the entire conference. If individual control functions 
are available, every single conference participant can use them.

– In open conferences every participant can use the control commands that 
affect the entire conference. If individual control functions are available, 
every single conference participant can use them in addition.

• The device used in pure voice conferences:

– If you use a telephone as device, you enter control commands via 
telephone keypad.

– If you use the client OpenScape Desktop Client Enterprise Web 
Embedded Edition or the OpenScape Web Client as device, you trigger 
the control commands with a click on the control icons in the call control.

• The device used in video conferences:

– If you use a video-incompatible telephone as device, you enter control 
commands via telephone keypad. In this case, use the control commands 
described in chapter "Controlling a Voice Conference via Telephone".

– If you use a video-compatible telephone as device, you enter control 
commands via telephone keypad. 

– If you use the OpenScape Desktop Client Enterprise Web Embedded 
Edition client as device, you enter the control commands for the video 
conference via the softphone keypad. 

The following chapters inform you about the functions available for controlling a 
conference and about how to trigger such control commands:

• Controlling a Voice Conference via Telephone Keypad.

• Controlling a Voice Conference via the Call Control available in the 
OpenScape clients.

• Controlling a Video Conference via the Keypad of a video-compatible 
Telephone or the Softphone Keypad of the OpenScape Desktop Client Enter-
prise Web Embedded Edition.

6.6.1  Controlling a Conference via Telephone

Controlling a conference via telephone
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As OpenScape UC Application user you can control an active conference also via 
the keys of your configured preferred device. The telephone keys are used for 
transmitting control commands to the system by sending DTMF tones.

NOTICE:  The administrator can deactivate the operating menu 
by configuration. Furthermore, he/she can change the 
assignment of commands to the single keys. The default setting 
for having the menu functions put out by announcement is 
   . In case of doubt please contact your administrator.

Activating the Control Menu

You control a conference by entering two key commands on the keypad of your 
phone. This prevents conference disruptions by a telephone key being pushed 
inadvertently.

NOTICE:  The administrator can change the telephone key/
command assignment. The following description refers to the 
system default setting.

Control Commands

You can use the following key commands for controlling a conference:

•  Play menu
The available menu options are announced to you.

•   Lock/unlock conference.
This feature is only available for participants with moderator or creator privi-
leges. Once the conference has been locked, no further participants may dial 
in. Pushing this key once more undoes the restriction.

•   Activate/lift muting.
Via this key you can temporarily deactivate the microphone of your telephone. 
The conference connection is maintained. Pushing this key once more reacti-
vates the microphone.

•   Activate/lift conference muting.
This feature is only available for participants with moderator or creator privi-
leges. This feature mutes all microphones of the conference participants. 
Only the voice signal of the conference participant who triggers this function 
is still transmitted to all conference participants.

•   Initiate device handover.
This function allows you to change the device you use in the conference. After 
you have pushed this key, enter the phone number of the device you want to 
switch to. You need to complete the phone number entry with the  pound 
key. For further proceedings, please follow the voice prompts.

•   Turn off music-on-hold.
If you currently are the only conference participant and hear music-on-hold, 
you can push this key to switch off the music. Pushing this key once more 
reactivates the music-on-hold.
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6.6.2  Controlling a Voice Conference via Call Control

Controlling a voice conference via the "Call Control" function dialog.

Depending whether you are moderator, creator or participant of an open 
conference, the following functions are available for controlling an active 
conference in the Call Control feature window:

In the header

•  Lock conference
In case of moderated conferences this feature is available to moderators only. 
In open conferences, every conference participant can trigger this feature. 
This option blocks the conference for other subscribers who want to join in. 
After you have clicked on the icon it changes to  .

•  Unlock conference
Releases the conference locking. After you have clicked on the icon it 
changes to  .

•  Mute conference
In case of moderated conferences this feature is available to moderators only. 
In open conferences, every conference participant can trigger this feature. It 
interrupts the sound transmission to all conference participants. After you 
have clicked on the icon it changes to  .

•  Unmute conference
This feature is only available for participants with moderator or creator privi-
leges. It cancels the conference muting.

•  Start web conference
If you have configured a web conference or were invited for a web 
conference, you can use this icon to set up the connection to the web 
conference.

•  End conference
This feature is only available for participants with moderator or creator privi-
leges. It ends the conference by closing down the connections to the other 
conference participants.

During the connection representation of the conference participants

NOTICE:  The connection representation shows all participants 
who are currently in the conference. In a moderated conference, 
the moderator is indicated by a dot that precedes his/her name 
entry. The name of the conference participant who is currently 
active (thus talking) is highlighted in boldface.

•  Change device and resume active call
This feature allows every conference participant to hand his/her conference 
connection over to another device and continue taking part in the conference 
from there.

•  Mute participant
It interrupts the sound transmission for a conference participant. After you 
have clicked on the icon it changes to  . 
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•  Unmute participant 
It undoes muting a conference participant.

•  Leave conference

– Moderated Meet Me conference
The conference moderator or creator can use this option to leave the 
conference or to disconnect single conference participants from the 
conference.

– Open Meet Me conference
Enables every participant to leave the active conference.

– Ad-hoc/MeetNow! Conference
Enables every participant to leave the active conference. As soon as all 
participants have exited the Ad-hoc- or the MeetNow! conference, the 
conference ends.

NOTICE:  After you have left the conference via the  icon and 
wish to join in again after a short period, you need to dial into the 
desired conference again and also specify the conference PIN.

If the Call Control dialog has been opened via the URL in the conference 
notification e-mail, the following information and functions depending on the 
system environment can be provided:

– The name of the currently active speaker is highlighted.

– Conference PIN Display

– Option to join an active web conference  .

– Display of the conference participants who are actually in the conference.

– Display of the participants who have not joined the conference yet.

NOTICE:  If you are on the road and do not take part in a 
conference with your office phone (ONS) but e.g. with your cell 
phone, the connection may be affected by various factors or even 
aborted. In case of a disconnection you have not initiated yourself, 
you can dial into the active conference again after a short, pre-
defined period. When the connection to the conference server is 
up again, you are prompted by greeting to push a specific, pre-
defined telephone key. By pushing this key you can instantly join 
the active conference without having to enter the conference PIN 
once more.

Via the Call Control dialog the moderator (in case of a moderated 
conference) or one of the other conference participants (in case of an open 
conference) can add further OpenScape UC Application or external partici-
pants:

NOTICE:  If you expand a conference that has been created in 
Microsoft Outlook via the call control, no e-mail invitation is sent 
to the new participant. He/she will not receive a link to join a web 
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conference that may have been configured.. If this participant is to 
receive the link to join the web conference, you need to send this 
link via e-mail.

– OpenScape UC Application users
For example, you can enter the name of the desired OpenScape 
UC Application participant in the New Call combo box and subsequently 
click on   to search all configured directories for the desired contact.

– External users
You can add an external user to the conference by entering his/her phone 
number in the New Call combo box and enabling the green receiver. This 
participant will be directly called by the conference system. He/she will not 
receive a conference notification e-mail because the conference system 
does not know his/her e-mail address.

NOTICE:  For adding external participants we recommend using 
the Add participant dialog as it allows specifying an e-mail 
address for the desired participant. You reach this dialog with a 
click on  in the Modify conference dialog.

6.6.3  Controlling a Video Conference

Controlling a video conference via telephone or softphone keypad of the 
OpenScape Desktop Client Enterprise Web Embedded Edition. 

Controlling a video conference is enabled by a concept that allows triggering 
control functions via the default keypad of a telephone. Because there are more 
control commands than keys, a menu structure is required for operation. The 
function of the cursor keys and of the return key on a computer keyboard is taken 
on by single keys for dialing numbers.
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The menu selection functions are distributed among the telephone keys as 
follows:

• Key  : Move up in the menu list.

• Key  : Move down in the menu list.

• Key  : Move back one menu level from a sub-menu.

• Key  : If available, open the associated sub-menu.

• Key  : Trigger the currently selected function.

Please heed the following for the video screen and operating the control menu: 

• For participants who have left the conference the video screen is kept up for 
a while (grace period). This period is defaulted by a system setting. It enables 
the conference participant to dial back into the conference at a later date. The 
video tile opened for you appears in blue during the grace period. 

• Conference participants whose video tile appears in blue on the video screen 
have either not released their video streaming or a defective video camera.

• Only the conference participant who opens the control menu first may operate 
it. All other participants are excluded from operation until the control menu is 
closed for the first participant.

• The control menu closes when the user who opened it leaves the conference.

• An inactivity timeout is implemented for displaying the control menu. In other 
words, if nobody uses the control menu for a specific period, it closes 
automatically. The system default for this inactivity timeout is 20 seconds.

• All conference participants can see the control menu opened by a participant, 
even if they cannot perform any settings.

NOTICE:  Please note operating restrictions conditioned by the 
conference type (moderated conference/open conference).

The following key commands are available for opening the menu:

•   : Opens the operating menu with the following function menus:

– Conference, with the functions: Participants, Mute and Lock.

– Layout, with the functions: Tiled, Active Speaker and Single.

– Options, with the functions: Conference Information and Video Infor-
mation.

Use the number keys on the phone keypad to select the function menu, then 
select the function you wish to edit. If you do not make an entry in the menu, 
the menu view is displayed for 20 seconds. After this period, the menu closes 
automatically.

NOTICE:  To hide the menu manually, enter   once 
again.

•   : The participant list, normally opened via Conference > Partici-
pants, is displayed directly. This particular shortcut enables opening the 
conference participant list quickly. Thereafter, you can navigate in the menu 
with telephone keys as usual.
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The single function menus provide the following features for controlling the video 
conference and for displaying conference or video information:

• Conference
This menu lets you apply the following functions to the conference:

– Participants
Select this function for displaying the participant list for a conference. Via 
the   command you can hide the participant list again.

– Mute
Select this function for muting the entire conference. Invoking this function 
once more undoes this restriction. The current muting status of the 
conference is displayed in the status window (head-up display) 
Conference Information.

NOTICE:  In case of a moderated conference only the moderator 
can mute the entire conference; in open conferences, all 
conference participants can mute a conference. 

– Lock
Select this function if you not wish any further conference participants to 
join in. Invoking this function once more undoes this restriction. The 
current locking status of the conference is displayed in the status window 
(head-up display) Conference Information.

NOTICE:  In case of a moderated conference only the moderator 
can lock a conference; in open conferences, all conference partic-
ipants can lock a conference. 

• Layout
This menu allows setting the following functions for the representation of the 
video screen:

NOTICE:  If you change the layout setting, it changes for all 
conference participants.

– Tiled
The transmitted video sequences of all conference participants are 
displayed on the video screen in tiles of the same size.

– Active Speaker
The video sequence of the currently active speaker is highlighted by 
representation in a bigger tile.

– Single
Only the video sequence of the currently active speaker is displayed on 
the video screen.

• Options
You can use this menu to see conference and video streaming information. It 
lets you optionally display the following functions:
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– Conference Information
Select this function is you wish to display the status window (head-up 
display) with information about the current conference on the video 
screen. The fields of this status window show the following information 
(from left to right):
- Name display of video-incompatible conference participants.
- Conference locked/unlocked icon.
- Conference muted/unmuted icon.
- Conference duration display.
- Number of video-incompatible conference participants.
- Number of video-compatible conference participants.

– Video Information
Select this function is you wish to display the status window (head-up 
display) with video streaming information on the video screen. In this 
status window you see the following information (from left to right):
- Resolution of the video signal on the current device.
- Encoder quality of the video signal in percent.
- Bandwidth for the received video signal.
- Number of data packages sent for video streaming.
- Number of complete data packages for the decoder (iFrames).
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7  OpenScape Extensions for Microsoft Outlook

General Description of the OpenScape Extensions for Microsoft Outlook

After you have installed the OpenScape Extensions for Microsoft Outlook, 
Microsoft Outlook provides features for scheduling conferences via a meeting 
request in the Microsoft Outlook calendar. Among server-based conferences you 
find: 

• Audio conferences

• Web conferences

• Video conferences

When the conference extensions are installed, the button 

 Add OpenScape conference 

is displayed in the toolbar of the dialog for scheduling an appointment.

The conference is performed via the OpenScape UC Application server. 

NOTICE:  The default system configuration plays a short signal 
tone audible to all conference participants when a conference 
participant joins or leaves the conference. In case of a larger 
number of conference participants joining or leaving this signal 
tone may become annoying to the others. It is therefore not played 
anymore when the number of conference participants exceeds 
15.

7.1  Requirements for Use

Requirements for using the OpenScape Extensions for Microsoft Outlook.

The OpenScape Extensions for Microsoft Outlook has been released only for 
specific Windows operating systems and Office versions. 

You find current and detailed information about the supported operating systems 
and versions of the usable Outlook clients in the OpenScape UC Application 
Planning Guide manual.

7.2  Meet Me Conferences

The definition of meet-me conferences.

Meet Me conferences are voice conferences planned and configured in advance.

Meet-me conferences can be scheduled conferences that start automatically at a 
specific time. They can also be conferences started any time either manually by 
the moderator or automatically with the first participant who dials in. 
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A conference does not begin at the actual start time but somewhat earlier. This 
advance period is defaulted by a system configuration. It serves for balancing out 
minor differences between the system times of the conference participants, thus 
avoiding failed dial-ins.

If the defaulted conference duration was too short, it is automatically prolonged 
following the defaults in the system configuration. Such prolongations are defined 
in accordance with the overall duration of conferences configured in the system. 
The default-set value for a prolongation is 30 minutes.

In addition, a Meet Me conference can be designed as moderator-controlled or 
open conference. Several conference participants can be defined as moderators. 
This determines the conference proceedings.

The following actions end a Meet Me conference: 

• The last moderator (moderated conference) leaves the conference by termi-
nating the conference call. This triggers a grace period that allows other 
conference participants to end the conference also. When the grace period 
has expired, the conference ends.

• The last conference participant (open conference) logs out of the conference 
by terminating the conference call.

Scheduled conference

In case of a scheduled conference, the conference creator sets the start time and 
duration of the conference in accordance with the overall duration of conferences 
configured in the system. 

Please note the following for a moderated and scheduled conference:

• If the moderator leaves the conference during the initially scheduled period, 
the conference persists until the initially scheduled end time. So, the other 
conference participants can resume the conference.

• If the moderator leaves the conference during a conference prolongation, the 
grace period starts when the moderator terminates the conference call. The 
grace period enables the other conference participants to end the conference 
also. When the grace period has expired, the conference ends.

Unscheduled conference

In case of an unscheduled conference you (as conference creator) need to start 
the conference manually. After the conference start the conference remains 
active within the scope of the overall duration of conferences configured in the 
system until the last conference participant has logged out by terminating the 
conference call.

Please note the following for a moderated and unscheduled conference:

• If the moderator leaves the conference during the initially scheduled period, 
the grace period starts when the moderator terminates the conference call. 
The grace period enables the other conference participants to end the 
conference also. When the grace period has expired, the conference ends.

• If the moderator leaves the conference during a conference prolongation, the 
grace period starts when the moderator terminates the conference call. The 
grace period enables the other conference participants to end the conference 
also. When the grace period has expired, the conference ends.
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Open conference

An open conference is a meet-me conference in which all participants have equal 
control privileges. The conference starts automatically either at a scheduled time 
or with the first participant who dials in or manually with the first conference partic-
ipant who dials in. The conference configuration allows two ways of joining in: 
Participants are either called automatically by the system after the conference 
start (dial-out) , or they need to dial in by themselves (dial-in) . You create an 
open conference by activating the Open Conference checkbox in the Create 
conference dialog.

Moderated conference

A moderated conference is a meet-me conference in which only the conference 
creator has the control privilege as moderator. The conference starts automati-
cally at the scheduled time if such a point in time has been configured. If no start 
time has been defined, the moderator can start the conference manually or by 
dialing into the conference. Depending on the configuration, the conference 
participants can dial into the conference (dial-in)  or are called by the system 
(dial-out) . When the moderator leaves the conference, it comes automatically 
to an end for the other participants, too. A moderated conference is created by 
the conference creator deactivating the Open Conference check box in the Add 
Conference dialog.

7.3  Web Conferences

Definition of web conferences.

You can use a web conference to show elements and actions represented on your 
monitor to other users in real time during an online session. By means of this 
“desktop sharing” you can thus demonstrate operating steps or present an appli-
cation and work on documents in cooperation with other users. This is particularly 
useful in training projects, demonstrations and conferences joined by participants 
who are far away from each other.

In an OpenScape system you can integrate different web conferencing providers.

The web conferencing application OpenScape Web Collaboration Embedded is 
shipped with OpenScape UC Application by default. A moderator decides which 
participant may present his/her screen and who is in control of the presented 
screen. Likewise, the moderator can present his/her own screen and have it 
controlled.

NOTICE:  The web conferencing application OpenScape Web 
Collaboration of the OpenScape UC Application is not supported 
for Mac OS.

Other web conferencing providers can be configured for use in a project-specific 
installation.
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Check the combo box for selecting the web conferencing provider to see which 
web conferencing providers are available to you.

NOTICE:  Please obtain the operating instructions for the single 
web conferencing applications from the manuals of the respective 
web conferencing provider.

If you can choose from several web conferencing providers, it is 
useful to deploy one specific web conferencing provider only. 
Since the features of all web conferencing providers vary only 
slightly, you need to familiarize yourself with only one web confer-
encing application.

NOTICE:  You find a guide to using and operating the OpenScape 
Web Collaboration web conferencing application as well as 
feature descriptions in the OpenScape Web Collaboration V1 
user manual.

Clients you can use for Web Conference

You can use the web conferencing feature on Windows-based systems only. 

NOTICE:  You find information about Windows operating systems 
that can be used for staging web conferences in the OpenScape 
UC Application V6 Planning Guide manual. 

You can stage a web conference alternatively via the following clients:

• A separate stand-alone client, which is downloaded and started for a web 
conferencing session.

• A web-based client that can be reached via a specific URL.

What is a Web Conferencing Application?

In OpenScape UC Application you can realize the web conferencing feature by 
different web conferencing applications. The web conferencing application is 
installed on an individual server. Neither the moderator nor the participants need 
to install or configure any additional application before using the web confer-
encing application. After the start of a web conference, the participants can 
download a program via a user-specific Internet address. The online session is 
opened after the conference participants have started this program.

Web conferencing applications support two user roles:

• Presenter
His/her desktop is presented to the other participants. He/she can allow/forbid 
controlling his/her desktop.

• Viewer
He/she watches the presenter's desktop.

The following user modes are possible during a web conference:
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• Moderator: he/she organizes, opens and controls a web conference

• Participants (active/passive):
these are the conference participants who have been invited for a web 
conference and join a web conference session.

All in all the web conferencing function is similar to the one of a video/audio 
conference with the difference that the desktop of a user is transmitted instead of 
a video stream. This transmission can be controlled by the moderator or a partic-
ipant if he/she has been granted the corresponding privilege.

When the moderator starts a web conferencing session, he/she is in display 
mode. The participants are in viewer mode and see the moderator's desktop. The 
moderator can change this mode by assigning a participant the privilege to 
display his/her desktop. In addition, the moderator can delegate the operation of 
the desktop elements to a participant. This enables the member to remotely 
control the mouse and keyboard of the computer the desktop of which is currently 
displayed. He/she can thus operate the computer.

Further features of a web conferencing application are:

• Application selection
You use this feature to specify the applications and screen elements to be 
visible to the session partners.

• Monitor control
Via this feature you control how your screen is represented to the session 
partners.

• Uploading, downloading and deleting files.

• Using a whiteboard feature in screenshot or live mode
This enables the session participants to insert drawings and markings in the 
transmitted screen, which all other participants can see then. In case of the 
screenshot mode the displayed screen freezes to a fixed-image; in live mode 
the transmission continues without restriction.

• Using a chat feature
The chat feature enables the transmission of text messages either to single 
participants or to all of them during the session.

With the conference configuration, all required conference data (participants, dial-
in data, link for the web conferencing client and conference time) is sent by e-mail 
to the conference participants. 

NOTICE:  Depending on the system environment, an additional 
link is embedded in the e-mail for invited internal conference 
participants (UC Application users). They can use this link to open 
a cluster-spanning call control window. This call control shows the 
status of the started conference and enables controlling the 
conference depending on the participant privileges.
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At the same time, the conference is entered for OpenScape UC Application 
participants in the conference list of the Conferences function window and, in 
case of Microsoft Outlook and IBM Lotus Notes, automatically entered in the 
calendar.

NOTICE:  External conference participants are informed about 
the dial-in data (PIN, Tollfree Bridge Number, and URL for the 
web conferencing application as well as the conference start time) 
by e-mail only if their e-mail address is available in the system. If 
the external conference participants do not have an e-mail 
address, they must be informed separately, e.g. via an external e-
mail address or by telephone.

7.4  Installing the OpenScape Extensions for Microsoft Outlook 

General information about installing the OpenScape Extensions for Microsoft 
Outlook.

You install the OpenScape Extensions for Microsoft Outlook by starting the setup 
file setup.exe from the setup directory OpenScape4Outlook.

NOTICE:  Please note that the installation file setup.exe on the 
operating system Windows7 must not be started from the Zip 
archive. Because of modifications to the privilege management in 
Windows7 the installation will otherwise fail. Unpack the archive 
first, then start the installation from the unpacked directory via the 
context menu item Run as administrator.

The dialog language in which the OpenScape Extensions for Microsoft Outlook is 
installed on your system corresponds to the language of your currently installed 
Microsoft Outlook application.

7.4.1  Requirements for Setting up OpenScape Extensions for Microsoft 
Outlook

Installation requirements for the OpenScape Extensions for Microsoft Outlook.

Normally, when the OpenScape Extensions for Microsoft Outlook is used under a 
default user account in a domain, you perform the setup in two steps:

NOTICE:  If a user who has administrative privileges at his/her 
workstation performs the setup or the current Runtime and .Net 
components have already been installed, only a single installation 
is required.
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• Installation of the OpenScape Extensions for Microsoft Outlook with adminis-
trative privileges on the relevant workstation.
This way, some additional Windows-specific Runtime and .Net components 
are installed that can be installed only with administrative privileges.

• Installation of the OpenScape Extensions for Microsoft Outlook for the user 
account, under which this component is to be used.
This is necessary for registering the setup of the OpenScape Extensions for 
Microsoft Outlook duly for this user account in the Registry under 
HKEY_CURRENT_USER .

7.4.2  How to Perform the Installation

Description of the OpenScape Extensions for Microsoft Outlook setup process.

To perform the setup, proceed as follows:

Step by Step 1. Shut down Microsoft Outlook.

2. Start the setup.exe with administrative privileges. To do this, use the 
Windows Vista or Windows 7 context menu item Run as administrator.

NOTICE:  When you install the Microsoft Outlook component via 
a network directory you encounter a security prompt that you 
need to confirm with a click on the Run button.

If you perform the initial setup on this workstation, the dialog OpenScape 
Extensions for Microsoft Outlook Setup opens.

NOTICE:  If in the second step, the user account setup is 
performed, the installation of the Windows specific components 
are skipped in the setup.

Depending on the operating system and the currently installed operating 
system components, some setup steps may follow to prepare the system for 
the installation of the OpenScape Extensions for Microsoft Outlook.

3. Click the Accept button of the Licence Agreement for Microsoft Visual 
Studio 2005 Tools for Office Second Edition Runtime to install this 
component. Another dialog OpenScape Extensions for Microsoft Outlook 
Setup opens.

4. Click the Accept button of the Licence Agreement for Microsoft Visual 
Studio 2005 Tools for Office Language Pack to install this component. 
Another dialog OpenScape Extensions for Microsoft Outlook Setup 
opens.
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5. Click the Install button to install the Microsoft Office 2003 Primary Interop 
Assemblies and 2007 Microsoft Office Primary Interop Assemblies 
components.

NOTICE:  This setup step is only displayed for an installation with 
Microsoft Outlook 2003. 

After you have installed this component, the dialog OpenScape Extensions 
for Outlook opens for the OpenScape Extensions for Microsoft Outlook 
setup.

6. Click on Next.

The welcome dialog of the setup wizard opens.

7. Click on Next to initiate the setup process.

The licensing dialog opens.

8. Set the I accept the license agreement option.

9. Click on Next. 

The setup confirmation dialog box opens.

10. Click the Install button.

A new dialog opens that allows tracing the setup process: 

Another dialog opens, which marks the end of the installation. 

11. Click on the Finish button in this dialog. 

The installation is complete and the setup assistant is closed.

12. Repeat these installation steps for each user account under which this 
component shall be used.

13. Start Microsoft Outlook under the user account that was installed for this 
component. 

The Initial Configuration for the OpenScape Extensions for Microsoft 
Outlook dialog opens. Enter here initially the user data for your access to the 
OpenScape server and the data for connecting the OpenScape server. At the 
next Microsoft Outlook start, the OpenScape is connected automatically.

NOTICE:  In Microsoft Outlook 2003 you reach the settings dialog 
also via the menu of Microsoft Outlook. Select in the menu of 
Microsoft Outlook Tools > Options > tab OpenScape Exten-
sions for Microsoft Outlook > Configuration button > tab 
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Network. In Microsoft Outlook 2010 you reach the settings dialog 
via File > OpenScape > doubleclick on Configuration > tab 
Network.

In the OpenScape Server - Access Data section you need to make the 
following entries for logging on to your OpenScape user account:

User ID

Specify here your OpenScape user ID in the format <user ID@domain>.

Password

Enter here the OpenScape password you use for logging on to the 
OpenScape server.

Use Windows Authentication

Set this option if you log on with your Windows login data. 

Then, for logging on to the OpenScape server, enter the data you use for 
logging on to your workstation in the User ID and Password input fields.

In the OpenScape Server - Network Configuration section, the following 
entries are required for connecting the OpenScape server from your 
workstation:

OpenScape Server - Host address

Enter here the complete network address (URL) of the OpenScape server.

OpenScape Server - Port

Enter here the network port via which the connection to the OpenScape 
server is configured.

NOTICE:  If you do not know the Logon or connection data, 
please contact your system administrator.
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Setup with the initial configuration for immediately connecting the OpenScape 
server is now complete.

NOTICE:  If the OpenScape server cannot be connected after you 
have specified the user data, the network address and the port of 
the OpenScape server, the OpenScape Extensions for Microsoft 
Outlook cannot be configured. When invoking the configuration 
dialog merely the Network tab is displayed for connecting the 
OpenScape server.

You can now configure your conferences via Microsoft Outlook meeting requests.

7.5  Installation in a Terminal Server Environment

Installing the OpenScape Extensions for Microsoft Outlook in a Terminal Server/
Citrix environment.

The setup process may be run through only once in terminal server or Citrix 
environments. Setup therefore requires administrative privileges.

The program files are installed in the Program Files directory instead of in the 
local user directory under Application Data. 

Newly added registry keys are automatically copied for all users, so that all users 
at the terminal server can deploy the OpenScape Extensions for Microsoft 
Outlook.

7.5.1  Requirements for the Installation in a Terminal Server Environment

Requirements for installing the OpenScape Extensions for Microsoft Outlook in a 
Terminal Server environment.

The following requirements must be complied with for the setup:

• The option for local users to log on to the terminal server must be temporarily 
inactive.

• All user must be logged off.

• The setup mode must have been released.

7.5.2  How to Perform the Installation in a Terminal Server Environment

Installing the OpenScape Extensions for Microsoft Outlook in a Terminal Server 
environment.
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Setup requires the following steps:

Step by Step 1. Start the command prompt (Start > Run > cmd).

2. Enter the following command in the command prompt:

change logon /disable

3. Log all users off of the system.

4. Enter the following command in the command prompt:

change user /install

5. Install OpenScape Extensions for Microsoft Outlook via the provided setup 
package.

6. Enter the following command in the command prompt:

change user /execute

7. Enter the following command in the command prompt:

change logon /enable

Setting up the Outlook conference extension in a terminal server environment is 
now complete.

7.5.3  User Configuration Files for Terminal Server Environments

Configuring user configuration files for a Terminal Server environment.

In case of a standard setup, the user configuration is stored in a local user 
directory:

...\Documents and Settings\<user profile>\Local 
Settings\Application Data\Siemens\UCSolutions

These directories are not replicated to other servers in a terminal server 
environment (with or without Citrix). Therefore, users are prompted to specify 
their configuration data each time they log on to a new terminal server.

To avoid this, the system administrator can determine that the configuration files 
are copied to a system-wide available directory by default during the OpenScape 
Extensions for Microsoft Outlook installation:

...\Documents and Settings\<user profile>\Application 
Data\Siemens\UCSolutions

For this purpose, you find the following file in the setup directory: UseSys-
AppData.reg

Using this file, the installation can be performed in a way that the user configu-
ration data is stored in this directory and the access path addresses this directory 
system-wide.

To restore the default behavior you can use the following file: UseLocalAp-
pData.reg 

It is also contained in the setup directory.
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7.6  Repairing, Upgrading and Uninstalling the OpenScape Extensions for 
Microsoft Outlook

Introductory description of how to repair (update), upgrade (installing a subse-
quent version) or uninstall the OpenScape Extensions for Microsoft Outlook.

You can update, upgrade or uninstall the client application OpenScape Exten-
sions for Microsoft Outlook also via the setup program (setup.exe).

7.6.1  How to Perform a Repair (Update) Installation for the OpenScape 
Extensions for Microsoft Outlook

Repairing (updating) the OpenScape Extensions for Microsoft Outlook.

If a current version of the OpenScape Extensions for Microsoft Outlook shall be 
repaired after the installation, proceed as follows:

Step by Step 1. Shut down Microsoft Outlook.

2. Start the current setup.exe of the installation program for the OpenScape 
Extensions for Microsoft Outlook.

3. Click on the Next button in the setup's welcome dialog.

Up comes this dialog:

4. Click on the Repair button in this dialog.

The confirmation dialog for the update installation opens.

5. Click on the Repair button in this confirmation dialog. 

The setup process starts and a new dialog opens that allows tracing the setup 
process. Another dialog opens, which marks the end of the installation. 

6. Click on the Finish button in this dialog. 

The update installation is complete and the setup assistant is closed.
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7.6.2  How to Perform an Upgrade Installation for the OpenScape 
Extensions for Microsoft Outlook

Installing a more recent OpenScape Extensions for Microsoft Outlook version.

If a current version of the OpenScape Extensions for Microsoft Outlook is to be 
set up after the installation, proceed as follows:

Step by Step 1. Shut down Microsoft Outlook.

2. Start the current setup.exe of the installation program for the OpenScape 
Extensions for Microsoft Outlook.

3. Click on the Next button in the setup's welcome dialog.

Up comes this dialog:

4. Click on the Upgrade button in this dialog.

The confirmation dialog for the upgrade installation opens.

5. Click on the Upgrade button in this dialog. 

The setup process starts and a new dialog opens that allows tracing the setup 
process. Another dialog opens, which marks the end of the installation. 

6. Click on the Finish button in this dialog. 

The update installation is complete and the setup assistant is closed.

7.6.3  Uninstalling the OpenScape Extensions for Microsoft Outlook

Uninstalling the OpenScape Extensions for Microsoft Outlook.
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How to remove the application OpenScape Extensions for Microsoft Outlook from 
your local system:

Step by Step 1. Close Microsoft Outlook.

2. Start the current setup.exe of the installation program for the OpenScape 
Extensions for Microsoft Outlook.

3. Click on the Next button in the setup's welcome dialog.

Up comes this dialog:

4. Click on the Remove button in this dialog.

The confirmation dialog for removing the application opens.

5. Click on the Remove button in this confirmation dialog. 

The uninstallation process starts and a new dialog opens which allows you to 
observe the uninstallation process. Another dialog opens, which marks the 
end of the uninstallation. 

6. Click on the Finish button in this dialog. 

The uninstallation is complete and the setup assistant is closed.

7.7  Configuring the OpenScape Extensions for Microsoft Outlook

Configuration options for the OpenScape Extensions for Microsoft Outlook.
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You can perform/change the settings for OpenScape Extensions for Microsoft 
Outlook in configuration dialogs.

NOTICE:  If invoking the configuration pages merely displays the 
Network tab, the OpenScape server could not be connected yet. 
In this case, try to connect the OpenScape server by specifying 
the user data, the network address and the port of the OpenScape 
server.

The following tabs are available for configuring the OpenScape Extensions for 
Microsoft Outlook:

• Network
Use this dialog to perform the settings for the user access and the connection 
to the OpenScape server.

• Audio / Video conference
Use this dialog to perform the settings for voice and video conferences.

• Web conference
Use this dialog to perform the settings for web conferences.

• Presence Status
Use this dialog to perform the settings for copying the conference appoint-
ments in order to control the presence status.

• User Interface
Use this dialog to define if the default configuration data should be used to 
create the conference or if you want to set the configuration data for each 
conference separately. Additionally, you can set the language for the invitation 
text here.

You reach the configuration dialogs via the Microsoft Outlook menu bar. In the 
Microsoft Outlook menu, select Tools > Options > OpenScape Extensions for 
Outlook tab > Configuration button.

Click the OK button to save your settings and to close the settings dialog.

Click the Cancel button to discard your settings. The OpenScape Configuration 
settings dialog is closed.

NOTICE:  Configuration modifications require a Microsoft Outlook 
restart to take effect.

7.7.1  Configuring the Network

The configuration settings for connecting the OpenScape server.

In the Network dialog, you can modify the initial setting data for your user access 
and the connection to the OpenScape server or enter this data if you have not 
performed this settings in the Initial Configuration dialog yet.
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In Microsoft Outlook 2003 you reach this settings dialog via the menu bar. Select 
in the menu of Microsoft Outlook Tools > Options > tab OpenScape Extensions 
for Microsoft Outlook > Configuration button > tab Network. In 
Microsoft Outlook 2010 you reach the settings dialog via File > OpenScape > 
doubleclick on Configuration > tab Network.

In the OpenScape Server - Network access section you need to make the 
following entries for logging on to your OpenScape user account:

• User ID
Specify your user ID in the format <user-ID@domain>.

• Password
Enter the password you use to log on to the OpenScape server.

• Use Windows Authentication
Set this option if you log on with your Windows login data. 
Then, for logging on to the OpenScape server, enter the data you use for 
logging on to your workstation in the User ID and Password input fields.

In the OpenScape Server - Network configuration section, the following entries 
are required for connecting the OpenScape server from your workstation:

• OpenScape Server - Host address
Enter here the complete network address (URL) of the OpenScape server.

• OpenScape Server - Port
Enter here the port via which the connection to the OpenScape server is 
configured.

NOTICE:  If you do not know the Logon or connection data, 
please contact your system administrator.
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7.7.2  Audio / Video Conference Configuration

Configuration of the audio / video conference default settings.

In the Audio /Video Conference dialog you can perform default settings for your 
audio conferences and schedule a video conference.

You reach this configuration dialog via the Microsoft Outlook menu bar. Select in 
the Microsoft Outlook menu Tools > Options >    Outlook tab > Configuration 
button > Audio/Video conference tab.

The Audio conference section provides the following configuration options:

• Record name
If you select this option, each conference participant is requested to specify 
his/her name before joining the conference. Only after recording their name, 
they can join the conference.

• Moderated conference
Use this option to determine whether to configure moderated or open confer-
ences as default.

NOTICE:  Only the moderator can start and control moderated 
conferences.

• Call direction
Select the corresponding option to define whether the conference participants 
are called by the system  have to dial into the conference by themselves  
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– If you have configured that the conference participants will be called by 
the system, the conference will start automatically when the start time is 
reached. Then, all conference participants are called by the system. At 
the same time, the web conference, if configured, will also start.

NOTICE:  The web conference start must be confirmed by the 
moderator or the conference creator.

– If you have configured that the conference participants need to dial into 
the conference by themselves, the conference is started when the first 
conference participant has dialed in via the bridge number and the 
conference PIN. As long as this conference participant is the only one, he/
she hears music-on-hold. When the next conference participant joins the 
conference, the conference will be opened.

NOTICE:  After you have dialed in or received the conference call, 
the system prompts you to join the conference. Click on  to join the 
conference  to reject to take part in the conference.

In the Video conference section, you can activate the checkbox Add video 
conference to configure the audio conference so that your conferences are 
always prepared for a video conference.

7.7.3  Configuring Web Conferences

Configuration of the web conference default settings.

You can default set your web conferences in the Web Conference dialog.
 A31003-S5070-U101-3-7619, 06/2012
128 OpenScape UC Application V7 Client Applications, User Guide



OpenScape Extensions for Microsoft Outlook
Configuring the OpenScape Extensions for Microsoft Outlook
You reach this configuration dialog via the Microsoft Outlook menu bar. Select in 
the Microsoft Outlook menu Tools > Options > OpenScape Extensions for 
Outlook tab > Configuration button > Web conference tab.

The top section under Web conference provider access data shows the 
properties of the web conference connections used. Additional tabs indicate that 
several web conference providers are available. Each tab represents one web 
conference provider.

In the bottom section under Web conference default settings you can use the 
Add web conference option to set that a web conference is automatically 
created with each conference you configure. The Preferred web conference 
provider combo box serves for selecting the desired web conference provider if 
several web conference provider are available.

7.7.4  Configuring the Presence Status

Configuring the presence synchronization.

Use the Presence dialog to perform the settings that update your presence state 
on the OpenScape server. 
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 129



OpenScape Extensions for Microsoft Outlook
Configuring the OpenScape Extensions for Microsoft Outlook
You reach this configuration dialog via the Microsoft Outlook menu bar. Select in 
the Microsoft Outlook menu Tools > Options > OpenScape Extensions for 
Outlook tab > Configuration button > Presence tab.

The Presence configuration section provides the following configuration 
options:

• Use presence synchronization
When you select this option, the OpenScape presence status is automatically 
synchronized with your Microsoft Outlook calendar data.
The presence status synchronization triggers the following operational 
behavior: 

– Independently of the presence status set before, your presence status 
changes automatically to the "In Meeting" status when an appointment or 
a meeting begins. This setting will be kept for the duration of the 
appointment or meeting.

– If a Microsoft Outlook user answers a meeting request with "Tentative", 
his/her presence state set before will be kept.

– At the end of the appointment or the meeting, the status "In Meeting" will 
change back to the status set before.

– If a user changes his/her status during an appointment or a meeting, e. g. 
by using another client application, the status is not synchronized. This 
presence status set manually will then apply to this user and be displayed.

• Update time in seconds
Click in the field in order to change the default time (60 seconds). Enter a new 
value for the synchronization time. Recommended values are 60 (1 minute), 
600 (10 minutes), 900 (15 minutes) or 1800 (30 minutes) in order to achieve 
an ideal synchronization depending on the concentration of appointments.
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7.7.5  Configuring the User Interface

Configuring the user interface.

Use the User interface dialog to perform the settings for the conference user 
interface.

You reach this configuration dialog via the Microsoft Outlook menu bar. Select in 
the Microsoft Outlook menu Tools > Options > OpenScape Extensions for 
Outlook tab > Configuration button > User interface tab.

The Conference user interface section provides the following configuration 
option:

• Use default conferencing options
Select this option to skip the settings dialog which is normally opened for the 
individual configuration of your conferences when you push the OpenScape 
Add conference button. That means that all conferences to be created are 
configured with the default settings that you defined before on the configu-
ration pages.

NOTICE:  You cannot change the configuration settings of an 
added conference retrospectively.

The Invitation text section provides the following configuration option:

• Language
In the Language combo box, select the language in which the invitation text 
will be sent to the conference participants via the meeting request. From the 
available languages, select the one you need as default setting for your 
conference invitations. By default, the invitation text first uses the language in 
which your Microsoft Outlook client has been installed.
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7.8  Configuring, Editing, Deleting, and Controlling Conferences

Operating options for the OpenScape Extensions for Microsoft Outlook.

After you have installed the OpenScape Extensions for Microsoft Outlook you can 
use the following operating options:

• Configuring conferences.
You can schedule one-time or recurrent meet-me conferences via the 
Microsoft Outlook calendar. Depending on the system environment, you can 
choose between the following conference types:

– Audio conferences

– Web conferences

– Video conferences

• Editing conferences.
This comprises:

– Changing conference data before sending the conference invitation.

– Changing conference data after sending the conference invitation.

– Starting audio conferences.

– Starting web conferences.

• Controlling conferences.
You can control an active audio conference via:

– The keypad of your telephone

– The call control of your OpenScape Desktop Client Enterprise Web 
Embedded Edition or your OpenScape Web Client.

• Deleting conferences.
You can delete your configured conferences from your Outlook calendar 
anytime.

NOTICE:  When deleting conferences, verify that no "orphaned" 
conferences remain. "Orphaned" conferences are conferences to 
which no appointment is assigned anymore after they have been 
deleted from the Outlook calendar. How to delete conferences 
correctly describes section Deleting Conferences.

7.8.1  How to Configure a Conference

Configuring a conference via the Microsoft Outlook calendar.

How to configure a conference:

Step by Step 1. Click in Outlook 2003 or Outlook 2007 on the small triangle icon next to the 
New button or in Outlook 2010 on New Items.

The message selection menu opens.
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2. Select from this menu the function Meeting Request or Meeting in Outlook 
2010.

NOTICE:  You can also reach this dialog via File > New > 
Meeting Request.

The Untitled - Meeting dialog opens.

3. If required, configure if you would like to create a recurrent conference. To 
this, push the Recurrence button in the toolbar. In the Appointment Recur-
rence dialog, enter the corresponding data.

4. Enter the conference participants in the address line.

NOTICE:  Via the To button you can browse the 
Microsoft Outlook address books or your contact lists for partici-
pants and select them.
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5. Specify a meeting subject in the corresponding input line.

NOTICE:  The subject describes the conference. Under this 
description the conference will be logged in the message respec-
tively conference journal.

6. Use the Start time and End time combo boxes to schedule the conference.

7. Click on the   AddOpenScape conference icon.

Depending on your configuration settings the OpenScape Conference 
dialog opens, or the conference data are immediately displayed in the bottom 
section of the <Subject> - Meeting dialog.

NOTICE:  This dialog opens during the creation of a conference 
only if you have not selected the Use default conference 
options option while performing configurations on the User 
Interface tab.

8. Select the following options in the Audio Conference section:

• Record name

Leave this option activated if you wish to have the names of the 
conference participants recorded, or deactivate it otherwise.

NOTICE:  If this checkbox is active, the conference participants 
need to specify their names before they can take part in the 
conference.
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• Moderated conference/open conference

Leave this checkbox activated if you wish to have a moderated 
conference. Deactivate this option if you wish to create an open 
conference.

A moderated conference requires the presence of a moderator. As long 
as the moderator is not in the conference, the other conference partici-
pants hear music-on-hold until the moderator join the conference.

The moderator of a moderated conference has more options to control the 
conference than the other participants of the moderated conference.

In case of an open conference the conference starts as soon as the first 
conference participant is in the conference. The conference now takes 
place with the participants who successively dial in.

In an open conference, all conference participants have the same options 
to control the conference.

• Call direction

Select the corresponding option to define whether all conference partici-
pants are called by the system or have to dial into the conference by 
themselves . 

9. Select the following options in the Web Conference section:

• Add web conference

Set this radio button if you want to create a web conference and an audio 
conference simultaneously.

• Preferred web conference provider

If several providers are available, you can select the conference provider 
from this combo box.

10. In the Invitation text section, select via the Language combo box the 
language for the invitation text. In this language, the invitation text will be sent 
to all conference participants via the meeting request. 

11. In the Video conference section, select whether you would like to configure 
additionally a video conference.

The invitation text contains the additional information "* This conference 
supports video.".

12. Click on OK after having made your selection.
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The dialog is closed and the conference data is displayed in the language 
configured in the bottom section of the <Subject> - Meeting dialog.

The conference access data are in detail:

In the Voice section:

The bridge number(s) the conference participants require to log on to the 
conference and the conference PIN that the conference participants use to 
authenticate themselves.

In the WEB section:

Two links for opening the required web conference client:

You can use the first link for downloading a separate stand-alone client for the 
web conferencing session. 

The second link enables loading a web-based client for the web conference.

13. In the <Subject> - Meeting dialog, click on the Send button.

The meeting request is sent do the addressed system users and the 
<Subject> - Meeting dialog is closed. All required information such as 
conference access data, meeting time and subject is delivered to the selected 
participants and entered in their Outlook calendar as appointment.

When the conference is created, the conference is entered with its data in the 
conference list of each OpenScape UC Application conference participant in all 
OpenScape UC Application clients at the same time.

NOTICE:  Bear in mind that you must communicate the 
conference information (bridge number and PIN) to external 
conference participants (participants without OpenScape 
UC Application user account) via a separate e-mail or other 
means of communication.

7.8.2  Editing the Conference before Sending the Conference Data

Editing a configured conference before sending the meeting request.

You have configured a conference by selecting the relevant participants, the 
subject and the conference time and by clicking on the  AddOpenScape 
Conference button.

After you have carried out these actions, the <Subject> - Meeting dialog displays 
the two buttons for editing the conference:

•  OpenScape Delete conference
Deletes the configured conference from your own conference list and from the 
conference lists of the invited participants.
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•  Join conference
Using this option you can join the conference.

NOTICE:  If a web conference has been configured in addition, 
the  Start Web Conference icon becomes active after the start 
of the OpenScape conference. You can use this icon to start the 
web conference from the calendar dialog of Microsoft Outlook. 

7.8.3  Editing the Conference after Sending the Conference Data

Editing a configured conference after sending the meeting request.

After you have sent the conference data, the conference date is entered in your 
Outlook calendar. You can reopen the conference data for editing by double-
clicking the conference calendar-entry.

The two buttons for editing the conference are now available:

•  OpenScape Delect conference
Deletes the configured conference from your own conference list and from the 
conference lists of the invited participants.

NOTICE:  The sent conference notifications are not deleted.

•  Join conference
Using this option you can join the conference.

NOTICE:  If a web conference has been configured in addition, 
the  Start Web Conference icon becomes active after the start 
of the OpenScape conference. You can use this icon to start the 
web conference from the calendar dialog of Microsoft Outlook. 

7.8.4  How to Invite Further Participants to a Conference that is already 
Started

Expand conference after the start with further participants.

After the start of a conference the moderator (in case of moderated conferences) 
or one of the other conference participants (in case of an open conference) can 
invite further participants to the current conference. 

Step by Step 1. Open the respective calendar entry for this conference.

2. Add the additional participant(s) to the originator's address line.

3. Click on the Send button.
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The Send Update to Attendees dialog opens.

4. In this dialog, select one of the following send options:

a) Send update only to added or deleted attendees if you would like to 
send the update only to the additionnally invited participants.

b) Send update to all attendees if you would like to send the update to all 
conference participants.

5. Click on OK.

The Send Update to Attendees dialog closes. The additionally invited 
conference participants are directly called by the system and receive an e-mail 
invitation. This e-mail contains all data that has been configured for the original 
conference invitation, i.e. also the links for a possibly configured web conference.

7.8.5  Deleting Conferences

Deleting conferences created via OpenScape Extensions for Microsoft Outlook.

NOTICE:  Once a conference is started you cannot delete it. You 
can only delete the calendar entry (appointment). Because 
conferences are started with an advance period, you may not be 
able to delete them even shortly before the scheduled start time.

To delete conferences you must take one of the actions proposed below to avoid 
that "orphaned" conferences are displayed in the OpenScape Desktop Client 
Enterprise Web Embedded Edition or the OpenScape Web Client conference 
lists. "Orphaned" conferences are conferences to which no appointments are 
assigned any more after being deleted from the Microsoft Outlook calendar.

"Orphaned" conferences in the OpenScape Desktop Client Enterprise Web 
Embedded Edition or the OpenScape Web Client may result, for example, from 
the following delete actions: 

• Deleting a conference entry from the Microsoft Outlook calendar main view. 

• Deleting the conference entry via the calendar access of your mobile device.

• Deleting the conference entry via Outlook Web Access (OWA).

To delete the conference created via the OpenScape Extensions for Microsoft 
Outlook without leaving "orphaned" conference entries in the OpenScape 
Desktop Client Enterprise Web Embedded Edition or the OpenScape Web Client, 
you must first open the corresponding conference entry with a doubleclick. After 
this, you have two options to delete the conference entry successfully:

• You can delete the conference via the opened conference entry by pushing 
the  Delete OpenScape Conference button.
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• Deleting the conference via the open conference entry by using the delete 
functions in Microsoft Outlook (File menu > Delete or toolbar  ).

NOTICE:  In case of Microsoft Outlook 2003, when deleting via 
menu File > Delete or toolbar , you need to select "Send 
cancellation and delete meeting" as deletion option.

7.8.6  Starting the Audio Conference

Start-up behavior of the audio conference.

An audio conference starts in most cases automatically when the start time has 
been reached (scheduled conferencing). However, in case of a moderated 
conference the moderator can start it manually beforehand. If the audio 
conference is an open one, it can also be started manually or by any conference 
participant dialing in. Depending on your conference configuration, the server 
triggers the following functions at the conference start: 

• The system calls all conference participants.

• All conference participants need to dial into the conference by 
themselves.

The conference participants are called by the system 

If you have configured that the conference participants will be called by the 
system, the conference will start automatically when the start time is reached. 
Then, all conference participants are called by the system. If the moderator has 
started the conference beforehand, all conference participants are called at this 
time.

The conference participants dial into the conference by themselves 

If you have configured that the conference participants need to dial into the 
conference by themselves, the conference starts automatically when the start 
time is reached. The conference participants can then dial into the conference. If 
another conference participant has started the conference beforehand (manually 
or by dialing in), he/she hears music-on-hold as long as he/she is the only partic-
ipant. When the next conference participant joins the conference, the conference 
will be opened.

NOTICE:  After you have dialed in or received the conference call, 
the system prompts you to join the conference. Click on  to 
join the conference or on  to refuse taking part in the 
conference.

7.8.7  How to Dial into an Audio Conference

Joining an audio conference.
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How to dial into the conference:

Step by Step 1. Open the meeting entry of the relevant conference in the Microsoft Outlook 
calendar.

2. Dial into the conference under the Bridge Number specified here when the 
conference start is due.

3. Enter the Conference PIN via telephone when the system prompts you to do 
so. This identifies you as authorized conference participant.

You have now joined the conference.

7.8.7.1  Controlling a Voice Conference via Call Control

Controlling a voice conference via the "Call Control" function dialog.

Depending whether you are moderator, creator or participant of an open 
conference, the following functions are available for controlling an active 
conference in the Call Control feature window:

In the header

•  Lock conference
In case of moderated conferences this feature is available to moderators only. 
In open conferences, every conference participant can trigger this feature. 
This option blocks the conference for other subscribers who want to join in. 
After you have clicked on the icon it changes to  .

•  Unlock conference
Releases the conference locking. After you have clicked on the icon it 
changes to  .

•  Mute conference
In case of moderated conferences this feature is available to moderators only. 
In open conferences, every conference participant can trigger this feature. It 
interrupts the sound transmission to all conference participants. After you 
have clicked on the icon it changes to  .

•  Unmute conference
This feature is only available for participants with moderator or creator privi-
leges. It cancels the conference muting.

•  Start web conference
If you have configured a web conference or were invited for a web 
conference, you can use this icon to set up the connection to the web 
conference.

•  End conference
This feature is only available for participants with moderator or creator privi-
leges. It ends the conference by closing down the connections to the other 
conference participants.
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During the connection representation of the conference participants

NOTICE:  The connection representation shows all participants 
who are currently in the conference. In a moderated conference, 
the moderator is indicated by a dot that precedes his/her name 
entry. The name of the conference participant who is currently 
active (thus talking) is highlighted in boldface.

•  Change device and resume active call
This feature allows every conference participant to hand his/her conference 
connection over to another device and continue taking part in the conference 
from there.

•  Mute participant
It interrupts the sound transmission for a conference participant. After you 
have clicked on the icon it changes to  . 

•  Unmute participant 
It undoes muting a conference participant.

•  Leave conference

– Moderated Meet Me conference
The conference moderator or creator can use this option to leave the 
conference or to disconnect single conference participants from the 
conference.

– Open Meet Me conference
Enables every participant to leave the active conference.

– Ad-hoc/MeetNow! Conference
Enables every participant to leave the active conference. As soon as all 
participants have exited the Ad-hoc- or the MeetNow! conference, the 
conference ends.

NOTICE:  After you have left the conference via the  icon and 
wish to join in again after a short period, you need to dial into the 
desired conference again and also specify the conference PIN.

If the Call Control dialog has been opened via the URL in the conference 
notification e-mail, the following information and functions depending on the 
system environment can be provided:

– The name of the currently active speaker is highlighted.

– Conference PIN Display

– Option to join an active web conference  .

– Display of the conference participants who are actually in the conference.

– Display of the participants who have not joined the conference yet.

NOTICE:  If you are on the road and do not take part in a 
conference with your office phone (ONS) but e.g. with your cell 
phone, the connection may be affected by various factors or even 
aborted. In case of a disconnection you have not initiated yourself, 
you can dial into the active conference again after a short, pre-
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defined period. When the connection to the conference server is 
up again, you are prompted by greeting to push a specific, pre-
defined telephone key. By pushing this key you can instantly join 
the active conference without having to enter the conference PIN 
once more.

Via the Call Control dialog the moderator (in case of a moderated 
conference) or one of the other conference participants (in case of an open 
conference) can add further OpenScape UC Application or external partici-
pants:

NOTICE:  If you expand a conference that has been created in 
Microsoft Outlook via the call control, no e-mail invitation is sent 
to the new participant. He/she will not receive a link to join a web 
conference that may have been configured.. If this participant is to 
receive the link to join the web conference, you need to send this 
link via e-mail.

– OpenScape UC Application users
For example, you can enter the name of the desired OpenScape 
UC Application participant in the New Call combo box and subsequently 
click on   to search all configured directories for the desired contact.

– External users
You can add an external user to the conference by entering his/her phone 
number in the New Call combo box and enabling the green receiver. This 
participant will be directly called by the conference system. He/she will not 
receive a conference notification e-mail because the conference system 
does not know his/her e-mail address.

NOTICE:  For adding external participants we recommend using 
the Add participant dialog as it allows specifying an e-mail 
address for the desired participant. You reach this dialog with a 
click on  in the Modify conference dialog.

7.8.7.2  Controlling a Conference via Telephone

Controlling a conference via telephone
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As OpenScape UC Application user you can control an active conference also via 
the keys of your configured preferred device. The telephone keys are used for 
transmitting control commands to the system by sending DTMF tones.

NOTICE:  The administrator can deactivate the operating menu 
by configuration. Furthermore, he/she can change the 
assignment of commands to the single keys. The default setting 
for having the menu functions put out by announcement is 
   . In case of doubt please contact your administrator.

Activating the Control Menu

You control a conference by entering two key commands on the keypad of your 
phone. This prevents conference disruptions by a telephone key being pushed 
inadvertently.

NOTICE:  The administrator can change the telephone key/
command assignment. The following description refers to the 
system default setting.

Control Commands

You can use the following key commands for controlling a conference:

•  Play menu
The available menu options are announced to you.

•   Lock/unlock conference.
This feature is only available for participants with moderator or creator privi-
leges. Once the conference has been locked, no further participants may dial 
in. Pushing this key once more undoes the restriction.

•   Activate/lift muting.
Via this key you can temporarily deactivate the microphone of your telephone. 
The conference connection is maintained. Pushing this key once more reacti-
vates the microphone.

•   Activate/lift conference muting.
This feature is only available for participants with moderator or creator privi-
leges. This feature mutes all microphones of the conference participants. 
Only the voice signal of the conference participant who triggers this function 
is still transmitted to all conference participants.

•   Initiate device handover.
This function allows you to change the device you use in the conference. After 
you have pushed this key, enter the phone number of the device you want to 
switch to. You need to complete the phone number entry with the  pound 
key. For further proceedings, please follow the voice prompts.

•   Turn off music-on-hold.
If you currently are the only conference participant and hear music-on-hold, 
you can push this key to switch off the music. Pushing this key once more 
reactivates the music-on-hold.
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7.8.8  Starting a Video Conference Connection

How to set up a video conference connection.

With the corresponding requirements met, you can extend an audio conference 
to a video conference. Requirements are e.g. server licenses and video-
compatible devices or clients.

When you select the Add Video Conference option upon configuring the 
conference, the video dialog opens automatically at the conference start. The 
user only needs to release sending his/her own video image for starting the video 
streaming. When the conversational partners release their video streaming, too, 
all conference participants can see each other.

The bottom left area of the video screens displays the participant name respec-
tively participant number. In case of a moderated conference, the video screen 
features the moderator icon  , which precedes the moderator's text entry.

The video screen of the currently active speaker is highlighted by a colored frame. 
In addition, the participant name or number of the active speaker appears in 
boldface.

NOTICE:  Users who take part in the conference via a pure voice 
connection see a text field in the video dialog when they are 
currently active as speaker. This text field displays the participant 
name or number of this user.

7.8.9  Starting/Joining a Web Conference

Starting a web conference.

After the audio conference has been started, an additionally configured web 
conference can be started by the user who has created it. To this, he/she first 
needs to download the web conference client via the  Start Web Conference 
button. How to proceed:

• Via Microsoft Outlook

– Click on the   Start Web Conference icon if you are the moderator of 
the conference or the person who created the conference. This starts the 
web conference and downloads the web conference client for the web 
conference.

• Via the OpenScape Web Client or the OpenScape Desktop Client Enterprise 
Web Embedded Edition 
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– In the call control already open for the active audio conference, click on 
the   Start Web Conference icon if you are the moderator of the 
conference or the person who created the conference. This starts the web 
conference and downloads the web conference client for the web 
conference.

NOTICE:  Operating the web conference client is described in the 
OpenScape Web Collaboration V1 manual.

Joining a web conference

How to join the web conference after it has been started:

• Via Microsoft Outlook

– Click on one of the two links for using either the separate stand-alone 
client or the web-based one.
Open the meeting entry of the relevant conference in the 
Microsoft Outlook calendar and click on the corresponding link. The 
conference client for the web conference starts.

• Via the OpenScape Web Client or OpenScape Desktop Client Enterprise 
Web Embedded Edition:

– In the call control already open for the active audio conference click on the 
  Start Web Conference icon. This downloads the web conference 
client for the web conference.

NOTICE:  Operating the web conference client is described in the 
OpenScape Web Collaboration V1 manual.
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8  OpenScape Extensions for Lotus Notes

General Description of the OpenScape Extensions for Lotus Notes

After you have installed the OpenScape Extensions for Lotus Notes, the IBM 
Lotus Notes client provides features for scheduling server-based Meet Me confer-
ences via a meeting request in the IBM Lotus Notes calendar. Among server-
based conferences you find: 

• Audio conferences

• Web conferences

• Video conferences

When the conference extensions are installed, the button 

 Add OpenScape conference

is displayed in the toolbar of the dialog for scheduling an appointment.

The conference is performed via the OpenScape UC Application server. 

NOTICE:  The default system configuration plays a short signal 
tone audible to all conference participants when a conference 
participant joins or leaves the conference. In case of a larger 
number of conference participants joining or leaving this signal 
tone may become annoying to the others. It is therefore not played 
anymore when the number of conference participants exceeds 
15.

8.1  Requirements for Use

Requirements for using the OpenScape Extensions for Lotus Notes.

The OpenScape Extensions for Lotus Notes has been released only for specific 
Windows operating systems and IBM Lotus Notes versions.

You find current and detailed information about the supported operating systems 
and versions of the usable IBM Lotus Notes clients in the OpenScape UC Appli-
cation Planning Guide manual.

You need to perform some configurations on the Lotus Domino server for 
installing the OpenScape Extensions for Lotus Notes. You find information about 
these preparations in the manual "OpenScape UC Application V6 Configuration 
and Administration" in Chapter "Configuring the Lotus Domino Server for the 
OpenScape Conference Extension".

8.2  Meet Me Conferences

The definition of meet-me conferences.
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Meet Me conferences are voice conferences planned and configured in advance.

Meet-me conferences can be scheduled conferences that start automatically at a 
specific time. They can also be conferences started any time either manually by 
the moderator or automatically with the first participant who dials in. 

A conference does not begin at the actual start time but somewhat earlier. This 
advance period is defaulted by a system configuration. It serves for balancing out 
minor differences between the system times of the conference participants, thus 
avoiding failed dial-ins.

If the defaulted conference duration was too short, it is automatically prolonged 
following the defaults in the system configuration. Such prolongations are defined 
in accordance with the overall duration of conferences configured in the system. 
The default-set value for a prolongation is 30 minutes.

In addition, a Meet Me conference can be designed as moderator-controlled or 
open conference. Several conference participants can be defined as moderators. 
This determines the conference proceedings.

The following actions end a Meet Me conference: 

• The last moderator (moderated conference) leaves the conference by termi-
nating the conference call. This triggers a grace period that allows other 
conference participants to end the conference also. When the grace period 
has expired, the conference ends.

• The last conference participant (open conference) logs out of the conference 
by terminating the conference call.

Scheduled conference

In case of a scheduled conference, the conference creator sets the start time and 
duration of the conference in accordance with the overall duration of conferences 
configured in the system. 

Please note the following for a moderated and scheduled conference:

• If the moderator leaves the conference during the initially scheduled period, 
the conference persists until the initially scheduled end time. So, the other 
conference participants can resume the conference.

• If the moderator leaves the conference during a conference prolongation, the 
grace period starts when the moderator terminates the conference call. The 
grace period enables the other conference participants to end the conference 
also. When the grace period has expired, the conference ends.

Unscheduled conference

In case of an unscheduled conference you (as conference creator) need to start 
the conference manually. After the conference start the conference remains 
active within the scope of the overall duration of conferences configured in the 
system until the last conference participant has logged out by terminating the 
conference call.

Please note the following for a moderated and unscheduled conference:
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• If the moderator leaves the conference during the initially scheduled period, 
the grace period starts when the moderator terminates the conference call. 
The grace period enables the other conference participants to end the 
conference also. When the grace period has expired, the conference ends.

• If the moderator leaves the conference during a conference prolongation, the 
grace period starts when the moderator terminates the conference call. The 
grace period enables the other conference participants to end the conference 
also. When the grace period has expired, the conference ends.

Open conference

An open conference is a meet-me conference in which all participants have equal 
control privileges. The conference starts automatically either at a scheduled time 
or with the first participant who dials in or manually with the first conference partic-
ipant who dials in. The conference configuration allows two ways of joining in: 
Participants are either called automatically by the system after the conference 
start (dial-out) , or they need to dial in by themselves (dial-in) . You create an 
open conference by activating the Open Conference checkbox in the Create 
conference dialog.

Moderated conference

A moderated conference is a meet-me conference in which only the conference 
creator has the control privilege as moderator. The conference starts automati-
cally at the scheduled time if such a point in time has been configured. If no start 
time has been defined, the moderator can start the conference manually or by 
dialing into the conference. Depending on the configuration, the conference 
participants can dial into the conference (dial-in)  or are called by the system 
(dial-out) . When the moderator leaves the conference, it comes automatically 
to an end for the other participants, too. A moderated conference is created by 
the conference creator deactivating the Open Conference check box in the Add 
Conference dialog.

8.3  Web Conferences

Definition of web conferences.

You can use a web conference to show elements and actions represented on your 
monitor to other users in real time during an online session. By means of this 
“desktop sharing” you can thus demonstrate operating steps or present an appli-
cation and work on documents in cooperation with other users. This is particularly 
useful in training projects, demonstrations and conferences joined by participants 
who are far away from each other.

In an OpenScape system you can integrate different web conferencing providers.
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The web conferencing application OpenScape Web Collaboration Embedded is 
shipped with OpenScape UC Application by default. A moderator decides which 
participant may present his/her screen and who is in control of the presented 
screen. Likewise, the moderator can present his/her own screen and have it 
controlled.

NOTICE:  The web conferencing application OpenScape Web 
Collaboration of the OpenScape UC Application is not supported 
for Mac OS.

Other web conferencing providers can be configured for use in a project-specific 
installation.

Check the combo box for selecting the web conferencing provider to see which 
web conferencing providers are available to you.

NOTICE:  Please obtain the operating instructions for the single 
web conferencing applications from the manuals of the respective 
web conferencing provider.

If you can choose from several web conferencing providers, it is 
useful to deploy one specific web conferencing provider only. 
Since the features of all web conferencing providers vary only 
slightly, you need to familiarize yourself with only one web confer-
encing application.

NOTICE:  You find a guide to using and operating the OpenScape 
Web Collaboration web conferencing application as well as 
feature descriptions in the OpenScape Web Collaboration V1 
user manual.

Clients you can use for Web Conference

You can use the web conferencing feature on Windows-based systems only. 

NOTICE:  You find information about Windows operating systems 
that can be used for staging web conferences in the OpenScape 
UC Application V6 Planning Guide manual. 

You can stage a web conference alternatively via the following clients:

• A separate stand-alone client, which is downloaded and started for a web 
conferencing session.

• A web-based client that can be reached via a specific URL.

What is a Web Conferencing Application?

In OpenScape UC Application you can realize the web conferencing feature by 
different web conferencing applications. The web conferencing application is 
installed on an individual server. Neither the moderator nor the participants need 
 A31003-S5070-U101-3-7619, 06/2012
150 OpenScape UC Application V7 Client Applications, User Guide



OpenScape Extensions for Lotus Notes
Web Conferences
to install or configure any additional application before using the web confer-
encing application. After the start of a web conference, the participants can 
download a program via a user-specific Internet address. The online session is 
opened after the conference participants have started this program.

Web conferencing applications support two user roles:

• Presenter
His/her desktop is presented to the other participants. He/she can allow/forbid 
controlling his/her desktop.

• Viewer
He/she watches the presenter's desktop.

The following user modes are possible during a web conference:

• Moderator: he/she organizes, opens and controls a web conference

• Participants (active/passive):
these are the conference participants who have been invited for a web 
conference and join a web conference session.

All in all the web conferencing function is similar to the one of a video/audio 
conference with the difference that the desktop of a user is transmitted instead of 
a video stream. This transmission can be controlled by the moderator or a partic-
ipant if he/she has been granted the corresponding privilege.

When the moderator starts a web conferencing session, he/she is in display 
mode. The participants are in viewer mode and see the moderator's desktop. The 
moderator can change this mode by assigning a participant the privilege to 
display his/her desktop. In addition, the moderator can delegate the operation of 
the desktop elements to a participant. This enables the member to remotely 
control the mouse and keyboard of the computer the desktop of which is currently 
displayed. He/she can thus operate the computer.

Further features of a web conferencing application are:

• Application selection
You use this feature to specify the applications and screen elements to be 
visible to the session partners.

• Monitor control
Via this feature you control how your screen is represented to the session 
partners.

• Uploading, downloading and deleting files.

• Using a whiteboard feature in screenshot or live mode
This enables the session participants to insert drawings and markings in the 
transmitted screen, which all other participants can see then. In case of the 
screenshot mode the displayed screen freezes to a fixed-image; in live mode 
the transmission continues without restriction.

• Using a chat feature
The chat feature enables the transmission of text messages either to single 
participants or to all of them during the session.
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With the conference configuration, all required conference data (participants, dial-
in data, link for the web conferencing client and conference time) is sent by e-mail 
to the conference participants. 

NOTICE:  Depending on the system environment, an additional 
link is embedded in the e-mail for invited internal conference 
participants (UC Application users). They can use this link to open 
a cluster-spanning call control window. This call control shows the 
status of the started conference and enables controlling the 
conference depending on the participant privileges.

At the same time, the conference is entered for OpenScape UC Application 
participants in the conference list of the Conferences function window and, in 
case of Microsoft Outlook and IBM Lotus Notes, automatically entered in the 
calendar.

NOTICE:  External conference participants are informed about 
the dial-in data (PIN, Tollfree Bridge Number, and URL for the 
web conferencing application as well as the conference start time) 
by e-mail only if their e-mail address is available in the system. If 
the external conference participants do not have an e-mail 
address, they must be informed separately, e.g. via an external e-
mail address or by telephone.

8.4  Installing the OpenScape Extensions for Lotus Notes

General information about installing the OpenScape Extensions for Lotus Notes.

NOTICE:  You need to perform some configurations on the Lotus 
Domino server for installing the OpenScape Extensions for Lotus 
Notes. You find information about these preparations in the 
manual "OpenScape UC Application V6 Configuration and 
Administration" in Chapter "Configuring the Lotus Domino Server 
for the OpenScape Conference Extension".

You install the OpenScape Extensions for Lotus Notes by starting the setup file 
setup.exe from the setup directory OpenScape4LotusNotes.

NOTICE:  The dialog language in which the OpenScape Exten-
sions for Lotus Notes is installed on your system corresponds to 
the language of your currently installed IBM Lotus Notes appli-
cation.
 A31003-S5070-U101-3-7619, 06/2012
152 OpenScape UC Application V7 Client Applications, User Guide



OpenScape Extensions for Lotus Notes
Installing the OpenScape Extensions for Lotus Notes
8.4.1  Requirements for Setting up OpenScape Extensions for Lotus Notes

Installation requirements for the OpenScape Extensions for Lotus Notes.

Normally, when the OpenScape Extensions for Lotus Notes is used under a 
default user account in a domain, you perform the setup in two steps:

NOTICE:  If a user who has administrative privileges at his/her 
workstation performs the setup or the current Runtime and .Net 
components have already been installed, only a single installation 
is required.

• Installation of the OpenScape Extensions for Lotus Notes with administrative 
privileges on the relevant workstation.
This way, some additional Windows-specific Runtime and .Net components 
are installed that can be installed only with administrative privileges.

• Installation of the OpenScape Extensions for Lotus Notes for the user 
account, under which this component is to be used.
This is necessary for registering the setup of the OpenScape UC Application 
Conference Extensions duly for this user account in the Registry under 
HKEY_CURRENT_USER .

8.4.2  How to Perform the Installation

Description of the OpenScape Extensions for Lotus Notes setup process.

To perform the setup, proceed as follows:

Step by Step 1. Close the IBM Lotus Notes client.

2. Start the setup.exe.

NOTICE:  When you install the IBM Lotus Notes component via a 
network directory you encounter a security prompt that you need 
to confirm with a click on the Run button.

3. Click on Next.

The welcome dialog of the setup wizard opens.

4. Click on Next to initiate the setup process.

The licensing dialog opens.

5. Set the I accept the license agreement option.

6. Click on Next. 

The setup confirmation dialog box opens.
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7. Click the Install button.

A new dialog opens that allows tracing the setup process: 

Another dialog opens, which marks the end of the installation. 

8. Click on the Finish button in this dialog. 

The installation is complete and the setup assistant is closed.

9. Start your IBM Lotus Notes client. 
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The Initial configuration dialog opens: Enter here initially the user data for 
your access to the OpenScape server and the data for connecting the 
OpenScape server. At the next start of your IBM Lotus Notes client, the 
OpenScape is connected automatically.

NOTICE:  
You can also reach this setting dialog via the configuration 
settings. To this, go to the IBM Lotus Notes dialog Calendar and 
push the Configuration   button.

In the OpenScape Server - Access Data section you need to make the 
following entries for logging on to your OpenScape user account:

OpenScape User ID

Specify here your user ID for the OpenScape UC Application in the format 
<user ID@domain>.

OpenScape - Password

Enter the password you use to log on to the OpenScape server.

In the OpenScape Server - Network Configuration section, the following 
entries are required for connecting the OpenScape server from your 
workstation:

OpenScape Server - Host Address

Enter here the complete network address (URL) of the OpenScape server.

OpenScape Server - Port

Enter here the network port via which the connection to the OpenScape 
server is configured.

NOTICE:  If you do not know the Logon or connection data, 
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please contact your system administrator.

Setup with the initial configuration for immediately connecting the OpenScape 
server is now complete.

NOTICE:  If the OpenScape server cannot be connected after you 
have specified the user data, the network address and the port of 
the OpenScape server, the OpenScape Extensions for Lotus 
Notes cannot be configured. When invoking the configuration 
dialog merely the Network tab is displayed for connecting the 
OpenScape server.

Now you can create your conferences by creating a new calendar entry in IBM 
Lotus Notes.

8.5  Updating and Uninstalling the OpenScape Extensions for Lotus Notes

Introductory description of repairing (updating) or uninstalling the OpenScape 
Extensions for Lotus Notes.

You update the client application OpenScape Extensions for Lotus Notes or 
uninstall it via the setup program (setup.exe) also.

8.5.1  How to Perform an Update Installation for the OpenScape Extensions 
for Lotus Notes

Repairing (updating) the OpenScape Extensions for Lotus Notes.

If a current version of the OpenScape Extensions for Lotus Notes is to be set up 
after the installation, proceed as follows:

Step by Step 1. Close the IBM Lotus Notesclient.

2. Start the current setup.exe of the installation program for the OpenScape 
Extensions for Lotus Notes.

3. Click on the Next button in the setup's welcome dialog.
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Up comes this dialog:

4. Click on the Repair button in this dialog.

The confirmation dialog for the update installation opens.

5. Click on the Repair button in this confirmation dialog. 

The setup process starts and a new dialog opens that allows tracing the setup 
process. Another dialog opens, which marks the end of the installation. 

6. Click on the Finish button in this dialog. 

The update installation is complete and the setup assistant is closed.

8.5.2  How to Perform an Upgrade Installation for the OpenScape 
Extensions for Lotus Notes

Installing a more recent OpenScape Extensions for Lotus Notes version.

If a current version of the OpenScape Extensions for Lotus Notes is to be set up 
after the installation, proceed as follows:

Step by Step 1. Shut down IBM Lotus Notes.

2. Start the current setup.exe of the installation program for the OpenScape 
Extensions for Lotus Notes.

3. Click on the Next button in the setup's welcome dialog.
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Up comes this dialog:

4. Click on the Upgrade button in this dialog.

The confirmation dialog for the upgrade installation opens.

5. Click on the Upgrade button in this dialog. 

The setup process starts and a new dialog opens that allows tracing the setup 
process. Another dialog opens, which marks the end of the installation. 

6. Click on the Finish button in this dialog. 

The update installation is complete and the setup assistant is closed.

8.5.3  Uninstalling the OpenScape Extensions for Lotus Notes

Uninstalling the OpenScape Extensions for Lotus Notes.

How to remove the application OpenScape Extensions for Lotus Notes from your 
local system:

Step by Step 1. Close the IBM Lotus Notes client.

2. Start the current setup.exe of the installation program for the OpenScape 
Extensions for Lotus Notes.

3. Click on the Next button in the setup's welcome dialog.
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Up comes this dialog:

4. Click on the Remove button in this dialog.

The confirmation dialog for removing the application opens.

5. Click on the Remove button in this confirmation dialog. 

The uninstallation process starts and a new dialog opens which allows you to 
observe the uninstallation process. Another dialog opens, which marks the 
end of the uninstallation. 

6. Click on the Finish button in this dialog. 

The uninstallation is complete and the setup assistant is closed.

8.6  Configuring the OpenScape Extensions for Lotus Notes

Configuration options for the OpenScape Extensions for Lotus Notes.

You can perform/change the settings for OpenScape Extensions for Lotus Notes 
in configuration dialogs.

NOTICE:  If invoking the configuration pages merely displays the 
Network tab, the OpenScape server could not be connected yet. 
In this case, try to connect the OpenScape server by specifying 
the user data, the network address and the port of the OpenScape 
server.

The following tabs are available for configuring the OpenScape Extensions for 
Lotus Notes:

• Network
Use this dialog to perform the settings for the user access and the connection 
to the OpenScape server.

• Audio / Video conference
Use this dialog to perform the settings for voice and video conferences.
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• Web Conference
Use this dialog to perform the settings for web conferences.

• Presence Status
Use this dialog to perform the settings for copying the conference appoint-
ments in order to control the presence status.

• User Interface
Use this dialog to define if the default configuration data should be used to 
create the conference or if you want to set the configuration data for each 
conference separately.

You reach the configuration dialogs in IBM Lotus Notes  via the calendar dialog 
menu bar. In there, click on the Configuration button to open the configuration 
dialogs.

NOTICE:  Alternatively, you can reach the configuration dialogs 
via the OpenScape  button when you are already in the 
New Calendar Entry dialog. In the OpenScape menu, select 
Configuration. 

Click the OK button to save the settings in the configuration dialogs and to close 
the settings dialog.

Click the Cancel button to discard your settings. The OpenScape Configuration 
settings dialog is closed.

NOTICE:  Configuration modifications require a IBM Lotus Notes 
restart to take effect.

8.6.1  Configuring the Network

The configuration settings for connecting the OpenScape server.

In the Network dialog, you can modify the initial setting data for your user access 
and the connection to the OpenScape server or enter this data if you have not 
performed this settings in the Initial Configuration dialog yet.
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You reach the configuration dialogs in IBM Lotus Notes via the calendar dialog 
menu bar. Push the Configuration button to open the configuration dialogs.

NOTICE:  Alternatively, you can reach the configuration dialogs 
via the OpenScape button when you are already in the 
New Calendar Entry dialog. In the OpenScape menu, select 
Configuration. 

In the configuration dialog, switch to the Network tab.

In the OpenScape Server - Network access section you need to make the 
following entries for logging on to your OpenScape user account:

• OpenScape User ID
Specify your user ID in the format <user-ID@domain>.

• OpenScape Password
Enter the password you use to log on to the OpenScape server.

In the OpenScape Server - Network configuration section, the following entries 
are required for connecting the OpenScape server from your workstation:

• OpenScape Server - Host Address
Enter here the complete network address (URL) of the OpenScape server.

• OpenScape Server - Port
Enter here the port via which the connection to the OpenScape server is 
configured.

NOTICE:  If you do not know the Logon or connection data, 
please contact your system administrator.
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8.6.2  Audio / Video Conference Configuration

Configuration of the audio / video conference default settings.

In the Audio /Video Conference dialog you can perform default settings for your 
audio conferences and schedule a video conference.

You reach the configuration dialogs in IBM Lotus Notes via the calendar dialog 
menu bar. Push the Configuration button to open the configuration dialogs.

NOTICE:  Alternatively, you can reach the configuration dialogs 
via the OpenScape button when you are already in the 
New Calendar Entry dialog. In the OpenScape menu, select 
Configuration. 

In the configuration dialog, switch to the Audio / Video conference tab.

The Audio conference section provides the following configuration options:

• Record name
If you select this option, each conference participant is requested to specify 
his/her name before joining the conference. Only after recording their name, 
they can join the conference.

• Moderated conference
Use this option to determine whether to configure moderated or open confer-
ences as default.

NOTICE:  Only the moderator can start and control moderated 
conferences.
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• Call direction
Select the corresponding option to define whether the conference participants 
are called by the system or have to dial into the conference by themselves 

.

– If you have configured that the conference participants will be called by 
the system, the conference will start automatically when the start time is 
reached. Then, all conference participants are called by the system. At 
the same time, the web conference, if configured, will also start.

NOTICE:  The web conference start must be confirmed by the 
moderator or the conference creator.

– If you have configured that the conference participants need to dial into 
the conference by themselves, the conference is started when the first 
conference participant has dialed in via the bridge number and the 
conference PIN. As long as this conference participant is the only one, he/
she hears music-on-hold. When the next conference participant joins the 
conference, the conference will be opened.

NOTICE:  After you have dialed in or received the conference call, 
the system prompts you to join the conference. Click on to 
join the conference or on to reject to take part in the 
conference.

In the Video conference section, you can activate the checkbox Add video 
conference to configure the audio conference so that your conferences are 
always prepared for a video conference.

8.6.3  Configuring Web Conferences

Configuration of the web conference default settings.

You can default set your web conferences in the Web Conference dialog.

You reach the configuration dialogs in IBM Lotus Notes via the calendar dialog 
menu bar. Push the Configuration button there to open the configuration dialogs.

NOTICE:  Alternatively, you can reach the configuration dialogs 
via the OpenScape button when you are already in the 
New Calendar Entry dialog. In the OpenScape menu, select 
Configuration. 
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In the configuration dialog, switch to the Web conference tab.

The top section under Web conference provider access data shows the 
properties of the web conference connections used. Additional tabs indicate that 
several web conference providers are available. Each tab represents one web 
conference provider.

In the bottom section under Web conference default settings you can use the 
Add web conference option to set that a web conference is automatically 
created with each conference you configure. The Preferred web conference 
provider combo box serves for selecting the desired web conference provider if 
several are available.

8.6.4  Configuring the Presence Status

Configuring the presence synchronization.

Use the Presence dialog to perform the settings that update your presence state 
on the OpenScape server. 

You reach the configuration dialogs in IBM Lotus Notes via the calendar dialog 
menu bar. Push the Configuration button to open the configuration dialogs.

NOTICE:  Alternatively, you can reach the configuration dialogs 
via the OpenScape button when you are already in the 
New Calendar Entry dialog. In the OpenScape menu, select 
Configuration. 
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In the configuration dialog, switch to the Presence tab.

The Presence configuration section provides the following configuration 
options:

• Use presence synchronisation
When you select this option, the OpenScape presence status is automatically 
synchronized with your calendar data and your presence setting from the IBM 
Lotus Notes client. In your IBM Lotus Notes client, you can choose between 
the following presence settings:

– Free
Select this presence status if during the appointment or the meeting, the 
presence status shall be set to Present.

– Tentative
Select this presence status if during the appointment or the meeting, the 
presence status set before shall be kept.

– Busy
Select this presence status if during the appointment or the meeting, the 
presence status shall be set to Busy.

– Out of office
Select this presence status if during the appointment or the meeting, the 
presence status shall be set to Out of office.

You reach the presence settings by pushing the OpenScape button, 
which you find in the New Calendar Entry dialog. In there, select the 
Presence status menu option for defining the presence settings for an 
appointment or a meeting.
The presence status synchronization triggers the following operational 
behavior: 

– Independently of the presence status set before, your presence status 
changes automatically to the "In Meeting" status when an appointment 
begins. This setting will be kept for the duration of the appointment or 
meeting.
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– If a IBM Lotus Notes user answers a meeting request with "Tentative", his/
her presence state set before will be kept.

– At the end of the appointment or the meeting, the status "In Meeting" will 
change back to the status set before.

– If a user changes his/her status during an appointment or a meeting, e. g. 
by using another client application, the status is not synchronized. This 
presence status set manually will then apply to this user and be displayed.

• Update time in seconds
Click in the field in order to change the default time (60 seconds). Enter a new 
value for the synchronization time. Recommended values are 60 (1 minute), 
600 (10 minutes), 900 (15 minutes) or 1800 (30 minutes) in order to achieve 
an ideal synchronization depending on the concentration of appointments.

8.6.5  Configuring the User Interface

Configuring the user interface.

Use the User interface dialog to perform the settings for the conference user 
interface.

You reach the configuration dialogs in IBM Lotus Notes via the calendar dialog 
menu bar. Push the Configuration button to open the configuration dialogs.

NOTICE:  Alternatively, you can reach the configuration dialogs 
via the OpenScape button when you are already in the 
New Calendar Entry dialog. In the OpenScape menu, select 
Configuration. 
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In the configuration dialog, switch to the User Interface tab.

The Conference user interface section provides the following operating options:

• Use default conferencing options
Select this option to skip the settings dialog which is normally opened for the 
individual configuration of your conferences when you push the Add 
OpenScape conference button. That means that all conferences to be 
created are configured with the default settings that you defined before on the 
configuration pages.

NOTICE:  You cannot change the configuration settings of an 
added conference retrospectively.

The Invitation text section provides the following configuration option:

• Language
In the Language combo box, select the language in which the invitation text 
will be sent to the conference participants via the meeting request. From the 
available languages, select the one you need as default setting for your 
conference invitations. By default, the invitation text first uses the language in 
which your IBM Lotus Notes client has been installed.

8.7  Configuring, Editing and Controlling Conferences

Operating options for the OpenScape Extensions for Lotus Notes.

After you have installed the OpenScape Extensions for Lotus Notes you can use 
the following operating options:
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• Configuring conferences.
You can schedule meet-me conferences via the calendar of your IBM Lotus 
Notes client. Depending on the system environment, you can choose 
between the following conference types:

– Audio conferences

– Web conferences

– Video conferences

• Editing conferences.
This comprises:

– Changing conference data before sending the conference invitation.

– Changing conference data after sending the conference invitation.

– Starting audio conferences.

– Starting web conferences.

• Controlling conferences.
You can control an active audio conference via:

– The keypad of your telephone

– The call control of your OpenScape Desktop Client Enterprise Web 
Embedded Edition or your OpenScape Web Client.

• Deleting conferences.
You can delete your configured conferences from your IBM Lotus Notes 
calendar anytime.

NOTICE:  When deleting conferences, verify that no "orphaned" 
conferences remain. "Orphaned" conferences are conferences to 
which no appointments are assigned anymore after they have 
been deleted from the IBM Lotus Notes calendar. How to delete 
conferences correctly describes section Deleting Conferences.

8.7.1  How to Configure a Conference

Configuring a conference via the IBM Lotus Notes calendar.

How to configure a conference:

Step by Step 1. Start your IBM Lotus Notes client.

2. Open your IBM Lotus Notes mailbox.

3. Click on the Mail button.

4. In the menu, select Switch to calendar.
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The calendar dialog opens.

5. Click on the Schedule a meeting button.
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The New Calendar Entry for... dialog box opens.

6. Specify a meeting subject in the corresponding input line.

NOTICE:  The subject describes the conference. Under this 
description the conference will be logged in the message respec-
tively conference journal.

7. Use the Starts and Ends combo boxes to schedule the conference.

8. If required, select a deviating time zone via the Specify a different time zone 
option.

9. If required, configure if you would like to create a recurrent conference. To 
this, select the Repeats option. The Repeat Options dialog opens. Enter the 
corresponding data for the repetition frequency.
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10. In the Invitees input line, enter all conference participants.

NOTICE:  Via the button to the right of the input line, you can 
browse the IBM Lotus Notes address books or your contact lists 
for participants and select them there.

11. Click on the AddOpenScape Conference button:

Depending on your configuration settings the OpenScape Conference 
dialog opens, or the conference data are immediately displayed in the bottom 
section of the dialog.

NOTICE:  This dialog opens during the creation of a conference 
only if you have not selected the Use default conference 
options option while performing configurations on the User 
Interface tab.

12. Select the following options in the Audio Conference section:

• Record name

Leave this option activated if you wish to have the names of the 
conference participants recorded, or deactivate it otherwise.

NOTICE:  If this checkbox is active, the conference participants 
need to specify their names before they can take part in the 
conference.
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• Moderated conference/open conference

Leave this checkbox activated if you wish to have a moderated 
conference. Deactivate this option if you wish to have an open 
conference.

A moderated conference requires the presence of a moderator. As long 
as the moderator is not in the conference, the other conference partici-
pants hear music-on-hold until the moderator join the conference.

The moderator of a moderated conference has more options to control the 
conference than the other participants of the moderated conference.

In case of an open conference the conference starts as soon as the first 
conference participant is in the conference. The conference now takes 
place with the participants who successively dial in.

In an open conference, all conference participants have the same options 
to control the conference.

• Call direction

Select the corresponding option to define whether the conference partic-
ipants are called by the system or have to dial into the conference by 
themselves .

13. Select the following options in the Web Conference section:

• Add web conference

Set this radio button if you want to create a web conference and an audio 
conference simultaneously.

• Preferred web conference provider

If several providers are available, you can select the conference provider 
from this combo box.

14. In the Invitation text section, select via the Language combo box the 
language for the invitation text. In this language, the invitation text will be sent 
to all conference participants via the meeting request.

15. In the Video conference section, select whether you would like to configure 
additionally a video conference.

The invitation text contains the additional information "* This conference 
supports video.".

16. Click on OK after having made your selection.
 A31003-S5070-U101-3-7619, 06/2012
172 OpenScape UC Application V7 Client Applications, User Guide



OpenScape Extensions for Lotus Notes
Configuring, Editing and Controlling Conferences
The dialog is closed and the conference data is displayed in the bottom 
section of the dialog.

The conference access data are in detail:

In the Voice section:

The bridge number(s) the conference participants require to log on to the 
conference and the conference PIN that the conference participants use to 
authenticate themselves.

In the WEB section:

Two links for opening the required web conference client:

You can use the first link for downloading a separate stand-alone client for the 
web conferencing session.

The second link enables loading a web-based client for the web conference.

17. In the dialog, push the Save and Send Invitations button.

The meeting request is sent do the addressed system users and the New 
Calendar Entry dialog is closed. All required information such as conference 
access data, meeting time and subject is delivered to the selected 
participants and entered in their IBM Lotus Notes calendar as appointment.

When the conference is created, the conference is entered with its data in the 
conference list of each OpenScape conference participant in all OpenScape 
clients at the same time.

NOTICE:  Bear in mind that you must communicate the 
conference information to external conference participants 
(participants without OpenScape user account) via a separate e-
mail or other means of communication.

8.7.2  Editing the Conference before Sending the Conference Data

Editing a configured conference before sending the meeting request.

You have configured a conference by selecting the relevant participants, the 
subject and the conference time and by clicking on the  Add OpenScape 
Conference button.

After you have carried out these actions, the New Calendar Entry dialog displays 
the two buttons for editing the conference:

•  Delete OpenScape Conference
Deletes the configured conference from your own conference list and from the 
conference lists of the invited participants.
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•  Join conference
Using this option you can join the conference.

NOTICE:  If a web conference has been configured additionally, 
the Start Web Conference button will be activated after the 
OpenScape conference has started. Push this button to start the 
web conference from the Outlook calendar dialog.

8.7.3  Editing the Conference after Sending the Conference Data

Editing a configured conference after sending the meeting request.

After you have sent the conference data, the conference date is entered in your 
IBM Lotus Notes calendar. You can reopen the conference data for editing by 
opening in IBM Lotus Notes the calendar and doubleclicking the conference 
calendar-entry.

The two buttons for editing the conference are now available:

•  Delete OpenScape Conference
Deletes the configured conference from your own conference list and from the 
conference lists of the invited participants.

NOTICE:  The sent conference notifications are not deleted.

•  Join conference
Using this option you can join the conference.

NOTICE:  If a web conference has been configured additionally, 
the Start Web Conference button will be activated after the 
OpenScape conference has started. Push this button to start the 
web conference from the Outlook calendar dialog.

8.7.4  How to Invite Further Participants to a Conference that is already 
Started

Expand conference after the start with further participants.

After the start of a conference the moderator (in case of moderated conferences) 
or one of the other conference participants (in case of an open conference) can 
invite further participants to the current conference. 

Step by Step 1. Open the respective calendar entry for this conference.

2. Add the additional participant(s) by modifying the originator's address line or 
a selection in an address book.
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3. Click on the Save and Send Invitations buttons.

The Meeting  dialog closes. The additionally invited conference participants are 
directly called by the system and receive an e-mail invitation. This e-mail contains 
all data that has been configured for the original conference invitation, i.e. also the 
links for a possibly configured web conference.

8.7.5  Deleting Conferences

Deleting conferences created via OpenScape Extensions for Lotus Notes.

To delete conferences, you must take one of the actions proposed below to avoid 
that "orphaned" conferences are displayed in the OpenScape Desktop Client 
Enterprise Web Embedded Edition or the OpenScape Web Client conference 
lists. "Orphaned" conferences are conferences to which no appointments are 
assigned any more after being deleted from the IBM Lotus Notes calendar.

"Orphaned" conferences in the OpenScape Desktop Client Enterprise Web 
Embedded Edition or the OpenScape Web Client may result, for example, from 
the following delete actions: 

• Deleting a conference entry from the IBM Lotus Notes calendar main view. 

• Deleting the conference entry via the calendar access of your mobile device.

To delete the conference created via the OpenScape Extensions for Lotus Notes 
without leaving "orphaned" conference entries in the OpenScape Desktop Client 
Enterprise Web Embedded Edition or the OpenScape Web Client, you must first 
open the corresponding conference entry with a doubleclick. After this, you have 
two options to delete the conference entry successfully:

• You can delete the conference via the opened conference entry by pushing 
the  DeleteOpenScape Conference button.

• Deleting the conference via the opened conference entry using the deletion 
functions in IBM Lotus Notes (menu Tools/Actions > Delete/Cancel).

8.7.6  Starting the Audio Conference

Start-up behavior of the audio conference.

An audio conference starts in most cases automatically when the start time has 
been reached (scheduled conferencing). However, in case of a moderated 
conference the moderator can start it manually beforehand. If the audio 
conference is an open one, it can also be started manually or by any conference 
participant dialing in. Depending on your conference configuration, the server 
triggers the following functions at the conference start:

• The system calls all conference participants.

• All conference participants need to dial into the conference by 
themselves.

The conference participants are called by the system 
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 175



OpenScape Extensions for Lotus Notes
Configuring, Editing and Controlling Conferences
If you have configured that the conference participants will be called by the 
system, the conference will start automatically when the start time is reached. 
Then, all conference participants are called by the system. If the moderator has 
started the conference beforehand, all conference participants are called at this 
time.

The conference participants dial into the conference by themselves 

If you have configured that the conference participants need to dial into the 
conference by themselves, the conference starts automatically when the start 
time is reached. The conference participants can then dial into the conference. If 
another conference participant has started the conference beforehand (manually 
or by dialing in), he/she hears music-on-hold as long as he/she is the only partic-
ipant. When the next conference participant joins the conference, the conference 
will be opened.

NOTICE:  After you have dialed in or received the conference call, 
the system prompts you to join the conference. Click on  to 
join the conference or on  to refuse taking part in the 
conference.

8.7.7  How to Dial into an Audio Conference

Joining an audio conference.

How to dial into the conference:

Step by Step 1. Open the meeting entry of the relevant conference in the IBM Lotus Notes 
calendar.

2. Dial into the conference under the Bridge Number specified here when the 
conference start is due.

3. Enter the Conference PIN via telephone when the system prompts you to do 
so. This identifies you as authorized conference participant.

You have now joined the conference.

8.7.7.1  Controlling a Voice Conference via Call Control

Controlling a voice conference via the "Call Control" function dialog.

Depending whether you are moderator, creator or participant of an open 
conference, the following functions are available for controlling an active 
conference in the Call Control feature window:

In the header
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•  Lock conference
In case of moderated conferences this feature is available to moderators only. 
In open conferences, every conference participant can trigger this feature. 
This option blocks the conference for other subscribers who want to join in. 
After you have clicked on the icon it changes to  .

•  Unlock conference
Releases the conference locking. After you have clicked on the icon it 
changes to  .

•  Mute conference
In case of moderated conferences this feature is available to moderators only. 
In open conferences, every conference participant can trigger this feature. It 
interrupts the sound transmission to all conference participants. After you 
have clicked on the icon it changes to  .

•  Unmute conference
This feature is only available for participants with moderator or creator privi-
leges. It cancels the conference muting.

•  Start web conference
If you have configured a web conference or were invited for a web 
conference, you can use this icon to set up the connection to the web 
conference.

•  End conference
This feature is only available for participants with moderator or creator privi-
leges. It ends the conference by closing down the connections to the other 
conference participants.

During the connection representation of the conference participants

NOTICE:  The connection representation shows all participants 
who are currently in the conference. In a moderated conference, 
the moderator is indicated by a dot that precedes his/her name 
entry. The name of the conference participant who is currently 
active (thus talking) is highlighted in boldface.

•  Change device and resume active call
This feature allows every conference participant to hand his/her conference 
connection over to another device and continue taking part in the conference 
from there.

•  Mute participant
It interrupts the sound transmission for a conference participant. After you 
have clicked on the icon it changes to  . 

•  Unmute participant 
It undoes muting a conference participant.

•  Leave conference

– Moderated Meet Me conference
The conference moderator or creator can use this option to leave the 
conference or to disconnect single conference participants from the 
conference.
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– Open Meet Me conference
Enables every participant to leave the active conference.

– Ad-hoc/MeetNow! Conference
Enables every participant to leave the active conference. As soon as all 
participants have exited the Ad-hoc- or the MeetNow! conference, the 
conference ends.

NOTICE:  After you have left the conference via the  icon and 
wish to join in again after a short period, you need to dial into the 
desired conference again and also specify the conference PIN.

If the Call Control dialog has been opened via the URL in the conference 
notification e-mail, the following information and functions depending on the 
system environment can be provided:

– The name of the currently active speaker is highlighted.

– Conference PIN Display

– Option to join an active web conference  .

– Display of the conference participants who are actually in the conference.

– Display of the participants who have not joined the conference yet.

NOTICE:  If you are on the road and do not take part in a 
conference with your office phone (ONS) but e.g. with your cell 
phone, the connection may be affected by various factors or even 
aborted. In case of a disconnection you have not initiated yourself, 
you can dial into the active conference again after a short, pre-
defined period. When the connection to the conference server is 
up again, you are prompted by greeting to push a specific, pre-
defined telephone key. By pushing this key you can instantly join 
the active conference without having to enter the conference PIN 
once more.

Via the Call Control dialog the moderator (in case of a moderated 
conference) or one of the other conference participants (in case of an open 
conference) can add further OpenScape UC Application or external partici-
pants:

NOTICE:  If you expand a conference that has been created in 
Microsoft Outlook via the call control, no e-mail invitation is sent 
to the new participant. He/she will not receive a link to join a web 
conference that may have been configured.. If this participant is to 
receive the link to join the web conference, you need to send this 
link via e-mail.

– OpenScape UC Application users
For example, you can enter the name of the desired OpenScape 
UC Application participant in the New Call combo box and subsequently 
click on   to search all configured directories for the desired contact.
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– External users
You can add an external user to the conference by entering his/her phone 
number in the New Call combo box and enabling the green receiver. This 
participant will be directly called by the conference system. He/she will not 
receive a conference notification e-mail because the conference system 
does not know his/her e-mail address.

NOTICE:  For adding external participants we recommend using 
the Add participant dialog as it allows specifying an e-mail 
address for the desired participant. You reach this dialog with a 
click on  in the Modify conference dialog.

8.7.7.2  Controlling a Conference via Telephone

Controlling a conference via telephone

As OpenScape UC Application user you can control an active conference also via 
the keys of your configured preferred device. The telephone keys are used for 
transmitting control commands to the system by sending DTMF tones.

NOTICE:  The administrator can deactivate the operating menu 
by configuration. Furthermore, he/she can change the 
assignment of commands to the single keys. The default setting 
for having the menu functions put out by announcement is 
   . In case of doubt please contact your administrator.

Activating the Control Menu

You control a conference by entering two key commands on the keypad of your 
phone. This prevents conference disruptions by a telephone key being pushed 
inadvertently.

NOTICE:  The administrator can change the telephone key/
command assignment. The following description refers to the 
system default setting.

Control Commands

You can use the following key commands for controlling a conference:

•  Play menu
The available menu options are announced to you.

•   Lock/unlock conference.
This feature is only available for participants with moderator or creator privi-
leges. Once the conference has been locked, no further participants may dial 
in. Pushing this key once more undoes the restriction.
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•   Activate/lift muting.
Via this key you can temporarily deactivate the microphone of your telephone. 
The conference connection is maintained. Pushing this key once more reacti-
vates the microphone.

•   Activate/lift conference muting.
This feature is only available for participants with moderator or creator privi-
leges. This feature mutes all microphones of the conference participants. 
Only the voice signal of the conference participant who triggers this function 
is still transmitted to all conference participants.

•   Initiate device handover.
This function allows you to change the device you use in the conference. After 
you have pushed this key, enter the phone number of the device you want to 
switch to. You need to complete the phone number entry with the  pound 
key. For further proceedings, please follow the voice prompts.

•   Turn off music-on-hold.
If you currently are the only conference participant and hear music-on-hold, 
you can push this key to switch off the music. Pushing this key once more 
reactivates the music-on-hold.

8.7.8  Starting a Video Conference Connection

How to set up a video conference connection.

With the corresponding requirements met, you can extend an audio conference 
to a video conference. Requirements are e.g. server licenses and video-
compatible devices or clients.

When you select the Add Video Conference option upon configuring the 
conference, the video dialog opens automatically at the conference start. The 
user only needs to release sending his/her own video image for starting the video 
streaming. When the conversational partners release their video streaming, too, 
all conference participants can see each other.

The bottom left area of the video screens displays the participant name respec-
tively participant number. In case of a moderated conference, the video screen 
features the moderator icon  , which precedes the moderator's text entry.

The video screen of the currently active speaker is highlighted by a colored frame. 
In addition, the participant name or number of the active speaker appears in 
boldface.

NOTICE:  Users who take part in the conference via a pure voice 
connection see a text field in the video dialog when they are 
currently active as speaker. This text field displays the participant 
name or number of this user.
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8.7.9  Starting/Joining a Web Conference

Starting a web conference.

If you have configured an additional web conference, there are two ways of 
starting such a conference depending on how the call behavior after the 
conference start is configured:

• The conference participants are called by the system.

• The conference participants need to dial into the conference by 
themselves.

The conference participants are called by the system 

If you have configured that the conference participants will be called by the 
system, the web conference will start automatically when the conference starts. 
The moderator or conference creator only has to confirm the web conference start 
in a popup window. The web conference participants can then join the web 
conference.

The conference participants need to dial in by themselves 

If you have configured that the conference participants need to dial into the 
conference by themselves, the web conference must be started manually. This 
can be done in two ways:

• Via IBM Lotus Notes:

– Push the   Start Web Conference icon if you are the moderator of the 
conference or the person who created the conference. This starts the web 
conference.

•  Via the OpenScape Web Client or OpenScape Desktop Client Enterprise 
Web Embedded Edition:

– In the call control already open for the active audio conference, click on 
the   Start Web Conference icon if you are the moderator of the 
conference or the person who created the conference. This starts the web 
conference.

NOTICE:  Operating the web conference client is described in the 
OpenScape Web Collaboration V1 manual.

Joining a web conference

How to join the web conference after it has been started:

• Via IBM Lotus Notes:

– Click on one of the two links for using either the separate stand-alone 
client or the web-based one.
Open the meeting entry of the relevant conference in the IBM Lotus Notes 
calendar and click on the corresponding link. The web conference client 
starts.

• Via the OpenScape Web Client or OpenScape Desktop Client Enterprise 
Web Embedded Edition:
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– In the call control already open for the active audio conference click on the 
  Start Web Conference icon. This downloads the web conference 
client for the web conference.
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9  OpenScape Desktop Integration

General Description of the OpenScape Desktop Integration

Using the information on the DesktopIntegration tab from the General Settings 
menu of the OpenScape Web Client you can install a small program on your 
workstation that allows calling a subscriber from any application.

An example: A Word document you have opened contains a phone number. 
Select this phone number in the text and enable the hotkey you have defined for 
this purpose. A call to this number is immediately initiated.

Furthermore, incoming calls and instant messages are signalled via the 
OpenScape Desktop Integrationapplication even if the OpenScape Web Client 
screen is closed.

In the OpenScape Desktop Integration application you can set further options for 
the startup behavior, the OpenScape Web Client display and the notification 
options.

NOTICE:  To use this application program the OpenScape Web 
Client need not be started.

9.1  Application Requirements

Application requirements for the OpenScape Desktop Integration.

Please note the following requirements for using the OpenScape Desktop 
Integration:

• You can use the OpenScape Desktop Integration with a Microsoft operating 
system only.

• If you wish to use the OpenScape Desktop Integration, be sure to download 
the application via the OpenScape Web Client URL that you use for the 
OpenScape Web Client by default.

• Since incoming calls and instant messages are signalled via the OpenScape 
Desktop Integration, a firewall used on your workstation must be configured 
accordingly. 
The ports to be released are:

– For http:// -> Port 7789 TCP 

– For https:// -> Port 8443 TCP

Please heed the following requirements for the TSP extension, which you can 
install via the context menu of the OpenScape DesktopIntegration under Settings 
> Options:

• The TSP of the OpenScape DesktopIntegration is a pure 32-bit application. In 
case of an installation on a 64-bit operating system this extension will not 
work.
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• You need administrator privileges for setting up the TSP on Windows Vista 
and Windows 7.

NOTICE:  TSP support enables direct calling from selected e-
mails or address book entries in Microsoft Outlook. The 
associated contacts need to have been assigned a phone number 
for this purpose.

9.2  How to Install the OpenScape Desktop Integration

Installing the OpenScape Desktop Integration.

The following steps are required for using the OpenScape Desktop Integration:

Step by Step 1. Start the OpenScape Web Client.

2. Open the DesktopIntegration tab. You reach this settings dialog via menu -
> General -> Common -> DesktopIntegration tab.

3. If a 64-bit operating system is installed at your workstation, click the 
Download or Download (x64) button on the DesktopIntegration tab.

The file-download dialog opens.

4. Enable here the Save button.

The file-selection dialog for storing files opens.
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5. Save the OSCwebDI.exe file on the desktop or in any directory.

6. Using the Explorer, open the desktop or the directory in which you have saved 
the application. Doubleclick OSCwebDI.exe. 

The application starts.

After the start the task bar features the  icon.

7. Rightclick the icon in the task bar to invoke the features of this application and 
the setting pages for the OpenScape Desktop Integration.

9.3  Configuring the OpenScape Desktop Integration

Configuring the OpenScape Desktop Integration.

You use the context menu function Settings to open the settings dialog for config-
uring the program OpenScape Desktop Integration.

The following settings dialogs are available for this purpose:

• Hotkey

On the Hotkey tab you determine the key command that triggers the feature 
of calling the phone number saved to the clipboard.
Click in the entry field and enable the desired <F-key> or <Ctrl + F-key>. The 
function key that triggers the dial process is displayed in the input field.

NOTICE:  To delete the function key, click in the input field and 
enable the Backspace key.
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• Start

On the Startup tab you define the startup behavior of the OpenScape 
Desktop Integration program. The following startup options are available 
individually or in combination:

– Open window at startup
Selecting this option you determine that the OpenScape Web Client 
automatically starts when the OpenScape Desktop Integration program is 
booted.

– Starting this application at login
Select this option to define that the OpenScape Desktop Integration 
program is started when you log on to your operating system.

– Add entry to start menu
You select this option to determine that an entry is created in the start 
menu of your user account when the application starts. Subsequently, the 
application is started automatically each time you log on to the system.

• Appearance

On the Appearance tab you determine the representation mode for the 
OpenScape Web Client window. The following options are available:
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– Keep windows always on top
When you select this option, the OpenScape Web Client window will 
always appear as the topmost application.

– Dialogs of the main window stay on top of it
This setting determines whether newly opened dialog windows can be 
covered by the main window.

– Open window for dialing
This setting opens the user interface (OpenScape Web Client and/or 
OpenScape Desktop Client Enterprise Web Embedded Edition), if a 
number is dialed via the hotkey function.

– Compact view
This setting opens the compact view of the user interface with the call 
control if a number is dialed via the hotkey feature.

– Positioning the OpenScape Web Client on the screen:
Open window at screen top.
Open window at screen bottom.
Open window at screen left.
Open window at screen right.

• Options

On the Options tab you can perform the following settings:

– Enable notifications
Via this checkbox you can deactivate the notifications that are always 
active by default. 
The following notifications are active by default:
Enable notification on incoming call
When a call comes in, you are informed by a flash on the desktop.
Enable notification on new instant message
When an instant message comes in, you are informed by a flash on the 
desktop.
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 187



OpenScape Desktop Integration
Configuring the OpenScape Desktop Integration
– Select this option to install/update TSP (Telephony Service Provider) 
for dialing from TAPI-Applications . Using this application you can 
directly call a subscriber from Microsoft Outlook via journal entries. Select 
the corresponding journal entry and select from the Microsoft Outlook 
menu Actions > Call contact.

NOTICE:  The journal entry must reference a phone number via 
the database for this purpose.

After clicking the TSP button you can update this service provider 
manually or install it when required.

– Show presence information in the notification area
After selecting this option your presence information will be displayed in 
the notification area. Then can then also directly change your presence 
status in the notification area.

– Enable dialing from HTML pages
Selecting this option releases the feature to dial a phone number from a 
specially prepared HTML page.
The phone number must have been integrated via an html command 
according to the following pattern:
<a href="clicktodial:<phone number>"><htmldisplay></
a>
Example:
To integrate the phone number “123456789” via the “Sales” link in an 
HTML page, you need to enter the following command line in the source 
code in the position where the link is to appear:
<a href="clicktodial:123456789">Sales</a>
The "Sales" link is embedded in the HTML page for directly dialing the 
phone number "123456789".

• Language

Select one of the defaulted languages to set it for menus and info texts. The 
following languages are currently available: English, German, French, 
Spanish, Italian, Portuguese, Brazilian Portuguese, Chinese, Dutch, Turkish 
and Russian.
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• About

On this tab you see the version number of the currently installed version of the 
OpenScape Desktop Integration program.

9.4  Operating the OpenScape Desktop Integration

Operating the OpenScape Desktop Integration.

The following features are available in the context menu for the OpenScape 
Desktop Integration:

•  Dial: <abcxyz>
The feature enables dialing the digit string you have copied to the clipboard 
as phone number.

•  Open
Enables opening the OpenScape Web Clientin an individual browser window.

•  Disable hotkeys
A click on this icon disables the hotkey feature even if the application is 
started.

•  Exit
A click on this icon closes the DesktopIntegration program.

•  Options
Opens the settings dialog for configuring the OpenScape Desktop Integration 
program.
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10  OpenScape Click-to-Dial-Browser-Plug-in

Calling with the OpenScape Click-to-Dial-Browser-Plug-in directly from HTML 
Pages.

The OpenScape Click-to-Dial-Browser-Plug-in is a program which allows to dial 
directly a phone number displayed on any HTML page by clicking this number in 
the web browser. Dialable phone numbers are highlighted on the HTML pages 
and displayed with the flag of the country corresponding to their country code.

The installation of the application can be accomplished in several ways: 

• Via the OpenScape Web Client.
The installation file stored on the server is downloaded and installed manually. 
You can find the download button in the OpenScape Web Client under menu 
> General > Common > Browser Integration tab.

• Via the OpenScape Desktop Client Enterprise Web Embedded Edition.
During the OpenScape Desktop Client Enterprise Web Embedded Edition 
installation, the OpenScape Click-to-Dial-Browser-Plug-in is also installed 
automatically.

NOTICE:  If the OpenScape Click-to-Dial-Browser-Plug-in has 
been installed via the OpenScape Desktop Client Enterprise Web 
Embedded Edition, it is initially inactive by default. Before using 
this feature, the user has to activate the application first. See the 
Configuration paragraph of this chapter.

• Via the program OpenScape Client Integrations.
This installation program allows you to use OpenScape Click-to-Dial-
Browser-Plug-in without installing another CTI client like the OpenScape 
Desktop Client Enterprise Web Embedded Edition or the OpenScape Web 
Client. You find more detailed information on this installation program in 
chapter OpenScape Client Integrations of this manual.

10.1  OpenScape Click-to-Dial-Browser-Plug-in

OpenScape Click-to-Dial-Browser-Plug-in features.

Using the OpenScape Click-to-Dial-Browser-Plug-ins you can select a phone 
number contained on any HTML page and directly initiate a call to this number.

The following browsers support this function:

• Internet Explorer Integration 
Provides the call functionality in the Microsoft Internet Explorer.

• Mozilla Firefox Integration
Enables calling by mouseclick via your Mozilla Firefox web browser.
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10.2  Requirements for Using the OpenScape Click-to-Dial-Browser-Plug-in

Requirements for using the OpenScape Click-to-Dial-Browser-Plug-in.

Only specific operating systems and browser versions support this browser plug-
in.

You find current and detailed information about the supported clients and their 
versions in the OpenScape UC Application Planning Guide manual.

10.3  Setting up the OpenScape Click-to-Dial-Browser-Plug-in

General information about setting up the OpenScape Click-to-Dial-Browser-Plug-
in.

NOTICE:  This section contains information that exclusively apply 
for setting up the OpenScape Click-to-Dial-Browser-Plug-in via 
the OpenScape Web Client. If you wish to use the plug-in in 
combination with the OpenScape Desktop Client Enterprise Web 
Embedded Edition, it is included in the OpenScape Desktop 
Client Enterprise Web Embedded Edition setup.

The system administrator or any user who has administrative privileges on a 
computer can install the OpenScape Click-to-Dial-Browser-Plug-in. The 
OpenScape Click-to-Dial-Browser-Plug-in is then installed for all users who also 
deploy this computer. 

NOTICE:  The OpenScape Click-to-Dial-Browser-Plug-in is 
automatically initialized and activated with the first invocation of 
the web browser.

The following three files are available for setting up the OpenScape Click-to-Dial-
Browser-Plug-in:

• BrowserIntegration.msi
Installs the OpenScape Click-to-Dial-Browser-Plug-in for the desired web 
browser - Internet Explorer or Mozilla Firefox.

• InstallBrowserIntegration.exe
Executes the BrowserIntegration.msi file. The configuration paramters 
specified in the config.ini file are used in this process. Via this file you also 
change the setup, perform updates and start the OpenScape Click-to-Dial-
Browser-Plug-in uninstallation.

• config.ini
In this file you can enter the following configuration parameters that are trans-
ferred to the BrowserIntegration.msi setup file by executing the file 
InstallBrowserIntegration.exe during the installation.
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– WebClientAddress
This parameter defines the URL of the OpenScape Web Client and 
optionally the port used. For example:
http://10.1.2.130:8443
or
https://oswebclient.siemens-enterprise.com

– CommandLine
At this point you can enter command line parameters that influence the 
setup. For example, /qn indicates that the installation is to be performed 
automatically, i. e. without user entries and setup dialogs. This setup type 
requires the mandatory definition of the OpenScape Web Client system 
URL in the config.ini file. Both features, Internet Explorer Integration 
and Mozilla Firefox Integration, are installed and can be deployed by all 
users of the system.

NOTICE:  The Firefox Integration feature is only installed when 
the Mozilla Firefox web browser is installed on the system.

NOTICE:  Modify the config.ini file only by following your 
system administrator's instructions.

10.3.1  How to Perform the Default Setup

Default setup of the OpenScape Click-to-Dial-Browser-Plug-in.

IMPORTANT:  Setting up OpenScape Desktop Client Enterprise 
Web Embedded Edition with OpenScape Click-to-Dial-Browser-
Plug-in and the default installation described in the following are 
mutually exclusive. The default setup ends with a corresponding 
message, if the OpenScape Desktop Client Enterprise Web 
Embedded Edition has already been installed with integrated 
OpenScape Click-to-Dial-Browser-Plug-in on the system.

NOTICE:  The setup dialogs are displayed in English.

To perform the setup, proceed as follows:

Step by Step 1. Close the web browser currently used (Internet Explorer or Mozilla Firefox).

2. Start the InstallBrowserIntegration.exe file.
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The welcome dialog of the setup wizard opens.

3. Click on Next to initiate the setup process. 

The following dialog appears:

4. Enter your and your organization's name. Then click on Next.
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The dialog that follows lists the features to be installed.

5. Determine whether the Firefox Integration feature is to be installed as well.

NOTICE:  The IE Integration is always installed by available.

NOTICE:  The Firefox Integration feature is only available for 
selection if the Mozilla Firefox web browser is installed on the 
system.

Click on the  icon to the left of the Firefox Integration feature to display 
the following menu:

– Will be installed on local drive.
Select this option to install the Firefox Integration on the local computer.

– Entire feature will be installed on local hard drive.
Select this option if both features are to be installed.
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 195



OpenScape Click-to-Dial-Browser-Plug-in
Setting up the OpenScape Click-to-Dial-Browser-Plug-in
– Entire feature will be unavailable.
Select this option if you do not want the Firefox Integration feature be 
installed on the local computer.

6. Click on Next >.

The following dialog pops up:

7. Enter the OpenScape Web Client URL.

The specified URL is checked via the Check server address button.

The correct URL is confirmed with a success message.

Click on OK to close this message and to continue the setup process.

If the URL is incorrect, a message points to the invalidity of this URL.

Click on OK. The message window closes. You can now correct the URL and 
continue the setup process.

8. Then click on Next. The setup process starts. A new dialog opens which 
allows you to observe the setup process.

The following dialog informs you about the completion of the setup.

9. Click on the Finish button. 
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The setup wizard closes.

Setting up the OpenScape Click-to-Dial-Browser-Plug-in is now complete.

10.4  Changing the Setup, Updating and Uninstalling the OpenScape Click-
to-Dial-Browser-Plug-in

Introductory description of how to perform a setup change, repair (update) or 
uninstall the OpenScape Click-to-Dial-Browser-Plug-in.

You start modifications to the existing setup, updates and the program's uninstal-
lation via the following dialog. This dialog opens when you execute the setup file 
from the setup directory of the application. The name of the setup file is:

InstallBrowserIntegration.exe

You can customize the program as follows:

• Via Modify
Installing/uninstalling a Firefox integration

• Via Repair
Installing a more recent program version.

• Via Remove
Uninstalling the program.

10.4.1  Modifying the Installation (Modify)

Options for adjusting the OpenScape Click-to-Dial-Browser-Plug-in setup.

After you have installed the OpenScape Click-to-Dial-Browser-Plug-in you can 
perform the following setup modifications:

• If you have not integrated Firefox yet, you can do it retrospectively.

• If you have integrated Firefox already, you can uninstall the Firefox support 
again.
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10.4.1.1  How to Install the Firefox Support Retrospectively

Installing the Firefox integration for the OpenScape Click-to-Dial-Browser-Plug-in 
retrospectively.

If you wish to use the call functionality from your Firefox web browser after a 
default installation of the OpenScape Click-to-Dial-Browser-Plug-in, proceed as 
follows:

Step by Step 1. Make sure that Mozilla Firefox has terminated.

2. Start the file:

InstallBrowserIntegration.exe

3. Select the Modify option in the opened dialog pictured above.

4. Click on Next. 

The dialog for selecting the feature to be installed appears.

5. Select the Firefox Integration feature and click on Next. 

The dialog for entering the OpenScape Web Client URL opens.

6. Click on Next >. 

The installation process begins.

7. Click on Finish when the setup is complete.

The process ends and the setup wizard closes.

NOTICE:  After the Mozilla Firefox reboot you are informed about 
the newly installed plug-in (add-on) in a dialog. Click on Refresh 
to copy the changes and close this dialog.

Installing the Firefox integration for the OpenScape Click-to-Dial-Browser-Plug-in 
retrospectively is now accomplished.

10.4.1.2  How to Uninstall the Firefox Support

Uninstalling the Firefox integration for the OpenScape Click-to-Dial-Browser-
Plug-in.

How to uninstall the Firefox Integration without removing the entire program:

Step by Step 1. Make sure that Mozilla Firefox has terminated.

2. Start the file:

InstallBrowserIntegration.exe

3. Select the Modify option in the opened dialog pictured above.

4. Click on Next. 
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The dialog for selecting the feature to be installed appears.

5. Click on  to the left of the Firefox Integration feature.

6. Select the Entire feature will be unavailable option.

7. Click on Next in this dialog.

The uninstallation routine starts. A new dialog opens which allows you to 
observe the uninstallation process. 

8. When the uninstallation is complete, a new dialog opens that you can close 
via the Finish button.

Calling from the web browser Mozilla Firefox is not possible anymore.

10.4.2  Update Installation (Repair)

Update installation (repair) for the OpenScape Click-to-Dial-Browser-Plug-in.

The Repair function is used for the following actions:

• If a more recent version of the OpenScape Click-to-Dial-Browser-Plug-in is to 
be installed after the setup.

• If the OpenScape server URL needs to be adjusted after the setup.

• If a malfunction has occurred in the currently installed application.

10.4.2.1  How to Perform an Update Installation (Repair)

Performing an update installation (repair) for the OpenScape Click-to-Dial-
Browser-Plug-in.

If an update installation is required, proceed as follows:

Step by Step 1. Shut down the web browser currently used.

2. Start the current version of the setup program for the OpenScape Browser 
Integration.

InstallBrowserIntegration.exe

3. Select the Repair option in the opened dialog pictured above.

4. Click on Next. 
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The following dialog opens.

5. Enter the OpenScape Web Client URL.

6. Click on the Check server address button.

This checks the entered URL. 

If the URL is correct, the Internet Explorer displays the login mask of the.

7. Click on Next.

A new dialog opens that allows tracing the setup process:

8. Another dialog opens, which marks the end of the installation. Click on the 
Finish button in this dialog.

The update is now complete and the setup assistant closed.

10.4.3  Uninstalling the OpenScape Click-to-Dial-Browser-Plug-in

Uninstalling the OpenScape Click-to-Dial-Browser-Plug-in.

NOTICE:  For a system on which several users deploy the 
OpenScape Click-to-Dial-Browser-Plug-in in the Microsoft 
Internet Explorer please note that the function WebClient Call 
must be manually removed for these users during the OpenScape 
Click-to-Dial-Browser-Plug-in uninstallation. Open the Search 
Options menu in the Microsoft Internet Explorer and select 
Manage Search Providers. Select the WebClient Call feature in 
the displayed list. Finally, click on the Remove button.

You can use the following options to remove the OpenScape Click-to-Dial-
Browser-Plug-in application from your local system:

• Uninstallation via executing the InstallBrowserIntegration.exe file

• Uninstallation via the Windows Start menu
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10.4.3.1  How to Perform the Uninstallation via the Setup File

Uninstalling the OpenScape Click-to-Dial-Browser-Plug-in via the setup file.

To uninstall the OpenScape Click-to-Dial-Browser-Plug-in via executing the 
InstallBrowserIntegration.exe file, proceed as follows:

Step by Step 1. Shut down the web browser currently used.

2. Start the current version of the setup program for the OpenScape Browser 
Integration.

InstallBrowserIntegration.exe

The following dialog opens:

3. Select the Remove option in the opened dialog pictured above.

4. Click on Next. 

A confirmation dialog opens.

5. Click on Next in this dialog.

The uninstallation process begins. A new dialog opens that allows tracing the 
uninstallation process:

6. Another dialog opens, which marks the end of the uninstallation. Click on the 
Finish button in this dialog.

The OpenScape Click-to-Dial-Browser-Plug-in is thus uninstalled and the 
uninstallation wizard closes.

10.4.3.2  How to Perform the Uninstallation via the Windows Control Panel

Uninstalling the OpenScape Click-to-Dial-Browser-Plug-in via the Windows 
control panel.
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To uninstall the OpenScape Click-to-Dial-Browser-Plug-in via the control panel, 
proceed as follows:

Step by Step 1. Shut down the web browser currently used.

2. Click on start and select the Control Panel > Add or Remove Programs 
option.

3. Select the Siemens OpenScape Browser Integration entry in the displayed 
list.

4. Then click on the Remove button.

5. Click on Yes in the open confirmation dialog.

The uninstallation starts.

The OpenScape Click-to-Dial-Browser-Plug-in is thus uninstalled.

10.5  Configuring the OpenScape Click-to-Dial-Browser-Plug-in

Configuring the OpenScape Click-to-Dial-Browser-Plug-in.

You can perform or change the OpenScape Click-to-Dial-Browser-Plug-in 
settings via the configuration menu.

After the program's installation you reach the configuration menu or configuration 
dialog depending on the web browser via different operation steps.

10.5.1  How to Configure the OpenScape Click-to-Dial-Browser-Plug-in for 
the Internet Explorer

Configuring the OpenScape Click-to-Dial-Browser-Plug-in for the Internet 
Explorer

To configure the OpenScape Click-to-Dial-Browser-Plug-in for the Internet 
Explorer, proceed as follows:

Step by Step 1. Start the Internet Explorer as usual.

2. Click on  in the toolbar.
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The configuration dialog opens.

NOTICE:  If OpenScape Desktop Client Enterprise Web 
Embedded Edition is installed on your computer, integration of the 
OpenScape Click-to-Dial-Browser-Plug-in in the Internet Explorer 
is configured for this application. This means that the desired 
connections are set up via the currently installed client. For 
example, the OpenScape Desktop Client Enterprise Web 
Embedded Edition is pre-installed on the system in the depicted 
dialog. If the OpenScape Desktop Client Enterprise Web 
Embedded Edition is started at the time of the call, it is used for 
the connection setup. If this software solution is not installed on 
the system, the call is initiated via the OpenScape Web Client.

10.5.2  Configuring the OpenScape Click-to-Dial-Browser-Plug-in for 
Mozilla Firefox

Configuring the OpenScape Click-to-Dial-Browser-Plug-in for Mozilla Firefox.
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You can open the configuration menu of the OpenScape Click-to-Dial-Browser-
Plug-in for Mozilla Firefox in two different ways:

• Open the Tools menu and select the Config Menu option.

• Rightclick anywhere in the menu bar.

10.5.2.1  How to Configure the OpenScape Click-to-Dial-Browser-Plug-in for Firefox via 
the Tools Menu 

Configuring the OpenScape Click-to-Dial-Browser-Plug-in for Firefox via the 
Tools menu

To configure the OpenScape Click-to-Dial-Browser-Plug-in for Firefox, proceed 
as follows:

Step by Step 1. Start Mozilla Firefox as usual.

2. Click on Tools in the main bar.

3. Select the Start Config Menu function.

The configuration dialog appears.

NOTICE:  If OpenScape Desktop Client Enterprise Web 
Embedded Edition is installed on your computer, integration of the 
OpenScape Desktop Client Enterprise Web Embedded Edition in 
Firefox is configured for this application. This means that the 
desired connections are set up via the currently installed client. If 
the OpenScape Desktop Client Enterprise Web Embedded 
Edition is started at the time of the call, it is used for the connection 
setup. If this software solution is not installed on the system, the 
call is initiated via the OpenScape Web Client.

10.5.2.2  How to Configure the OpenScape Click-to-Dial-Browser-Plug-in for Firefox via 
Rightclick on the Menu Bar 

Configuring the OpenScape Click-to-Dial-Browser-Plug-in for Firefox with a right-
click on the menu bar.

To configure the OpenScape Click-to-Dial-Browser-Plug-in for Firefox, proceed 
as follows:

Step by Step 1. Start Mozilla Firefox as usual.

2. Rightclick anywhere in the menu bar.

3. Select Customize... in the open context menu.

The Customize Toolbar dialog opens.

4. Click on the Config Menu entry in the displayed icon list. 
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5. Keep the left mousebutton pressed and drag the  icon to the desired 
position in the toolbar.

6. Click on the Finish button.

The dialog closes.

7. Click the  button.

The configuration dialog opens.

10.5.3  Configuration Options for the OpenScape Click-to-Dial-Browser-
Plug-in

Configuration options for the OpenScape Click-to-Dial-Browser-Plug-in.

NOTICE:  The configuration dialogs for the OpenScape Click-to-
Dial-Browser-Plug-in contain the same options for the Internet 
Explorer and Mozilla Firefox integration.

NOTICE:  You specify the language of the configuration dialog 
under Control Panel > Regional and Language Options.

The following configuration options are available for setting the OpenScape Click-
to-Dial-Browser-Plug-in:

• Activating/deactivating the IE/Firefox integration

• Defining blacklists of words

• Defining blacklists of URLs

• Defining a blacklist of phone numbers

• Selecting countries

10.5.3.1  Activating/Deactivating the IE/Firefox Integration

Activating/deactivating the configuration option IE/Firefox integration

The Internet Explorer/Firefox integration becomes active after you have installed 
the OpenScape Click-to-Dial-Browser-Plug-in. You can deactivate the integration 
using the Disable IE Integration or Disable Firefox Integration buttons. 

Deactivation means that phone numbers are no longer displayed as links but as 
normal text and cannot be used for dialing anymore.
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10.5.3.2  Defining Blacklists of Words

Configuration option defining "blacklists of words".

NOTICE:  This list does not contain any entries after the instal-
lation.

In this list you can specify words (also called blocking words) that are to be 
searched for. If one of these words is found preceding a phone number, this 
number is not displayed as link with preceding country flag button and cannot be 
dialed directly by mouseclick.

If you want to define a new blocking word, click on the Add new blocking word 
button. The following dialog opens for you to make entries.

If you want to delete a list entry, select it in the corresponding combo box of the 
configuration dialog and click on the Remove selected blocking word button.

NOTICE:  After you have added or removed blocking words you 
need to reboot the web browser or update the loaded web page. 
Only then the configuration changes will be considered.

10.5.3.3  Defining Blacklists of URLs

Configuration option defining "blacklists of URLs".

NOTICE:  This list does not contain any entries after the instal-
lation.

This list contains the URLs not to be considered. You add new entries to the list 
via the Add a URL to the blacklist dialog. You reach this dialog via the Add new 
URL button in the configuration dialog.
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If you want to delete a list entry, select it in the corresponding combo box of the 
configuration dialog and click on the Remove selected URL button.

NOTICE:  After you have added or removed blocking words or 
URLs you need to reboot the web browser or update the loaded 
website. Only then the configuration changes will be considered.

10.5.3.4  Defining Blacklists of Phone Numbers

Configuration option defining "blacklists of phone numbers".

NOTICE:  This list does not contain any entries after the instal-
lation.

This list contains the phone numbers not to be considered. You can use the 
following options to integrate new entries in the list:

• Via the Add new number button.
A click on the Add new number button opens the below dialog in which you 
can enter the desired phone number.

• Via the OpenScape Click-to-Dial-Browser-Plug-in context menu
Rightclick a phone number on the loaded web page. Select the Ignore 
number option in the context menu. A message confirms the copying of the 
desired phone number to the phone number blacklist. Click on OK to close 
this message.
If you want to delete a list entry, select it in the corresponding combo box of 
the configuration dialog and click on the Remove selected number button.

NOTICE:  Modifications to the number list are automatically 
copied by the program. The web browser need not be rebooted or 
the displayed website updated.
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10.5.3.5  Selecting Countries for Phone Number Normalization

Setting the configuration option "country selection" for phone number normal-
ization.

NOTICE:  The defaulted country is always the one configured as 
location under Control Panel > Regional and Language 
Options > Regional Options.

Configuring the default country determines the country code, which also influ-
ences the number normalization. To display the country selection list, enter the 
initial letter of the country you look for in the entry field. Select the desired country 
from the list and click on OK to copy the modifications.

The following priorities apply for the number normalization:

1. If the country code (for example +49 for Germany) is given for the phone 
number displayed on the web page, it is used for setting up the call.

2. If no country code is specified, the country code of the given domain is used, 
for example +49 for the domain .de.

3. If 1. and 2. do not apply, the country code of the default country set in the 
configuration dialog is used.

4. If a phone number has been identified as NANP (North American Numbering 
Plan) number, +1 is used as country code.

10.6  Operating the OpenScape Click-to-Dial-Browser-Plug-in

Operating OpenScape Click-to-Dial-Browser-Plug-in.

After you have installed the OpenScape Click-to-Dial-Browser-Plug-in, phone 
numbers on HTML pages are converted in a new HTML structure. 

It consists of the following elements: 

• A button that represents the flag of the country the country code of which has 
been identified (country flag button)

• A phone number represented as hyperlink, which can be dialed by mouse-
click.

10.6.1  How to Initiate a Call from an HTML Page

Calling a subscriber by clicking a phone number on an HTML page.
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How to initiate a call to a phone number represented in the browser:

Step by Step 1. Click on the phone number represented as button with country flag and link in 
the website. 

NOTICE:  If a browser security prompt opens when you click on 
the phone number because a certificate is missing, you can 
ignore it and continue with confirming this message.

2. If you use the OpenScape Click-to-Dial-Browser-Plug-in via theOpenScape 
Web Client: A login dialog opens if you invoke the function for the first time or 
have not yet saved the user data.

NOTICE:  If you use the OpenScape Click-to-Dial-Browser-Plug-
in via OpenScape Desktop Client Enterprise Web Embedded 
Edition, you need not log in. The call is initiated directly.

3. Enter the name with which you log in at the OpenScape Web Client under 
User name.

4. Enter the password with which you log in at the OpenScape Web Client under 
Password.

The call is initiated.

NOTICE:  If you have configured the correct URL for the 
OpenScape Web Client when installing the plug-in, the 
connection is set up with the OpenScape Web Client. If the 
OpenScape Desktop Client Enterprise Web Embedded Edition is 
installed and running on your system, the call is initiated with it.

10.6.2  The OpenScape Click-to-Dial-Browser-Plug-in Context Menu

Using the OpenScape Click-to-Dial-Browser-Plug-in context menu.

You open the OpenScape Click-to-Dial-Browser-Plug-in context menu with a click 
of the right mousebutton on the country flag button.  

The context menu contains the following options:
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• Copy phone number
This feature copies the linked phone number to the clipboard.

• Call <phone number>
This feature initiates the connection setup with the linked phone number.

• Ignore number
This feature adds the linked phone number to the black list of phone numbers.

NOTICE:  The context menu of the OpenScape Click-to-Dial-
Browser-Plug-in for Internet Explorer contains the default features 
of the web browser: Undo, Cut, Copy, Paste, Delete, Select all 
in addition to the above functions.

10.6.3  The Country Selection Dialog for the OpenScape Click-to-Dial-
Browser-Plug-in

Setting of the default country for phone number normalization.

You can change the setting for selecting a country. To open the setting dialog, 
click on the country flag button that precedes the phone number represented as 
link on the displayed web page. 

The following dialog opens:

To configure another country, click in the entry field and enter the first letter of the 
desired country. A list of all countries the names of which begin with the entered 
letter is displayed. Select the desired country and click on OK. The country flag 
icon is updated according to your modification.
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10.6.4  Calling via the Web Browser Search Engine List

Calling via the web browser search engine list

NOTICE:  Microsoft Internet Explorer 7.0 does not support this 
functionality. In case of Microsoft Internet Explorer 8.0 and Mozilla 
Firefox the call entry is also automatically added to the context 
menu of a selected phone number as option - Search with 
WebClient Call <phone number>.

By the call entry WebClient Call in the web browser search engine the 
OpenScape Click-to-Dial-Browser-Plug-in enables using your web browser as 
normal telephone. In other words, you can call any phone number from your web 
browser anytime.

Representation of the call entry (example)

You only need to enter the number to be called in the WebClient Call field and 
push the return key (enter). The desired connection is set up via the OpenScape 
Web Client.

NOTICE:  Using this functionality requires you to configure the 
correct URL of the OpenScape Web Client host during the 
OpenScape Click-to-Dial-Browser-Plug-in setup. This option is 
otherwise not installed or displayed in the web browser's search 
engine.

Microsoft Internet Explorer 8.0 Mozilla Firefox
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11  The OpenStage Client

The OpenStage Client is a server application that can be used on telephones of 
type OpenStage 60/80 for setting frequently required communications functions 
of the OpenScape UC Application.

Some important OpenScape UC Application functions, normally used via the 
OpenScape Web Client, the OpenScape Desktop Client Enterprise Web 
Embedded Edition or the OpenScape Mobile Client, can be operated by 
telephones of type OpenStage 60 or OpenStage 80 via the application 
OpenStage Client.

NOTICE:  You find detailed operating instructions for the 
OpenStage telephone in the manuals OpenStage 60 or 
OpenStage 80.

The following OpenScape UC Application features are available via the 
OpenStage Client:

• Access to the presence function

– The telephone displays your currently set presence status.

– You can change your presence status via telephone.

• Access to your preferred device

– The telephone displays your currently set device.

– You can change your preferred device via telephone.

• Access to contact search in the available address books

– You can look for contacts in the available address books.

– You can directly call the found contact.

• Access to your contact list

– You can search your contact list for contacts.

– You can directly call contacts from your contact list.

• Access to your call journal

– You can have your call journal displayed. The call journal lists all inbound 
and outbound calls.

– You can directly call the subscribers (callers and callees) listed in the call 
journal.

– You can filter the display of call journal entries by date and time.

• Access to conferences

– You can have your conference list displayed.

– You can start conferences you have created yourself.

11.1  Requirements for Using the OpenStage Client

Requirements for using the OpenStage Client.
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The following requirements must be complied with for using the OpenStage Client 
application in the OpenScape UC Application:

• The person who deploys the application must be an OpenScape 
UC Application user.

• The user must have been assigned an ONS number (ONS = One-Number 
Service).

• The server application must have been installed on the backend computer of 
the OpenScape UC Application.

• The server application must have been configured on the backend computer 
of the OpenScape UC Application.

On the display of your OpenStage telephone after invoking the Applications tab 
you can see whether the application is available to you. This tab features an entry 
such as OpenStage Client via which you can start or stop the application.

NOTICE:  The name OpenStage Client is freely selectable and 
has been assigned here to the application as example. In case of 
doubt please contact your system administrator.

You reach this tab by touching the sensor key .

NOTICE:  Depending on the operating state you need to touch 
this key several times for browsing the tab view.

11.2  How to Start the Application on the OpenStage Telephone

Starting the OpenStage Client application on the OpenStage telephone.

To start the application on the telephone proceed as follows:

Step by Step 1. Switch to the Applications tab using the sensor key  of the mode keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the OpenStage Client application.

3. Use the arrow pointing to the right on the TouchGuide to reach the next 
function level. Here you find the functions Start (for starting the application), 
Stop (for stopping the application) and Stop All (for stopping all running appli-
cations).
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4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Start function.

5. Execute this action by pushing OK in the center of the TouchGuide.

The OpenStage Client tab is additionally included in the tab

NOTICE:  that displays the message "Starting XML Application" 
during the startup procedure.

After completion of the startup process, the OpenStage Client functions are 
offered on this tab.
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11.3  Operating the OpenStage Client

General notes for operating the OpenStage Client.

Operating the OpenScape UC Application features via a telephone of type 
OpenStage 60 or OpenStage 80 is very similar to operating these functions via 
the OpenScape Mobile Client. Operation starts after you have booted and 
invoked the OpenStage Client application via the TouchGuide keys on the 
OpenStage telephone.

To invoke the application, select the sensor key Service/application menu from 
the mode keys.

Push this sensor key repeatedly until the main menu appears on the OpenStage 
Client tab. You reach the OpenStage Client functions via the main menu.

Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to select 
the function you wish to edit.

The following further options are available for this purpose:

• Push OK in the center of the TouchGuide to directly switch to the submenu of 
the selected function for performing settings there.
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• Use the arrow pointing to the right on the TouchGuide to reach the next 
function level. The submenu is displayed. 

Trigger one of the following functions there:

– Info: After you have selected this menu option using the cursor keys 
"scroll downward/scroll upward" on the TouchGuide and pushed OK, you 
see the software version currently installed.

– Select: After you have selected this menu option and pushed OK, you 
branch to the submenu of this function.

– Exit: After you have selected this menu option and pushed OK, the appli-
cation OpenStage Client closes after a security prompt.

NOTICE:  Depending on the main menu function, the submenu 
provides additional functions. These additional functions are 
related to the selected feature and described in the feature's 
context.

11.3.1  How to Set the Presence Status

Setting the presence status in the OpenStage Client.

You can see your currently set presence status as icon to the left of the menu 
entry Presence and to the right of this entry in the clear text (in the example figure 
Available) in the OpenStage Client.
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 217



The OpenStage Client
Operating the OpenStage Client
How to change your presence status:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Presence function.

3. Open the menu for selecting a status by pushing OK in the center of the 
TouchGuide.

4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired presence status.
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5. Confirm your selection with OK in the center of the TouchGuide.

The desired presence status is changed whereever it is displayed in the 
OpenScape UC Application and you return to the OpenStage Client menu.

11.3.2  How to Set the Preferred Device

Setting the preferred device in the OpenStage Client.

The preferred device is the one you have defined for receiving inbound calls. You 
select it from your device list. Your currently set preferred device is indicated to 
the right of the menu entry Preferred Device in the clear text (example: Office 
Phone) in the OpenStage Client.

How to change your preferred device:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Preferred Device function.
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3. Open the menu for selecting a device by pushing OK in the center of the 
TouchGuide.

4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired device.

5. Confirm your selection with OK in the center of the TouchGuide.

The desired preferred device is changed whereever the OpenScape 
UC Application accesses it for routing calls to this device. Subsequently, you 
return to the OpenStage Client menu.

11.3.3  How to Use the Directory Search

Searching address books for contacts via the Directory Search function and 
calling the found contact.

You can search the available address books for contacts and call a found contact 
directly.
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How to search address books for a contact and call him/her:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Directory Search function.

3. Open the selection of search parameters by pushing OK in the center of the 
TouchGuide.
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4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired search parameter. The following search parameters are 
available:

a) Name, to look for the contact via the second name database field.

b) First Name, to look for the contact via the first name database field.

c) Phone, to look for the contact via the phone number database field.

5. After you have selected the desired search parameter push OK in the center 
of the TouchGuide. Next to the search parameter you see an input field.

6. Enter the search item (second name, first name or phone number) using the 
telephone keypad.

NOTICE:  How to use the telephone keypad for entering a name 
is described in the manual for the OpenStage telephone under 
Keypad in section Text input.

NOTICE:  When searching via a name, you can also use the 
name's initials. This may produce a confusingly long hitlist, 
though, if too few letters are entered or a letter combination occurs 
too often. When looking for a contact via phone number, you need 
to enter this number like you normally do for calling an internal 
subscriber.

7. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Search now function.

8. Push OK in the center of the TouchGuide. The search function starts.

The search result is displayed indicating the number of hits in the form of a list.

9. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the contact you wish to call.

10. After you have selected the desired contact push OK in the center of the 
TouchGuide. The contact's device list opens.

11. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the device you wish to use for calling the contact.

12. After you have selected the desired device push OK in the center of the 
TouchGuide.

The call to the found contact's device is initiated.

11.3.4  How to Call a Subscriber via Contact List

Calling a subscriber via your private OpenScape UC Application contact list.
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Your telephone displays the contact list you have created in the OpenScape 
UC Application via the OpenScape Desktop Client Enterprise Web Embedded 
Edition or the OpenScape Web Client. All entries in your contact list including 
those sorted in sub-groups are itemized. By selecting a contact entry you can 
directly call this contact.

NOTICE:  You can search your contatct list for contacts via the 
submenu option Search (Contact List > contact name > 
Search).

How to call a subscriber via your contact list:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Contact List function.
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3. Open your contact list by pushing OK in the center of the TouchGuide.

4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired contact.

5. Confirm your selection with OK in the center of the TouchGuide. The list of 
devices available for calling the contact is displayed.

6. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired phone number.
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7. Confirm your selection with OK in the center of the TouchGuide.

NOTICE:  If you push on the arrow pointing to the right instead of 
OK in operating step 5, the submenu opens. Here you can branch 
to the device selection via Details and search your contact list for 
a contact via Search. The procedure corresponds to the directory 
search. 

The corresponding page of the contact list with the highlighted first hit is displayed 
as search result.

The call to the selected phone number is initiated.

11.3.5  The OpenStage Client Call Journal

Using the journal for your calls via the OpenStage Client.

The call journal lets you access all calls you have received or made. The journal 
displays calls with the following attributes: 

• A status icon with the following meanings:

–  Inbound call successful

–  Inbound call unsuccessful

–  Outbound call successful

–  Outbound call unsuccessful

–  Conference call from the system

–  Dial-in call to join a conference

• The call time:

– With indicating the specific time, if the call occurred on the current day.

– With indicating the specific date, if the call occurred before the current 
day.

• The name of the called or calling subscriber, if possible.

The journal entries are accompanied with the following editing options:

• Callback to the calling/called subscriber.

• Filtering the journal entries by:

– Listing all calls.

– Listing missed calls.

– Listing inbound calls.

– Listing outbound calls.

11.3.5.1  How to Call Subscribers via Call Journal

Calling a subscriber via the OpenStage Client call journal.
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The call journal lets you access all calls you have received or made. You can 
select an entry in the call journal and directly call the corresponding subscriber.

How to call a subscriber via your journal entries:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Journal function.

3. Open the list of your calls by pushing OK in the center of the TouchGuide.

4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired call.
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5. Use the arrow pointing to the right on the TouchGuide to reach the next 
function level. The submenu is displayed.

6. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Call function.

The call to the relevant subscriber is initiated.

11.3.5.2  How to Search the Call Journal for Calls

Filtering the journal entries by date and time.

To detail your search for calls, you can filter the journal entries to display calls that 
occured in specific periods or on specific dates. When you filter based on a date, 
you can additionally enter a time from which calls shall be listed.
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How to display journal entries from specific periods:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Journal function.

3. Open the list of your calls by pushing OK in the center of the TouchGuide.
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4. Use the arrow pointing to the right on the TouchGuide to reach the next 
function level. The submenu is displayed.

5. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select one of the offered filter functions.

a) All calls: Selecting this option displays all calls in the call journal.

b) Missed calls: Selecting this option displays in the call journal all calls you 
did not accept.

c) Incoming calls: Selecting this option displays all inbound calls in the call 
journal.

d) Outgoing calls: Selecting this option displays all outbound in the call 
journal.

The call journal will then display the calls according to the filter settings.

11.3.6  Operating Conferences via the OpenStage Client

General information about operating conferences via the OpenStage Client.

Using the OpenStage Client you can start conferences you have configured via 
the OpenScape Desktop Client Enterprise Web Embedded Edition or the 
OpenScape Web Client and operate started conferences:
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• You can select a conference from the pre-configured ones and start it via the 
OpenStage Client. The started conference is then additionally displayed as 
active conference in the display under the Conferences menu option.

NOTICE:  Depending on the configuration guidelines of creating 
a conference, you are automatically called at the conference start 
or need to dial in after the conference start.

• When in an active conference, you have the following options:

– You can leave the conference.

– In case of an open conference, every participant can end the conference.

NOTICE:  In case of a moderated conference, only the moderator 
can end the conference. This is the participant who configured the 
conference as moderated conference. 

– You can update the list of conference participants displayed on the 
OpenStage telephone.

11.3.6.1  How to Start Conferences via the OpenStage Client

Starting a conference via the OpenStage Client.

The Conferences menu gives you access to all conferences you have 
configured. You can thus start one of your conferences via this menu.
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How to start one of your conferences:

Step by Step 1. Switch to the OpenStage Client tab using the sensor key  of the mode 
keys.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the Conferences function.

3. Open your conference list by pushing OK in the center of the TouchGuide.

4. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the conference you wish to start.
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5. Start the conference by pushing OK in the center of the TouchGuide.

The selected conference starts and is displayed as active conference in the 
menu.

• The participants for whom dialing in has been configured upon the conference 
creation can do so now by specifying the corresponding dial-in and login 
parameters (bridge number and PIN).

• The participants for whom receiving a system call has been configured upon 
the conference creation receive the conference call from the OpenScape 
UC Application and need not log in to the conference.

NOTICE:  When dialing in or after you have received the 
conference call, the system prompts you to make an entry via 
telephone keypad. This is the case, for example, if you wish to join 
a conference (entry [1]) or if you wish to perform control actions 
during the conference (entry [*] and [*] once more for activating 
the conference operation menu). You make these entries via the 
telephone keypad. Switch to the telephone mode beforehand. You 
do this by enabling the sensor key Show telephony interface  
of the mode keys.

11.3.6.2  Operating Options in an Active Conference

Operating options via the OpenStage Client in an active conference.
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Once the conference has been started and the participants have joined either by 
dialing in or accepting a system call, the OpenStage Client displays the 
conference status with the active conference participants:
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You can perform the following operating steps in the active conference:

Step by Step 1. Use the arrow pointing to the right on the TouchGuide to reach the next 
function level.

The submenu is displayed.

NOTICE:  In the example figure below you see the submenu for 
the participants of an open conference or for the moderator of a 
moderated conference.

2. Use the cursor keys "scroll downward/scroll upward" on the TouchGuide to 
select the desired option.

• Leave: Leaving the conference.

• Drop participant: Removing the selected participant from the 
conference.

• Terminate: Ending the conference.

NOTICE:  The Terminate function is available to all conference 
participants only in open conferences. In case of a moderated 
conference, only the person who has created the conference can 
end it in this way.
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• Lock conference: Once the conference is locked, no further participants 
can dial in. 

NOTICE:  This function then changes to Unlock conference. 
This allows you to open the conference to other participants 
again.

• Mute conference: This function mutes the microphones of all conference 
participants. Only the voice signal of the conference participant who 
triggers this function is still transmitted to all conference participants.

NOTICE:  This function then changes to Unmute conference. 
This allows you to open the microphones for the conference 
participants again.

• (Un)Mute participant: This function lets you temporarily switch off the 
sound transmission from the selected conference participant. The 
conference connection is maintained. 

NOTICE:  When you invoke this function once more, the selected 
conference participant becomes audible again.

• Refresh: Updating the list of conference participants and switching to the 
conference participant list.
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• Back: Takes you back to the OpenStage Client main menu.

NOTICE:  In case of an open conference, all conference partici-
pants have access to the full functional range. In a moderated 
conference, only the moderator has this privilege. 

Other participants in a moderated conference can only use a restricted 
options menu with the following functions:

Leave: Leaving the conference.

Refresh: Updating the list of conference participants and switching to the 
conference participant list.

Back: Takes you back to the OpenStage Client main menu.
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12  OpenScape Client Integrations

General Information about OpenScape Client Integrations

After installing OpenScape Client Integrations you can use the Click-to-Dial 
function independently of setting up the CTI client OpenScape Desktop Client 
Enterprise Web Embedded Edition. You can thus implement this function in many 
clients and use it there.

12.1  OpenScape Client Integrations

Features of the OpenScape Client Integrations.

OpenScape Client Integrations allows initiating a phone call via any journal 
entries from within specific clients (click-to-dial) for which this function has been 
installed.

The following functions are provided via the OpenScape Client Integrations:

• Callback to originators of any messages.

• Direct call, for example via any contact, calendar and task entries that contain 
contact information.

• After initiating the call, the call control in the OpenScape Web Client opens 
automatically if the URL of the OpenScape Web Client is entered in the Client 
Integration setup and the "Use Click to Communicate" option has been set.

• Direct call via selected phone numbers on internet pages for the browsers 
Microsoft Internet Explorer and Mozilla Firefox.

12.2  Supported Clients

List of clients via which the OpenScape Client Integrations features can be used.

You can install the OpenScape Client Integrations features using the OpenScape 
Client Integrations setup for the following clients:

• Microsoft Outlook

• Lotus Notes

NOTICE:  You can use the click-to-dial feature in Lotus Notes for 
contact entries only.

• Sametime Connect

• Microsoft Internet Explorer

• Mozilla Firefox

You find the latest information about the supported clients and their versions in 
the OpenScape UC Application Planning Guide manual.
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12.3  Installation Requirements

Requirements for setting up OpenScape Client Integrations.

The following requirements must be complied with for installing OpenScape 
Client Integrations:

• .Net Framework 3.5 must have been installed on the workstation.

• The installation requires administrative privileges on the workstation on which 
the installation is to be performed.

• OpenScape Client Integrations is always installed for all users who deploy this 
workstation.

• Before you start the setup you need to shut down the application for which you 
wish to install OpenScape Client Integrations. An error message will 
otherwise inform you during the setup that a specific application is still running 
and needs to be closed.

Furthermore, please heed the following points:

• Only those OpenScape Client Integrations components are offered for instal-
lation in the setup for which a corresponding client application is already 
available. 

• Only those OpenScape Client Integrations components are offered for instal-
lation in the setup that have not yet been installed on the workstation.

• If the OpenScape Client Integrations components have already been installed 
via the OpenScape Desktop Client Enterprise Web Embedded Edition setup, 
installation of these components via the OpenScape Client Integrations setup 
is blocked. Setup then ends with a corresponding error message. 

• If OpenScape Click-to-Dial-Browser-Plug-in has already been installed via 
the OpenScape Web Client, you can additionally install the missing compo-
nents during the OpenScape Client Integrations setup.

You find the required setup files for OpenScape Client Integrations on the instal-
lation DVD under path:

win32\ClientIntegrations.zip

12.4  Setup Adjustments

Adjustments for setting up OpenScape Client Integrations.

As a rule, adjustments of the setup are not required. In case of a Large Rollout, 
the required parameters are applied by group policy instead of msi file manipu-
lation. In this process, the values for the Domino server name and for the Web 
Client URL are set via registry keys. You can set the following parameters via 
group policy:

• The Domino server name: [Type String]
HKEY_LOCAL_MACHINE\Software\Siemens\NotesConfigu-
ration\Servername 

• The Web Client URL: [Type String]
HKEY_CLASSES_ROOT\mmo\WebURL
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Some commands allow transferring parameters to the .msi setup package 
directly via the Config.ini. You can transfer the following commands via the 
Config.ini:

• WebClientAddress=
Via this command the OpenScape Web Client URL is transferred directly to 
the msi package.

• CommandLine=
Via this command you can transfer the parameters allowed for executing the 
Windows Installer. For example, the setup is executed automatically without 
user entries (silent mode) with Commandline=\qn.

• Activation=0

NOTICE:  You need to supplement this command manually under 
the [WiseInstaller] heading.

Supplement this command if the Click-to-Dial browser plug-in shall be 
disabled after the installation for the time being. You need to activate the plug-
in then manually via the configuration dialog of the respective browser appli-
cation (Microsoft Internet Explorer or Mozilla Firefox).

• RequestString=
Without meaning here.

12.5  How to Install the OpenScape Client Integrations

Setup routine for the OpenScape Client Integrations.

NOTICE:  The language in the setup dialogs is exclusively 
English.

How to install the OpenScape Client Integrations for the previously mentioned 
clients:
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Step by Step

1) Start the setup file InstallClientIntegrations.exe. The following 
dialog opens:

2) Click on Next > to start the installation. The following dialog opens: 
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3) Enter your name in the field Full Name and the company name in the Organi-
zation field. Then click on Next >. The following dialog opens:

4) Select the client application for which OpenScape Client Integrations is not to 
be installed. OpenScape Client Integrations is selected for installation for all 
available client applications by default.

• To exclude a component from the setup, click in the list field on the arrow 
icon and select the Entire feature will be unavailable option in the 
context menu.

• You can use the Reset button to cancel a setting and switch back to the 
default setting.

• You can display the drive environment of this system via the Disk Cost 
button for detecting free memory.

The following components can be installed:

• Microsoft Outlook

• Lotus Notes

• Sametime Connect

• Sametime Connect for Notes 8

• Microsoft Internet Explorer

• Mozilla Firefox

Setup always occurs to the directory ...\Programs\Siemens by default. 
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5) After you have specified your setup defaults, click on Next >. The following 
configuration dialog opens:

6) Enter the URL for your web client in the input field under OpenScape Web 
Client host address. The call is initiated via the OpenScape Web Client. You 
can use the IP address (example: http://100.100.100.100:7789) or the server 
name (example: https://webclient.company.com) to enter the host address.

7) Click on the Check server address button. If the specified server address is 
valid, the following success message is put out:

If the specified server address is invalid, the following error message is put 
out:

8) Set the Use Click To Communicate option if you want the call control of the 
OpenScape Web Client to open automatically when you initiate a call via the 
Click-to-Dial function. 

9) Enter the path to the directory server for the connection to a Lotus Notes 
server in the next input field. Make this entry in the format <domain/server> 
(example: Sametime/Data). This enables direct dialing from the standard 
Notes directory without any previous configuration.
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10) Click on Next > to start the setup process. The next dialog shows the setup 
progress.

You can terminate the setup process via the Cancel button.

11) When the installation is accomplished the following dialog appears:

12) Click on Finish to complete the setup process.

OpenScape Client Integrations is now installed for the selected client applica-
tions.

12.6  OpenScape Client Integrations

Operating the OpenScape Client Integrations.
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Prerequisites

• The OpenScape Client Integrations must have been installed for the client 
from which you wish to use the features.

• The journal and contact entries you wish to use for a return call must have 
been stored with a phone number.

To call any journal entry from your mail client via the OpenScape Client Integra-
tions proceed as follows:

Step by Step

1) Select the entry you wish to call in your mailbox, calendar or address book.

2) Click on  Dial.

3) Enter your user data for authentication if you have not done this already.

NOTICE:  Authentication is only required when you use the call 
function for the first time or after you have changed the password. 
Thereafter, the call is initiated without previous authentication.

The call is initiated via the OpenScape Web Client.

NOTICE:  If you have selected the Click-to-Communicate option 
during the installation, the call control for visualizing and 
controlling the call opens directly.

12.7  Updating and Uninstalling via the Setup File

Performing a modification, repairing or uninstalling the application.

After the installation you can invoke the setup routine once more for performing 
maintenance tasks:

• Changing the setup settings that were performed during the initial installation.

• Repairing the application if program errors occur or a new program version is 
to be installed.

• Uninstalling the application.

After you have started the setup routine anew, a dialog opens for selecting and 
performing the desired action.
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The following actions are available:

• Modify: Select this option if you wish to change application settings you 
performed during the previous setup.

• Repair: Select this option if the application does not work properly because 
files are damaged or missing. The application will then completely be 
reinstalled.

• Remove: Select this option if you wish to remove the application from your 
workstation.

12.7.1  How to Change Program Settings

Changing application parameters of OpenScape Client Integrations via the setup.

How to change the settings performed during the OpenScape Client Integrations 
setup:
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 245



OpenScape Client Integrations
Updating and Uninstalling via the Setup File
Step by Step

1) Start the setup file InstallClientIntegrations.exe. The following 
maintenance dialog opens:

2) Select the maintenance option Modify.

3) Click on Next > to initiate the selected action.

You are guided through the installation steps you ran through during the initial 
installation and can adjust your settings.

12.7.2  How to Update or Repair

OpenScape Client Integrations via the setup.

How to install a more recent version of the application or perform a new instal-
lation because of errors in the application:
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Step by Step

1) Start the setup file InstallClientIntegrations.exe. The following 
maintenance dialog opens:

2) Select the maintenance option Repair.

3) Click on Next > to initiate the selected action.

The setup routine starts. The application will then completely be reinstalled.

12.7.3  How to Uninstall the Program

OpenScape Client Integrations via the setup.

NOTICE:  OpenScape Client Integrations should be uninstalled in 
the usual manner via Control Panel > Programs and Features.

How to completely remove the application from your workstation via the setup:
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Step by Step

1) Start the setup file InstallClientIntegrations.exe. The following 
maintenance dialog opens:

2) Select the maintenance option Remove.

3) Click on Next > to initiate the selected action.

The uninstallation routine starts and the application is completely removed from 
your system.
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13  OpenScape UC Application Icons

Overview of the icons used in the OpenScape UC Application client programs.

The icons used are grouped in the following categories:

• Status icons

• Action icons divided in:

– Communication icons

– Cooperation icons

– Application feature icons

• Information icons

13.1  Status Icons

Status icons in the OpenScape UC Application clients.

The following icons are used for status displays in the clients:

Icon Function Icon Function

Available Information on Available

Be right back Information on Be right 
back

In a meeting Information on In a 
meeting

Busy Information on Busy

Do not disturb Information on Do not 
disturb

Unavailable Information on Unavailable

Unknown Information on Unknown

Status cannot be 
displayed or status infor-
mation display switched 
off
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13.2  Action Icons

Action icons in the OpenScape UC Application clients.

Using OpenScape UC Application action icons you can communicate with others, 
cooperate with others and use application features.

Action icons are grouped in the following categories:

• Communication icons

• Cooperation icons

• Application feature icons

13.2.1  Communication Icons

Communication icons in the OpenScape UC Application clients.

The following icons are used for communicating with other subscribers:

Icon Function Icon Function Icon Function

Call (subscriber free) Call (inactive) Call (subscriber busy)

Call (subscriber without 
telephone status display)

End call (cancel call) Phone unknown

Call (several phone numbers 
available, available subscriber)

Call (several phone numbers 
available, deactivated)

Call (several phone numbers 
available, busy)

Call (several phone numbers 
available)

Call (pull-down menu) Hold call Resume held call

Consultation Transfer call

Forward call Transfer call to another device Transfer call

Redirected call - deputy Take incoming call Take outgoing call

Request callback with busy line 
or no reply

Instant messaging - contact is 
online

Instant messaging - contact is 
offline

Instant messaging - unknown 
contact status

Initiate chat conference or 
invite further persons for the 
chat
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13.2.2  Cooperation Icons

Cooperation icons in the OpenScape UC Application clients.

The following icons are used for cooperating with other subscribers:

Routing profile (active) Routing profile (inactive)

Office phone Mobile phone Miscellaneous phone

Phone number list

Record call Finish recording Call is recorded

Send e-mail via default e-mail 
application

Send e-mail to all Private e-mail

Contact list Contact list main bar Add contact

Icon Function Icon Function Icon Function

Icon Function Icon Function Icon Function

Create conference Initiate ad-hoc 
conference (active)

Initiate ad-hoc 
conference (inactive)

Option "Participate in 
conference" or 
"Display conference" 
(activated)

Option "Participate in 
conference" or 
"Display conference" 
(deactivated)

Conference is started

All participants need 
to dial in themselves

All participants are 
called

Conference 
moderator

Participant dials in 
himself/herself

Participant is called End conference

Conference/
conference member 
not muted

Conference/
conference member 
muted

Conference is locked 
(can be unlocked)

Conference is 
unlocked (can be 
locked)
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13.2.3  Application Icons

Application icons in the OpenScape UC Application clients.

The following icons are used for application control in the clients:

13.3  Information Icons

Information icons in the OpenScape UC Application clients.

Add new work group Work group (active) Work group (inactive)

Active work group

Web conference

Icon Function Icon Function Icon Function

Icon Function Icon Function Icon Function

Minimize feature window to 
caption bar

Expand feature window from 
caption bar 

Open pulldown list

Browse to journal list start Go down in journal Go up in journal

Go to end of journal Context menu

Copy Edit Note

Remove Journal notes

Help Search Delete search mask

OpenScape address directory General address directory Outlook application

Minimize window Expand window  View in separate window

Split window section horizon-
tally

Split window section vertically
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The following icons are used for informing about specific operating states in the 
clients, for example in journals:

Icon Function Icon Function Icon Function

Incoming connected Outgoing connected

Incoming busy Outgoing busy

Incoming not reached Outgoing not reached

Phone unavailable Phone unknown

Call Urgent call

Access Call

Active conference

Voicemail Audio settings Mute

Call is recorded

Subscriber available Subscriber unavailable Unknown contact

Office phone Mobile phone Miscellaneous phone

My computer
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 253



OpenScape UC Application Icons
Information Icons
 A31003-S5070-U101-3-7619, 06/2012
254 OpenScape UC Application V7 Client Applications, User Guide



Index
A
Audio conferencing service 18

B
Browser integration 19

C
Calendar integration 19
Call screening 19
conferences menu 56
configuration 125
Conventions 13

D
DesktopIntegration 19
Directory search 18

F
formats in the manual 13

G
Groupware integration 19

I
installation 117
installation process 117
Instant messaging 18

J
Jabber XCPTM 18
joining/starting conference 56
Journal with number resolution 18

M
Main Features 17
Meet Me conference 88, 111, 148
Messaging integration 19
Microsoft Office Communications Server (OCS) 

Integration 19

N
Named device list 19
Network 125

O
One-number service (ONS) 18
ONS, one-number service 18
OpenSacpe UC Speech Portal

Examples of voice commands 80

OpenScape Click-to-Dial Browser Plug-in
configuration

activating/deactivating IE/Firefox 
integration 205

configuration options 205
country selection 208
defining blacklist of phone numbers 207
defining blacklist of URLs 206
defining blacklist of words 206
Firefox, general considerations 204
Firefox, via rightclick on menu bar 204
Firefox, via the Tools menu 204
general considerations 202
internet explorer 202

features 36, 191
General Considerations 191
installation

default installation 193
general considerations 192
general uninstallation information 200
installing Firefox retrospectively 198
modifying the installation (modify) 197
performing an update installation 199
uninstalling Firefox 198
update installation (repair) 199
updating/uninstalling 197

operation
calling via web browser search engine list 211
context menu 209
country selection 210
general considerations 208
initiating a call from an HTML page 209

requirements for use 192
uninstalling via control panel 202
uninstalling via the setup.exe 201

OpenScape Client Integrations
changing application parameters 245
features 237
general considerations 237
installation 239
installation requirements 238
operation 244
repairing 246
setup adjustments 238
supported clients 237
uninstalling the application 247
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 255



Index
updating 246
updating and uninstalling 244

OpenScape Conference Extension for Lotus Notes
Automatic conference start 35
configuration

audio conference 162
general considerations 159
Network 160
presence 164
user interface 166
web conference 163

configuring a conference 168
deleting a conference 175
dialing into an audio conference 176
editing conference after sending conference 

data 174
editing conference before sending conference 

data 173
features 35
general considerations 147
installation, general 152
installation, installation process 153
installation, requirements 153
Operation

controlling via call control 105, 140, 176
operation

controlling via telephone 104, 143, 179
general considerations 167

performing an update installation 156
requirements for use 147
scheduled conferencing 35
starting a web conference 181
starting an audio conference 175
uninstalling 158
updating/uninstalling

general considerations 156
OpenScape Conference Extension for Microsoft 

Outlook 117, 125
Automatic conference start 35
configuration

audio conference 127
general considerations 125
presence 129
user interface 131
web conference 128

features 35
general considerations 111
installation

general considerations 116
requirements 116

installation terminal server
configuring user configuration files 121
general considerations 120
requirements 120
setup process 121

Operation
controlling via call control 105, 140, 176

operation
configuring a conference 132
controlling via telephone 104, 143, 179
dialing into an audio conference 140
editing conference before sending conference 

data 136
general considerations 132
starting a web conference 144
starting an audio conference 139

performing an update installation 122, 123, 157
requirements for use 111
scheduled conferencing 35
uninstalling 124
updating/uninstalling

general considerations 122
OpenScape Desktop Client Enterprise Web Embedded 

Edition
Feature

Preferred Device 24, 26
feature

conferencing 24, 26
contact list 24, 26
instant messaging (IM) 24, 26
journal 25, 26
own calls 23, 25
own status 24, 26
video conferencing 25

OpenScape Desktop Integration
application requirements 183
configuration

about 189
appearance 186
hotkey 185
language 188
options 187
start 186

features 36
general considerations 183
installation 184
operation 189

OpenScape Mobile Client
feature

calling 27
contacts 28
A31003-S5070-U101-3-7619, 06/2012
256 OpenScape UC Application V7 Client Applications, User Guide



Index
devices 28
Handover to 27
journal 28
setting a rule 28
setting a status 28
settings 28
updating 28

features 27
OpenScape UC Application

action icons for communication 250
action icons for cooperation 251
action icons, in general 250
application icons for the application 252
Conference types

Ad-hoc Conferences 85
Meet Me Conferences 86
MeetNow! conferences 85
Video Conferences 85
Web Conferences 85

conference types
staging Meet-Now! conferences 102

icons used 249
information icons 253
MeetNow! conferences 101
Merge Calls 85
participating in a moderated conference by the 

system calling you 94
participating in an open conference by the system 

calling you 96
status icons 249

OpenScape UC Application conferences
ad-hoc conferences 88
configuring a Meet Me conference 90
configuring conferences 100
controlling a video conference 107
controlling via call control 105, 140, 176
controlling via telephone 104, 143, 179
controls in the "Conferences" dialog 100
joining a conference by dialing in yourself via 

phone 93
joining a conference by dialing in yourself via web 

client 94
joining a meet-me conference, general 91
starting a meet-me web conference 100
starting an ad-hoc web conference 99

OpenScape UC Speech Portal
Answering Machine Mode (Guest Access) 

feature 79
Answering Machine Mode as answering machine, 

operation 84

Answering Machine Mode in Guest Access, 
operation 84

Control Mode (Direct Access) feature 78
Control Mode, operation 80
features 78
general considerations 33, 77

OpenScape Voice Portal 56
access types 41
access via OpenScape Xpressions PhoneMail 42
Answering Machine Mode (Guest Access) 

feature 44
Answering Machine Mode (Guest Access) 

features 74
calendar menu

functions 53
looking for an appointment 55
playing next appointment/looking for 

appointment 54
playing the next appointment 55

call subscriber menu 72
calling a subscriber via digit dialing 73
calling a subscriber via name dialing 73
conferences menu 56

joining a conference 57
starting a conference 58

Control Mode (Direct Access) feature 43
direct access 42
editing a contact 70
features 32, 43
general considerations 39
help menu 74
logon 45
logon menu 44
mailbox menu

functions 46
playing voicemails 48
selecting message types 50
sending messages 46
switching message directories 52

operating modes 40
playing voicemails 49
recording a name 61
recording greetings 60
selecting message types 51
sending messages 47
settings menu 58

editing contacts 69
recording greetings 59
Unified Communications options 65
voicemail options 62

switching message directories 53
A31003-S5070-U101-3-7619, 06/2012
OpenScape UC Application V7 Client Applications, User Guide 257



Index
Unified Communications options
activating a routing rule 68
How to Manage Preferred Devices 67
How to Set your Presence Status 67

voicemail options
changing the PIN 63
managing trusted numbers 64

OpenScape Voice Portal with PhoneMail
features 33

OpenScape Web Client
Feature

Preferred Device 24, 26
feature

conferencing 24, 26
contact list 24, 26
instant messaging 24, 26
journal 25, 26
own calls 23, 25
own status 24, 26

features 25
OpenStage Client

call journal 226
call journal in general 225
calling a subscriber via contact list 223
conference status 233
conferences in general 229
ending a conference 234
features 213
filtering call journal 227
leaving a conference. 234
locking/unlocking a conference 235
looking for subscribers in address books 220
muting/unmuting a conference 235
muting/unmuting participants 235
operating options in active conference 233
operation in general 216
removing participants from conference 234
setting the preferred device 219
setting the presence status 217
starting a conference 230
starting the application on the OpenStage 

telephone 214
updating (list of conference participants) 235
usage requirements 214

P
Presence-based contact management 18

S
Single Sign-On, SSO 19
Softphone 18
SSO, single sign-on 19

T
Tell-me-when (notification feature) 18
Tell-me-when feature 18
Text-to-speech 18

U
Using routing rules 18

V
Video conferencing 18
Video telephony 19

W
Web conferences 96, 113, 149
A31003-S5070-U101-3-7619, 06/2012
258 OpenScape UC Application V7 Client Applications, User Guide


	History of Changes
	1 The OpenScape UC Application Clients
	1.1 Outline
	1.2 Working with this Manual
	1.2.1 Formats and Display Forms
	1.2.1.1 Figures

	1.2.2 Reference Manuals


	2 The OpenScape UC Application
	2.1 Introduction
	2.1.1 Main Features
	2.1.2 Main Concepts
	2.1.3 Microsoft Groupware and Office Integration
	2.1.4 IBM Lotus Groupware Integration
	2.1.5 Microsoft Office Communications Server (OCS) Integration


	3 Overview of the OpenScape UC Application Clients
	3.1 OpenScape Desktop Client Enterprise Web Embedded Edition
	3.1.1 Own Calls
	3.1.2 Conferencing
	3.1.3 Contact List
	3.1.4 Own Status
	3.1.5 Preferred Device
	3.1.6 Instant Messaging (IM)
	3.1.7 Journal
	3.1.8 Video Conferencing

	3.2 OpenScape Web Client
	3.2.1 Own Calls
	3.2.2 Conferencing
	3.2.3 Contact List
	3.2.4 Own Status
	3.2.5 Preferred Device
	3.2.6 Instant Messaging (IM)
	3.2.7 Journal

	3.3 OpenScape Mobile Client
	3.3.1 Calling
	3.3.2 Handover to
	3.3.3 Contacts
	3.3.4 Journal
	3.3.5 Devices
	3.3.6 Updating
	3.3.7 Setting a Status
	3.3.8 Setting a Rule
	3.3.9 Settings

	3.4 OpenScape Fusion for Google Apps
	3.4.1 Initiating Calls
	3.4.2 Contact Synchronization
	3.4.3 Preferred Devices
	3.4.4 Conferencing
	3.4.5 Click-to-Dial
	3.4.6 Presence Status
	3.4.7 Single Sign-On

	3.5 OpenScape Voice Portal
	3.5.1 OpenScape Voice Portal mit PhoneMail

	3.6 OpenScape UC Speech Portal
	3.7 OpenScape Extensions for Microsoft Outlook
	3.8 OpenScape Extensions for Lotus Notes
	3.9 OpenScape Desktop Integration
	3.10 OpenScape Click-to-Dial-Browser-Plug-in
	3.11 OpenStage Client
	3.12 OpenScape Client Integrations

	4 OpenScape Voice Portal
	4.1 OpenScape Voice Portal Operating Modes
	4.2 Access to the OpenScape Voice Portal
	4.2.1 Access via direct Logon to the OpenScape Voice Portal
	4.2.2 OpenScape Voice Portal Access via OpenScape Xpressions PhoneMail

	4.3 The OpenScape Voice Portal Features
	4.4 Logging on to the Main Menu
	4.4.1 How to Log on to the OpenScape Voice Portal

	4.5 The Mailbox Menu
	4.5.1 Sending Messages
	4.5.1.1 How to Send Messages

	4.5.2 Playing new Voicemails
	4.5.2.1 Playing new Voicemails

	4.5.3 Selecting a Message Type
	4.5.3.1 How to Select a Message Type

	4.5.4 Switching message directories
	4.5.4.1 How to Switch the Message Directory


	4.6 The Calendar Menu
	4.6.1 Playing and Editing Appointments
	4.6.1.1 How to Retrieve the Next Upcoming Appointment
	4.6.1.2 How to Play Appointments from a specific Date Range


	4.7 The Conferences Menu
	4.7.1 Starting or Joining Conferences
	4.7.1.1 How to Join a Conference
	4.7.1.2 How to Start a Conference


	4.8 The Settings Menu
	4.8.1 Reply Options
	4.8.1.1 How to Record a Welcome Greeting
	4.8.1.2 How to Record your own Name

	4.8.2 Voicemail Options
	4.8.2.1 How to Change the Password (PIN)
	4.8.2.2 How to Manage Trusted Numbers

	4.8.3 Unified Communications Options
	4.8.3.1 How to Set your Presence Status
	4.8.3.2 How to Manage Preferred Devices
	4.8.3.3 How to Activate a Routing Rule

	4.8.4 Editing a Contact
	4.8.4.1 How to Edit a Contact


	4.9 The Call Subscriber Menu
	4.9.1 How to Call a Subscriber via Digit Dialing
	4.9.2 How to Call a Subscriber via Name Dialing

	4.10 The Help Menu
	4.11 The OpenScape Voice Portal Answering Machine Mode (Guest Access)
	4.11.1 Using the Answering Machine Mode as Answering Machine
	4.11.2 How to use the Answering Machine Mode to Send Voice Messages directly


	5 OpenScape UC Speech Portal
	5.1 The OpenScape UC Speech Portal Features
	5.2 Operating the OpenScape UC Speech Portal

	6 Conferences in the OpenScape UC Application
	6.1 Ad-hoc Conferences
	6.2 Meet Me Conferences
	6.2.1 How to Configure a Meet Me Conference via the Conferences Dialog
	6.2.2 How to Configure a Meet Me Conference via the Contacts Dialog
	6.2.3 Joining an Active Meet-me Conference
	6.2.3.1 Options for joining a Meet Me Conference
	6.2.3.2 How to Dial into a Conference by yourself via Telephone
	6.2.3.3 How to Dial into a Conference by yourself via the "Conferences" Dialog
	6.2.3.4 How to Participate in a Moderated Conference by the System Calling you
	6.2.3.5 How to Participate in an Open Conference by the System Calling you


	6.3 Web Conferences
	6.3.1 How to Start an Ad-hoc Web Conference
	6.3.2 How to Start a Meet-me Web Conference

	6.4 Configuring Conferences
	6.4.1 Controls in the "Conferences" Dialog

	6.5 MeetNow! Conferences
	6.5.1 How to Perform MeetNow! Conferences

	6.6 Operating Options during a Conference
	6.6.1 Controlling a Conference via Telephone
	6.6.2 Controlling a Voice Conference via Call Control
	6.6.3 Controlling a Video Conference


	7 OpenScape Extensions for Microsoft Outlook
	7.1 Requirements for Use
	7.2 Meet Me Conferences
	7.3 Web Conferences
	7.4 Installing the OpenScape Extensions for Microsoft Outlook
	7.4.1 Requirements for Setting up OpenScape Extensions for Microsoft Outlook
	7.4.2 How to Perform the Installation

	7.5 Installation in a Terminal Server Environment
	7.5.1 Requirements for the Installation in a Terminal Server Environment
	7.5.2 How to Perform the Installation in a Terminal Server Environment
	7.5.3 User Configuration Files for Terminal Server Environments

	7.6 Repairing, Upgrading and Uninstalling the OpenScape Extensions for Microsoft Outlook
	7.6.1 How to Perform a Repair (Update) Installation for the OpenScape Extensions for Microsoft Outlook
	7.6.2 How to Perform an Upgrade Installation for the OpenScape Extensions for Microsoft Outlook
	7.6.3 Uninstalling the OpenScape Extensions for Microsoft Outlook

	7.7 Configuring the OpenScape Extensions for Microsoft Outlook
	7.7.1 Configuring the Network
	7.7.2 Audio / Video Conference Configuration
	7.7.3 Configuring Web Conferences
	7.7.4 Configuring the Presence Status
	7.7.5 Configuring the User Interface

	7.8 Configuring, Editing, Deleting, and Controlling Conferences
	7.8.1 How to Configure a Conference
	7.8.2 Editing the Conference before Sending the Conference Data
	7.8.3 Editing the Conference after Sending the Conference Data
	7.8.4 How to Invite Further Participants to a Conference that is already Started
	7.8.5 Deleting Conferences
	7.8.6 Starting the Audio Conference
	7.8.7 How to Dial into an Audio Conference
	7.8.7.1 Controlling a Voice Conference via Call Control
	7.8.7.2 Controlling a Conference via Telephone

	7.8.8 Starting a Video Conference Connection
	7.8.9 Starting/Joining a Web Conference


	8 OpenScape Extensions for Lotus Notes
	8.1 Requirements for Use
	8.2 Meet Me Conferences
	8.3 Web Conferences
	8.4 Installing the OpenScape Extensions for Lotus Notes
	8.4.1 Requirements for Setting up OpenScape Extensions for Lotus Notes
	8.4.2 How to Perform the Installation

	8.5 Updating and Uninstalling the OpenScape Extensions for Lotus Notes
	8.5.1 How to Perform an Update Installation for the OpenScape Extensions for Lotus Notes
	8.5.2 How to Perform an Upgrade Installation for the OpenScape Extensions for Lotus Notes
	8.5.3 Uninstalling the OpenScape Extensions for Lotus Notes

	8.6 Configuring the OpenScape Extensions for Lotus Notes
	8.6.1 Configuring the Network
	8.6.2 Audio / Video Conference Configuration
	8.6.3 Configuring Web Conferences
	8.6.4 Configuring the Presence Status
	8.6.5 Configuring the User Interface

	8.7 Configuring, Editing and Controlling Conferences
	8.7.1 How to Configure a Conference
	8.7.2 Editing the Conference before Sending the Conference Data
	8.7.3 Editing the Conference after Sending the Conference Data
	8.7.4 How to Invite Further Participants to a Conference that is already Started
	8.7.5 Deleting Conferences
	8.7.6 Starting the Audio Conference
	8.7.7 How to Dial into an Audio Conference
	8.7.7.1 Controlling a Voice Conference via Call Control
	8.7.7.2 Controlling a Conference via Telephone

	8.7.8 Starting a Video Conference Connection
	8.7.9 Starting/Joining a Web Conference


	9 OpenScape Desktop Integration
	9.1 Application Requirements
	9.2 How to Install the OpenScape Desktop Integration
	9.3 Configuring the OpenScape Desktop Integration
	9.4 Operating the OpenScape Desktop Integration

	10 OpenScape Click-to-Dial-Browser-Plug-in
	10.1 OpenScape Click-to-Dial-Browser-Plug-in
	10.2 Requirements for Using the OpenScape Click-to-Dial-Browser-Plug-in
	10.3 Setting up the OpenScape Click-to-Dial-Browser-Plug-in
	10.3.1 How to Perform the Default Setup

	10.4 Changing the Setup, Updating and Uninstalling the OpenScape Click- to-Dial-Browser-Plug-in
	10.4.1 Modifying the Installation (Modify)
	10.4.1.1 How to Install the Firefox Support Retrospectively
	10.4.1.2 How to Uninstall the Firefox Support

	10.4.2 Update Installation (Repair)
	10.4.2.1 How to Perform an Update Installation (Repair)

	10.4.3 Uninstalling the OpenScape Click-to-Dial-Browser-Plug-in
	10.4.3.1 How to Perform the Uninstallation via the Setup File
	10.4.3.2 How to Perform the Uninstallation via the Windows Control Panel


	10.5 Configuring the OpenScape Click-to-Dial-Browser-Plug-in
	10.5.1 How to Configure the OpenScape Click-to-Dial-Browser-Plug-in for the Internet Explorer
	10.5.2 Configuring the OpenScape Click-to-Dial-Browser-Plug-in for Mozilla Firefox
	10.5.2.1 How to Configure the OpenScape Click-to-Dial-Browser-Plug-in for Firefox via the Tools Menu
	10.5.2.2 How to Configure the OpenScape Click-to-Dial-Browser-Plug-in for Firefox via Rightclick on the Menu Bar

	10.5.3 Configuration Options for the OpenScape Click-to-Dial-Browser- Plug-in
	10.5.3.1 Activating/Deactivating the IE/Firefox Integration
	10.5.3.2 Defining Blacklists of Words
	10.5.3.3 Defining Blacklists of URLs
	10.5.3.4 Defining Blacklists of Phone Numbers
	10.5.3.5 Selecting Countries for Phone Number Normalization


	10.6 Operating the OpenScape Click-to-Dial-Browser-Plug-in
	10.6.1 How to Initiate a Call from an HTML Page
	10.6.2 The OpenScape Click-to-Dial-Browser-Plug-in Context Menu
	10.6.3 The Country Selection Dialog for the OpenScape Click-to-Dial- Browser-Plug-in
	10.6.4 Calling via the Web Browser Search Engine List


	11 The OpenStage Client
	11.1 Requirements for Using the OpenStage Client
	11.2 How to Start the Application on the OpenStage Telephone
	11.3 Operating the OpenStage Client
	11.3.1 How to Set the Presence Status
	11.3.2 How to Set the Preferred Device
	11.3.3 How to Use the Directory Search
	11.3.4 How to Call a Subscriber via Contact List
	11.3.5 The OpenStage Client Call Journal
	11.3.5.1 How to Call Subscribers via Call Journal
	11.3.5.2 How to Search the Call Journal for Calls

	11.3.6 Operating Conferences via the OpenStage Client
	11.3.6.1 How to Start Conferences via the OpenStage Client
	11.3.6.2 Operating Options in an Active Conference



	12 OpenScape Client Integrations
	12.1 OpenScape Client Integrations
	12.2 Supported Clients
	12.3 Installation Requirements
	12.4 Setup Adjustments
	12.5 How to Install the OpenScape Client Integrations
	12.6 OpenScape Client Integrations
	12.7 Updating and Uninstalling via the Setup File
	12.7.1 How to Change Program Settings
	12.7.2 How to Update or Repair
	12.7.3 How to Uninstall the Program


	13 OpenScape UC Application Icons
	13.1 Status Icons
	13.2 Action Icons
	13.2.1 Communication Icons
	13.2.2 Cooperation Icons
	13.2.3 Application Icons

	13.3 Information Icons

	Index

